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Welcome to VGStudio MAX 1.0 User's Manual 

VGStudio MAX 1.0 is a software system designed to support interactive analysis of three dimen-
sional/volumetric data, the so called "voxel data" or three dimensional images. The term voxel  is 
used to characterize a volume element; it is a generalisation of the notion of pixel that stands for 
a picture element. Volume data described with voxels represent therefore the result of some 
sampling process of a three dimensional object or structure. Typical sampling systems are X-Ray 
CAT, MRI, PET and SPECT, Confocal Laser microscopy. 

VGStudio MAX 1.0 is a highly sophisticated image analysis and visualization software and was 
developed to provide the user with a powerful but easy-to-use interface to process and visualize 
voxel/volume data with high-performance analyzing and volume rendering algorithms. VGStu-
dio MAX 1.0 includes Volume Graphics unsurpassed VGL® rendering technology which allows 
to render largest volume data sets at an interactive performance on every modern PC. VGStudio 
MAX 1.0 is the worldwide first application providing an intuitive standard graphical user inter-
face in combination with the most advanced visualization and image processing technology. 
Apart from volume data analysis, VGStudio MAX 1.0 may also be used for documentation and 
presentation purposes. You may render high quality images and animations of your data under 
investigation.  

Today VGStudio MAX 1.0 is used by professionals in healthcare, industry and science all over 
the world. 

 

 

 

 

 

 

 

 

 

 

 

 

 

All terms you might be unfamiliar with here will be explained throughout this manual. 
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Medical Use Restrictions 

We wish to thank you for your past support and continued usage of the 
VGStudio voxel data visualization and analysis program. We have many 
future plans for the product, and we will advise you through the appropri-
ate channels as these enhancements become available. 

At the same time, however, we wish to remind you that the VGStudio 
products are "for research use only" or "for investigational use only." The 
Department of Health and Human Services (DHHS) National Institute of 
Health (NIH) defines "research" as...  

" ... a systematic investigation, including research development, testing 
and evaluation, designed to develop or contribute to generalizable 
knowledge... " (Cf. 45 CFR 46.102(d)) 

The "human subject" in research is...  

" ... a living individual about whom an investigator... conducting research 
obtains (1) data through intervention or interaction with the individual, or 
(2) identifiable private information. Intervention includes both physical 
procedures by which data are gathered and manipulations of the subject 
or the subject’s environment that are performed for research purposes. 
Interaction includes communication or interpersonal contact between the 
investigator and subject... " (Cf. 45 CFR 46.102(f)) 

Similarly, the DHHS Food and Drug Administration (FDA) defines an "in-
vestigation" as...  "... a clinical investigation or research involving one or 
more subjects to determine the safety or effectiveness of a device... " 
(Cf. 21 CFR 812.3(h)) 

The FDA definition of a "subject" is... 

" ... a human who participates in an investigation, either as an individual 
on whom... an investigational device is used or as a control. A subject 
may be in normal health or may have a medical condition or disease... " 
(Cf. 21CFR.812.3(p)) 

Within this regulatory framework, then, a clinical investigation can be ar-
gued to be a more restrictive form of research, in which the data and in-
formation collected are intended to be used to support the claims of a 
device's safety or effectiveness (the FDA regards software used in medi-
cal applications to be a medical device).  

At the present time, Volume Graphics makes no representation that the 
VGStudio product is either safe or effective for any intended use for 
which research may currently be performed. 

If you are conducting research or clinical investigations, by law, you are 
required to obtain prior Investigational Review Board (IRB) approval of 
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the clinical study protocol and of the patient informed consent docu-
ments, and to provide each patient/subject with a copy of the completed 
informed consent document. Similarly, if you are conducting research or 
clinical investigations using animal subjects, you are obligated to follow 
Good Laboratory Practices, and to observe the ethical treatment of the 
animals. If your facility or academic institution receives funding from NIH, 
or if your IRB has DHHS- approved assurances on-file, then you are ob-
ligated to follow the NIH rules, in addition to the FDA rules. 

As a consequence of the regulatory status of the VGStudio products, you 
are reminded of the Login Acceptance Screen, reprinted below, in which 
you acknowledge the regulatory status of the product prior to using its 
functionality: 

Disclaimer: VGStudio IS NOT FOR CLINICAL USE. 

VGStudio or data derived from VGStudio may be used only for research 
and may not under any circumstances be used for clinical purposes. 
Pressing the 'Accept' during the VGStudio installation procedure indi-
cates your consent NOT to use  VGStudio for anything other than re-
search purposes. 

You are encouraged to contact your governing IRB or clinical risk man-
ager should you have any additional questions or concerns. We hope 
that this information clarifies your understanding of the regulatory status 
of the VGStudio product, and look forward to continued dialog with you. 

To acknowledge the conditions regulating the use of VGStudio, please 
sign this letter in the space provided below and fax a copy of page 8 and 
9 to us at +49 621 181 2634. 

We wish you continued success in your research activities.  

— 
Volume Graphics GmbH 

 

I agree to the above restrictions on the use of VGStudio. 

_________________________________ 
Customer's Signature 

_________________________________ 
Customer's Name (Printed) 

_________________________________ 
Organization 





 

 

1 Introduction to VGStudio MAX 1.0 

This chapter will help the user in getting accustomed with the program and its functions, and 
gives an overview of some basic concepts the user should keep in mind when using the program. 

This chapter covers the following topics: 

�� Volume graphics and VGStudio MAX 

�� About this manual 

�� Conventions used in this manual 

�� Where to get additional help 

�� Where to send feedback 
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1.1 Volume Graphics and VGStudio MAX 1.0 

Volume rendering or, to use a more general term, volume graphics, is a sub-specialty of 3D 
computer graphics which deals with the discrete representation and visualization of objects rep-
resented as sampled data in three or more dimensions. Volume graphics differs from traditional 
3D graphics in that 3D graphics primarily deals with the representation of object surfaces, 
whereas volume graphics deals with the representation of both object surfaces and interiors. In 
volume graphics, for example, sample points such as CT or MRI scans are taken from the real 
world, assigned color and transparency levels, and are then projected directly onto the computer 
screen. 

In recent years, the popularity of volume graphics has grown considerably. A few years ago, 
volume graphics was still limited by the large amount of computational power and memory re-
quired for real-time volume rendering. In contrast to classical or advanced 2D image processing, 
volume visualization and analysis produces huge amounts of data, so that memory, processor 
performances and algorithms are critical. Due to the highly sophisticated algorithms used in 
VGStudio MAX 1.0 and the increase in PC computing power, volume graphics and volume 
analysis became accessible to everybody as the program runs on a standard PC. The adoption of 
efficient solutions in VGStudio MAX 1.0, e.g. the multiprocessor (SMP) capable implementation 
of nearly every VGStudio MAX 1.0 feature, allows the user to apply a trial and error approach to 
the analysis of 3D data; the user can apply an operation or a transformation to the data and con-
trol the result in an interactive and real-time environment, and may thus select the best suited 
operation for his/her needs. By using VGStudio MAX 1.0, everybody can take advantage of vol-
ume graphics technology which has inherent advantages for applications that need visualization 
of irregular objects, or where the interior structure and a high-quality detail representation are 
essential, e.g. representations of the human body. 

 

Fig. 1 Color and transparency levels are assigned to CT or MRI scans and are then projected 
directly onto the computer screen. 
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1.2 Images Rendered by VGStudio MAX 1.0 Users 

 
Fig. 2 Here are example images rendered by VGStudio MAX users. 
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1.3 About this Manual 

VGStudio MAX has been designed to be as intuitive as possible, but as it is a sophisticated pro-
gram, you might need help from time to time. In this case, you should refer to this manual which 
includes a comprehensive table of contents and an index to help you find the information you 
need. 

This manual assumes that you are familiar with the Unix or Windows operating systems. If you 
need help with features specific to either system, please refer to the documentation supplied with 
your computer. 
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1.4 Conventions Used in this Manual 

This manual uses the following conventions to identify information: 

�� Whenever you must execute a command by clicking the mouse, the command will be dis-
played in bold text (for example, click OK to continue). 

�� Menu items and buttons also appear in bold text for easy identification (for example, the File 
menu or the Save button). 

�� You will find the following icons throughout the manual. The icons indicate which mouse 
button you should press to execute the appropriate action. 

�� Throughout the manual, you will find Reminder icons. They indicate important facts and 
exceptions. 

   

�� Chapter cross references are displayed in italics (for example, Chapter 1 Introduction to 
VGStudio MAX 1.0). 

�� This manual combines Windows and Unix instructions. In most cases, they overlap, but in 
those instances when there are differences (most often with key commands), the manual will 
list both commands. 

 

Press left mouse button Press middle mouse button Press right mouse button 
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1.5 Where to Get Additional Help 

Check the table of contents or the index whenever you need to locate information on a particular 
function. If you cannot find the information, there are other ways to get help. Please also refer to 
Chapter 2.5 Registering VGStudio MAX 1.0. 

�� Installation & Information Card—Provides latest information on the current VGStudio 
MAX 1.0 release and information on the installation procedure for your operating system. 

�� Volume Graphics Web Site—The Internet is a quick way to get answers to your questions. 
You can use the Volume Graphics web site at www.volumegraphics.com as a technical sup-
port resource. 

�� E-Mail— Send an e-mail to Volume Graphics at vgstudio@volumegraphics.com 

�� Volume Graphics Technical Support—If none of the resources mentioned above provides 
the answer, you can contact the Volume Graphics technical support by sending an e-mail to 
vgstudio@volumegraphics.com or one of our sales representatives. Please be at your com-
puter and have your registration number available when you call. 

�� Volume Graphics Sales—Our friendly and knowledgeable sales personnel can answer basic 
questions about product capabilities and give information on other Volume Graphics prod-
ucts which may fit your needs. You may contact our sales department by sending an e-mail 
to info@volumegrapics.com or one of our sales representatives. 
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1.6 Feedback 

We are very interested in your comments on VGStudio MAX. Many of VGStudio MAX's 
changes and improvements over the years were based upon user requests and input. If you have 
comments or feature requests, please send them to us via the World Wide Web: 

http://www.volumegraphics.com 

e-mail: vgstudio@volumegraphics.com 

You may also send a letter or fax to the following address / fax number: 

 
Volume Graphics GmbH 
VGStudio MAX Product Manager  
Wieblinger Weg 92a 
D-69123 Heidelberg 
Germany 
Tel:  +49 / 6221 / 73920 60 
Fax: +49 / 6221 / 73920 88 
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2 Installation 

This chapter gives general information on installation requirements and on the installation itself. 
Each section provides the users with instructions for both Windows and Unix operating systems. 
Find the section that is appropriate for your operating system. 

This chapter covers the following topics: 

�� System requirements 

�� Installation instructions 

�� Registering VGStudio MAX 
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2.1 System Requirements 

This section lists the minimum system requirements for Windows and Unix users. Refer to the 
section that is appropriate for you. Also, see the section on VGStudio MAX and memory usage 
in the Appendix. 

Windows 

Microsoft Windows™ 9x,  Windows NT 4.0 or Windows 2000 operating system 

Pentium III or higher or equivalent CPU  

128 MB RAM (256 MB or more recommended) 

Super VGA display (17" or larger recommended) with 800x600 resolution and 256 colors 
(1280x1024 at High Color recommended) 

CD-ROM drive 

Unix 

Linux 2.0 (other Unix OS on request) operating system 

128 MB available RAM (256 MB or more recommended) 

Super VGA display (17" or larger recommended) with 800x600 resolution and 256 colors 
(1280x1024 at High Color recommended) 

CD-ROM drive 
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2.2 VGStudio MAX 1.0 on Multiprocessor Hardware  

Almost all features included in VGStudio MAX 1.0 are implemented multithreaded so that 
VGStudio MAX 1.0 takes full advantage of modern processor technologies. Especially on multi-
processor (SMP) hardware, VGStudio MAX 1.0 delivers an almost linear speedup proportional 
to the number of processors in use. VGStudio MAX 1.0 utilizes the full memory bandwidth of 
today’s and upcoming system designs to provide its users with an optimal performance. 

By default VGStudio MAX 1.0 utilizes all processors available in a system. The user may limit 
the number of processors used by VGStudio MAX 1.0 by applying the environment variable 
PROCESSORS with the appropriate number of processors. 

Adding environment variables on a Windows NT 4.0 / 2000 System 

Step 1: Choose Settings in the Program Manager Start menu. 

Step 2: Choose Control Panel from the Settings menu. 

Step 3: Double-click the System icon to display System Properties. 

Step 4: On the Environment index card, click any existing variable name in the list you want to 
add the variable to. 

Step 5: Type in the name of the new variable in the Variable box. 

Step 6: Type in the value in the Value box. 

Step 7: Click Set. 

Notes: 

If you are not an administrator, you may add variables only to the User Variables list. Windows 
NT will save changes in the registry so that they will be available automatically the next time 
you start your computer. Changes will not affect programs that are running, and will only be 
effective once you have restarted your computer. 

Adding environment variables on a Unix system  

Notes: 

Ask your system administrator for help if you are not familiar with modifying system or envi-
ronment variables. To modify your PROCESSORS variable, type in one of the following com-
mands depending on what shell you use and where you have installed the software. Include the 
corresponding line into your .cshrc or your .bashrc file if you do not want to modify your envi-
ronment variables every time you log into your system. 

Examples for utilization of 2 processors.  
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For tcsh users type:  

setenv PROCESSORS 2 

For bash users type:  

export PROCESSORS=2 
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2.3 Installation Instructions 

Please refer to the installation information within the VGStudio MAX 1.0 CD booklet for up-to-
date and detailed information on the installation procedure for your operating system.  

 

 

Reminder: The VGStudio MAX 1.0 software ast to be installed by a user with 
Administrator rights. The installation without Administrator rights will result in an 
incomplete installation.  
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2.4 VGStudio MAX 1.0 License  

The VGStudio MAX 1.0 Node Locked License update window will pop up when you start 
VGStudio MAX 1.0 for the first time or when no valid license was found on your system. Enter 
your name or the name of your company and the license key which is included in your VGStudio 
MAX 1.0 software package and click OK. You may also ask the Volume Graphics support for a 
trial license at vgstudio@volumegraphics.com. To do so press the Create registration form 
button, fill in the required information and send the registration form to Volume Graphics. 

If you started VGStudio MAX 1.0 for the first time and you got no license you can click Demo 
for running VGStudio MAX 1.0 in demo mode. The application then runs ten minutes and you 
will not be able to save. Clicking Exit will exit the application. 

When you chose License update the Demo button will be named Cancel. Clicking Cancel 
(please refer to Chapter 4.3.8 Help Menu - License update) closes just closes the window. 

 

 

Fig. 3 The License update window where you enter 
your name and license key. 
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Reminder: The Node Locked License update dialog may not be used to enter a 
Floating License Code.  Please refer to the Installation & Information Card de-
livered with your VGStudio MAX 1.0 software package in case that you purchased 
a Floating License of VGStudio MAX 1.0  
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2.5 Registering VGStudio MAX 1.0 

To be eligible for technical support, as well as receive information on bug-fix updates and fea-
ture upgrades, you must register your copy of VGStudio MAX. To register press the Create reg-
istration form button in the License dialog (please refer to Chapter 4.3.8 Help Menu - License 
update), fill in the required information and send the registration form to Volume Graphics either 
by fax, mail, or e-mail. If you change your address after registering, you may call or e-mail us so 
we can update your record, or send us a standard post office change of address notice. See Chap-
ter 1.6 Feedback for more information on how to contact Volume Graphics directly. 
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3 Getting Started 

This chapter explains how to get started using VGStudio by introducing some basic program 
concepts. It covers the following topics: 

�� Launching the program 

�� First steps with VGStudio MAX 

�� Exiting VGStudio MAX 

�� Image quality versus speed 
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3.1 Launching the Program 

To launch VGStudio MAX 1.0 for Windows open the Start menu. Select the option Programs / 
Volume Graphics / VGStudio MAX 1.0. You may also double-click on a vgi-File e.g. in your 
Windows Explorer to start VGStudio MAX 1.0. You may drag a vgi file on the VGStudio MAX 
icon to start VGStudio MAX with the appropriate file loaded automatically. 

To launch VGStudio MAX 1.0 for Linux/Unix enter the command vgstudiomax at the com-
mand prompt. You may add a vgi file as command line option to start VGStudio MAX with the 
appropriate file loaded automatically. 

C:\>vgstudiomax  [vgi-file] 

Example:   C:\>vgstudiomax demo.vgi 

 

 

Reminder: When starting the program for the first time you have to enter your 
name and the license key. For more information on the installation procedure, see 
Chapter 2 Installation. 

 

After having launched the program, the VGStudio MAX application will appear on your screen 
with its startup screen. The startup screen will disappear after a few seconds or upon pressing a 
key on your keyboard or a mouse button. The VGStudio MAX interface consists of seven main 
elements: 

- Title bar 

- Menu bar  

- Icon bar 

- Slice windows 

- 3D window 

- Tool box 

- Status bar 
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All the functions included in VGStudio MAX are accessed either by selecting options in the 
main menu, by clicking buttons in the icon bar, by using the tools in the toolbox, or via context 
menus which you open by clicking into an element with the right mouse button. 

3.1.1 Keyboard Usage 

Most VGStudio MAX functions that are accessed via the menu may also be activated by using 
keyboard shortcuts. If keyboard shortcuts exist, they are displayed next to the entries in the pull-
down menus. This can be seen in the following image where the Edit menu is shown as an ex-
ample. 

 

Fig. 4 The VGStudio MAX interface after startup. 
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List of Keyboard Shortcuts 
 
Command Keyboard Shortcut 
  

File Menu  

New Ctrl + N 

Open Ctrl + O 

Save Ctrl + S 

Save As F12 

Quit Alt + F4 
  

Object Menu  

Move Shift + Ctrl + M 

Rotate Shift + Ctrl + R 

Scale Shift + Ctrl + S 

Clipbox Shift + Ctrl + B 

Clipplane Shift + Ctrl + C 
Group Ctrl + G 
Ungroup Ctrl + U 
  

Edit Menu  

Undo Ctrl + Z 

Redo  Ctrl + Y 

Cut Ctrl + X 

Copy Ctrl + C 

Paste Ctrl + V 

Delete Del 
Duplicate Ctrl + D 

Select All Ctrl + A 

Deselect Alt + D 

Select Inverse Alt + I 

 
 
 
 
 
 
 
 
 
 
Fig. 5 The keyboard 
shortcuts are dis-
played next to the 
menu entries. 
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3.1.2 Mouse Usage 

VGStudio MAX is designed to work with a mouse with either two or three buttons. If you are 
using a two-button mouse, the third (middle) mouse button is emulated by simultaneously press-
ing the Alt key on your keyboard and the left mouse button. In conjunction with certain window 
managers, the Alt + left mouse button combination is already in use. A second alternative to 
emulate the middle mouse button when using a two-button mouse is to use the combination Shift 
+ Ctrl + left mouse button. 

Throughout the manual, you will find the following icons. The icons indicate which mouse but-
ton you should press to perform the appropriate action. 

 

By clicking an object with the left mouse button, you select or activate an object. You may also 
select several objects at once by clicking into a window with the left mouse button and then 
dragging a frame over the objects while the left mouse button is pressed or by using the shortcut 
Ctrl + A (when using this shortcut, all objects currently displayed in the scene will be selected). 
You may deselect one or several objects by clicking outside the bounding box of any object. The 
box around any object will disappear. 

Press left mouse button Press middle mouse button Press right mouse button 

  

 
Fig. 6 When clicking an object with the left mouse button you select or activate it. This is 
indicated by a bounding box around the object.
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To select more than one object (but not all objects of the scene), keep the Ctrl key pressed while 
clicking the objects to be selected. A bounding box will appear around the selected, active ob-
jects. To deselect an object, press the Ctrl key and click the selected object. The bounding box 
will then disappear. 

For different actions such as positioning, rotating, clipping, or scaling, the bounding boxes 
around the objects will be displayed in different colors (see table below). These bounding boxes 
also include active areas. The mouse cursor has to be moved into an active area before an action 

Fig. 7 Select several objects by dragging a frame over the objects while the left mouse 
button is pressed. 

Fig. 8 Select several objects by dragging a frame over the objects while the left mouse 
button is pressed. 
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can be applied to the object. In positioning, rotation, and clipplane mode, the whole bounding 
box is the active area. In clipbox mode (see figure below) or scale mode, squared handles on 
each side of the bounding box indicate the active areas. 

The mouse cursor will change as soon as the mouse is moved into an active area, which indicates 
that an action can now be performed. The following table shows the colors of the bounding 
boxes and the shape of the cursor when a certain mode is selected. 

VGStudio MAX 1.0 Magellan® / SPACE MOUSE support 

VGStudio MAX 1.0 is designed to work with the LogiCad Inc./GmbH Magellan® / SPACE 
MOUSE. To use VGStudio MAX 1.0 in combination with a LogiCad Spacemouse start the 
Space Mouse driver before starting VGStudio MAX 1.0.  

 

Fig. 9 Move the cursor into the active area to perform an action.

Action Color of 
bounding box 

Default cursor Cursor on ac-
tive area 

Positioning green   

Rotate red   

Clipbox / 
Clipplane 

cyan   

Scale blue   
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The Space Mouse may be used to steer the six degrees of freedom of the currently selected ob-

ject. The Magellan® / SPACE MOUSE allows you to control "flying objects" spatially without 
strain. 

Information on the LogiCad Inc./GmbH Magellan® / SPACE MOUSE can be found under the 
internet address http://www.spacemouse.com. 

 
Fig. 10 The Space Mouse 
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3.2 First Steps with VGStudio MAX 

This section will explain your first steps when using VGStudio MAX and will guide you through 
the most important steps of the program. A data set of a human jaw which was scanned with a 
CT scanner is used to show some of the basic functions of VGStudio MAX. This chapter will not 
go into detail, i.e. describe all the options and alternatives available. Each tool introduced in this 
chapter will be described in more detail in the following chapters. 

 

 

Reminder: Some of the settings discussed here will only be valid for CT data! 

Start the VGStudio MAX application. An empty scene will be displayed, i.e. the slice windows 
and the 3D window will be empty. Select the Open command in the File menu. In the Open info 
file dialog select the file jaw.vgi within the subdirectory "medical" by clicking it and pressing 
Open or by simply double-clicking the file. The file extension .vgi stands for Volume Graphics 
Info file. The data is loaded into VGStudio MAX and images will appear in the four windows of 
the workspace as shown below. 
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The jaw data set is loaded into the scene. Around the jaw, a green bounding box will appear. The 
green box indicates that the object is the currently selected object and that the Move mode is 
activated. An action can be applied to the selected object only. Click with the left mouse button 
into the 3D view window outside the green bounding box to deselect the object. The bounding 
box will disappear. Click the jaw again to select the object. The green bounding box will reap-
pear. Now move the object by clicking into the green bounding box with the left mouse button 
and dragging the mouse while the left mouse button is pressed. 

To activate the Rotate mode, press the Rotate icon in the icon bar. 

The bounding box around the jaw will appear now in red color, which indicates that the Rotate 
mode is active. Rotate the jaw by clicking into the red bounding box with the left mouse button 
and dragging the mouse while the left mouse button is pressed. The jaw can be rotated in any 
direction. 

 

Fig. 11 The VGStudio MAX screen after a file has been loaded. Here, the Move mode is acti-
vated, which is indicated by the green bounding box. 

 



3.2 First Steps with VGStudio MAX 

VGStudio MAX 1.0 User’s Manual 41

One of the most powerful tools of volume graphics is the possibility to map any gray value of the 
original data to any arbitrary opacity. This functionality is handled by the Classification tool.  

In the main part of the Classification tool you find the Opacity manipulation area. It shows a 
function which maps any gray value (abscissa) to any opacity value (ordinate). It also shows a 
histogram of the frequency of occurrence of the different gray values in the background. The 
gray values are applied to the abscissa of the plot, the opacity values are applied to the ordinate. 
The line running from the lower left corner to the upper right corner is the default opacity func-
tion running from dark transparent voxels to bright opaque voxels. An arbitrary function may be 
applied to the data by inserting new handles to the function and moving these handles. 

 

Fig. 12 The red bounding box indicates that the Rotate mode is active. Rotate the image by 
clicking into the bounding box and dragging the mouse while the left mouse button is pressed. 
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To manipulate the opacity function place the mouse into the Classification tool’s Opacity ma-
nipulation area as shown above. Click the middle mouse button (or the left mouse button while 
the Alt key is pressed) to insert a new handle or remove an existing handle on the opacity func-
tion’s line. Click the new handle with the left mouse button and drag it down to zero opacity. 
The opacity function should now look like the following example: 

  

Fig. 13 To insert a new handle or to remove an existing handle in the Opacity manipulation 
area, click the desired position with the middle mouse button.

 

Fig. 14 The opacity function after a new 
handle has been inserted.
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The resulting 3D image will appear much clearer since all the noise included in the lowest (the 
left side) gray values is now set to zero opacity and is therefore invisible. The 3D image is ren-
dered even faster since most of the transparent data is removed. Se also Chapter 3.3 Image Qual-
ity versus Rendering Speed. 

For another step grab the new opacity handle by clicking it with the left mouse button and drag it 
to the right while the left mouse button is pressed. Keep the handle on the base line, zero opacity, 
as shown in the following example. Drag it to the right-hand side of the gray peak displayed in 
the histogram of the Opacity manipulation area.  

The resulting 3D image should look like it is shown in the following figure. Only the bone struc-
ture, the teeth, and the braces are visible, the noise/air and the soft tissue are invisible.  

 

Fig. 15 Drag the new handle to the right to 
make soft tissue invisible in the 3D image.
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The reason for this is explained in the following picture.  

Noise and air will appear on the left-hand side of the Opacity manipulation area. The next tis-
sues which appear towards brighter gray values are fat and muscles. The brightest tissue is the 
bone structure, teeth and metal braces which appear on the right-hand side of the Opacity ma-
nipulation area. If all the gray values of tissues such as air/noise, fat and muscle are set to zero 
opacity, only the bone structure, teeth, and metal will remain visible. 

 

Fig. 16 The 3D image after noise/air and soft tissue have been removed. Only the bone struc-
tures, the teeth and metal parts are now visible. 

 

Fig. 17 From left to right, the gray values of the different structures are displayed, i.e. 
noise/air, fat, muscle, and bone structures. 
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To enhance the 3D perception of the image activate the Shadow light source. 

To activate the shadow light source click the checkbox in the Shadow light source section of the 
Light properties dialog. 

The jaw will now appear with realistic shadowing. 

Another very powerful function of the Classification tool is the gray value segmentation. To 
demonstrate this feature we will first reset the Classification tool. To do so click into the Object 
overview section with the right mouse button and click Delete all segments as shown in the fol-
lowing figure. 

 

Fig. 18 The Light properties dialog. 

 

Fig. 19 The 3D image after having ac-
tivated the Shadow light source. 
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Then move the mouse cursor to the right border of the Opacity manipulation area. 

The shape of the cursor will change as shown in the figure above. Drag the blue line which ap-
pears on the left-hand side of the Opacity manipulation area while keeping the left mouse but-
ton pressed. The gray values to the left and right of the blue line will be displayed while dragging 
the line. Drag the line to a gray value between 1300 and 1400. You can always move the line by 
dragging it to the left or right while keeping the left mouse button pressed. 

 

Fig. 20 Click Delete all segments to reset the 
Classification tool to its default values.

 

Fig. 21 For gray value segmentation, move 
the cursor to the right side of the Opacity 
manipulation area and drag the blue line.
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The blue line will mark the border between two gray value segments. Two segments have been 
created. The left segment includes the noise/air, fat, and muscle gray values, the right segment 
includes the bone structure and metal objects. To reduce the noise, add a new handle in the left 
segment as you did before by using the middle mouse button. The classification tool should now 
look like the following figure. 

 

Fig. 22 The blue line marks the border be-
tween two gray value segments.

 

Fig. 23 Reduce the noise by inserting a new 
handle and dragging it down to zero posi-
tion. 
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Click with the right mouse button into the left segment’s section of the Color manipulation 
area. The following menu will pop up. 

Click Set segment color and select a color for the left segment, the soft tissue, by clicking one of 
the default colors or using the Custom color option to select a user-defined color. After you 
have done so, the Classification tool will look as follows. 

The jaw in the 3D image will then look like in the figure below. Soft tissue is displayed in yel-
low, the bone tissue in white. 

 

Fig. 24 Select a color for the different segments.

 

Fig. 25 The Classification tool 
after you have selected a color 
for the segments. 
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The gray value segmentation allows to set up independent gray value ranges where opacity and 
color can be customized without affecting other segments. A single segment may, for example, 
be extracted (see Chapter 4.6.1 Classification Tool), disabled, or enabled by clicking with the 
right mouse button into segment 1 shown in the Opacity manipulation area. A context menu 
will then open where you may, for example, select Disable segment to disable segment 1. 

The next functions explained here are the Clipbox and Clipplane functions. Rotate the jaw into 
a position as shown in the following figure. 

 

 

 

Fig. 26 The 3D image after a color has 
been assigned to one of the segments. 

 

Fig. 27 The 3D image in Rotate mode 
indicated by the red frame. 
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Click the Clipbox icon in the icon bar. 

The Clipbox mode is characterized by the cyan bounding box with squared handles, i.e. active 
areas on each side of the selected object or group of objects. When moving the cursor into the 
active area, a scissors will appear next to the cursor, as it is shown in the figures below. Clip the 
object by clicking the active area on one side of the bounding box and dragging the mouse in-
ward while keeping the left mouse button pressed. Please refer also to Chapter 4.6.7 Object 
Properties.  

Remove the clipping by dragging the handles outward or by clicking the Undo button. 

Most features included in VGStudio MAX 1.0 can be undone! After you have removed the clip-
ping, the 3D image should look like the following image. 

 

 

 

 

 

Fig. 28 The 3D window in Clipbox mode indicated by the cyan bounding box and the scissors 
displayed next to the cursor when moving it into an active area.
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Click the Clipplane icon to activate the Clipplane mode.  

The Clipplane mode is characterized by the cyan bounding box with a normal vector on one side 
of the currently selected object. When moving the cursor into the bounding box, a scissors will 
appear next to the cursor. The object may be clipped along an arbitrary clipplane by dragging the 
mouse up and down while the middle mouse button (or the Alt key and the left mouse button) 
is pressed. Press the middle mouse button while positioning the mouse inside the active area and 
drag the mouse down to move the clipplane inward. Drag the mouse inside the active area while 
keeping the left mouse button pressed to rotate the clipplane in any arbitrary direction. 

 

Fig. 29 The 3D view in Clipbox mode 
after the previous clipping has been 
undone. 

 

 

  

Fig. 30 Move the object along an arbitrary clipplane by dragging the mouse up or down while 
the middle mouse button is pressed. By dragging the mouse inside the active area while the left 
mouse button is pressed, the clipplane will be rotated in any arbitrary direction. 
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You may save your current work at any time by using the Save or Save as option in the File 
menu. As an example, use the Save as option and name the scene jaw1 (the original file will 
then not be overwritten). The file extension .vgi (Volume Graphics Info file) will be added 
automatically and therefore has not to be added by you. To reload the current scene, you may use 
the Open option in the File menu. 

A single image such as the rendered 3D image or one of the slice images may be saved by select-
ing the appropriate image window and using the Save image option in the File menu. 

3.2.1 Scenes, Scene-  & Object-Coordinate-System and Units 

All objects loaded into VGStudio MAX will be placed into “the Scene”. The scene is the virtual 
space displayed in VGStudio MAX’ 3D window. By default, the orientation of the scene coordi-
nate axes will be oriented as shown in the following figure. 

The coordinate system used by VGStudio MAX is right-handed, with the coordinate origin in the 
lower left corner. The coordinate origin is on the left side of a body (x), at the front (y), and at 
the feet (z). By default, the positive x-direction in the scene runs from left to right. The positive 
y-direction in the scene runs from the front to the back of the screen plane. The positive z-
direction in the scene runs from the bottom upwards. However, these orientations represent the 
default settings. The whole scene may be rotated or moved with help of the World view tool. All 
axes or planes orthogonal to the axes in VGStudio MAX have a consistent color coding. The x-
axis and planes orthogonal to the x-axis are displayed in red, the y-axis and planes orthogonal to 
the y-axis in green, and the z-axis and planes orthogonal to the z-axis in blue. For easy identifica-
tion, all sections in the windows of the tool box related to the coordinate axes are also marked 
according to this color scheme. 

 

Fig. 31 The VGStudio MAX scene coor-
dinate system. 
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An object loaded into a scene will be placed in the scene’s origin (0,0,0) with its center, not with 
its origin. Each object loaded into the scene has its own inherent coordinate system. The origin 
of a voxel objects coordinate system is located at the voxel at position (0,0,0) as shown in Fig. 
33. An object may be moved or rotated arbitrarily within the scene as shown in the following 
example:  

This means that the object coordinate system of an object may differ from the scene coordinate 
system. Several tools within VGStudio MAX provide information in object coordinates, e.g. the 
Clip section in the object properties tool showing the depth of the clipping plane within the ob-

 

Fig. 32 Color coding of axes and orthogonal 
planes. 

 

Fig. 33 An arbitrarily rotated object is moved 
to scene position 200,200,200. 
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ject, while other tools display scene coordinates like the Position section in the object properties 
tool showing the absolute position of the object within the scene. 

Each object loaded into VGStudio MAX has an inherent resolution, this means for voxel objects 
that a voxel has a defined x-, y- and z-resolution. This resolution as well as the measurement unit 
are normally applied during the import process to each object. By this VGStudio MAX supports 
the processing of an arbitrary number of objects with different inherent voxel resolutions. The 
correct relative scaling of the objects is handled by VGStudio MAX.  

 

Reminder: VGStudio MAX does sopport only a limited dynamic in object scaling 
for objects loaded at the same time. Loading an object with a voxel resolution of 
several �m and another object with a voxel resolution of several m may result in 
enormous memory consumption or even to fatal errors! 

The measure unit used for measurement and positioning tasks within VGStudio MAX is defined 
application wide. The current measurement unit applied can be seen in the VGStudio MAX 
status bar. The application wide unit is defined normally through the unit applied to the objects 
loaded into VGStudio MAX. The word "unit" is displayed in the status bar if no unit is applied. 
All numbers displayed representing measurement and positioning numbers are displayed in vir-
tual "voxel" units in that case. 

3.2.2 Voxel and Polygon Objects 

VGStudio MAX is able to handle and render objects or data sets in voxel and polygonal repre-
sentation. In traditional 3D graphics (polygon graphics), objects are represented as mathematical 
models. Surfaces are subdivided into many small triangles or polygons, which are assigned col-
ors, textures, and levels of transparency or opacity.  

 

 

Fig. 34 Objects in polygonal representation (left) and voxel representation (right). 
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Volume graphics is a sub-specialty of 3D computer graphics. It deals with the discrete represen-
tation and visualization of objects represented as sampled data in three or more dimensions. A 
volume/voxel data set is a three-dimensional array of voxels. The term voxel is used to character-
ize a volume element; it is a generalization of the notion of pixel that stands for a picture ele-
ment. A volume data set usually contains values that have been obtained by some type of 3D 
scanning or sampling device or by a simulation process. Typical sampling devices are x-ray, 
CAT, MNR, PET, SPECT, and Confocal Laser microscopy. Each voxel consists of a position 
and a value. The voxel position is a three-tuple that specifies a position within the three-
dimensional voxel array. The origin of the volume data set is considered to be the center of the 
first voxel (i.e., the voxel with coordinates (0,0,0)). The first coordinate of the voxel position 
represents the column, the second coordinate represents the row, and the third coordinate repre-
sents the image (or slice).  

Columns, rows, and images are numbered starting from 0. The voxel in the 8th column, 1st row, 
and 2nd image would then have the position (7,0,1). 

3.2.3 Data Sets, Sections and Segments 

A typical voxel data set includes several millions voxels with different gray values within a spe-
cific gray value range. We will use a data set of a MRI scan of a human head (Fig. 36).  

 

Fig. 35 A schematic Voxel data set. 

 

Fig. 36 Data ranges within a voxel data set. 
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The gray values within the MRI scan range from 0 to 728. Different tissues within the data set 
appear with different gray values within the data set. However we can not always separate a cer-
tain tissue or structure within the data set by just specifying a gray value range. E.g. the gray 
value within the brain in our example range from 83 to 447 but other tissues within the data set 
e.g. parts of the muscles and skin have gray values within the same gray value range. This means 
it is not possible to get a visualization of the brain tissue only by defining a simple gray value 
range, in other words by a gray value classification. For these cases VGStudio MAX 1.0 includes 
powerful segmentation tools allowing manual or semi automated definition of structures within 
the data set according their morphological properties. In our MRI data set example VGStudio 
MAX' segmentation where used to classify the brain tissue by creating a 3D selection of all Vox-
els belonging to the brain. The result of such a morphological classification is called a Section. 
The MRI data set in our MRI example will now include two sections: section (1) which includes 
all voxels representing the brain and section (0) including all the remaining voxels. The tissue 
within the brain can further be classified into the white and the gray brain mass.  

In this case the two tissues can easily be separated by a gray value classification since these two 
tissues appear clearly within two separate gray value ranges and there are no other tissues within 
this section of the data set. (see Fig. 37). This leads us to the principle data hierarchy supported 
by VGStudio MAX 1.0: VGStudio MAX 1.0 allows to handle an arbitrary number of data sets at 
the same time. A data set can be divided into an arbitrary number of sections (morphological  
classification). Each section can be divided into several segments (gray value classification) (see 
Fig. 38).    

 

Fig. 37 MRI data set with brain section and brain tissue gray value classification. 
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Sections are created and manipulated by the Segmentation tool (for more information on the 
Segmentation tool, please refer to Chapter 4.6.10 Segmentation) as well as the Scene tree tool 
(for more information on the Scene Tree tool, please refer to Chapter4.6.2 Scene Tree) which 
allows to select, delete and merge sections. Segments are created and handled by the Classifica-
tion tool (for more information on the Classification tool, please refer to Chapter 4.6.1 
Classification Tool).  

3.2.4 The Illumination Model 

VGStudio MAX supports an illumination of the scene by two light sources with parallel light. 
You may adjust the light settings in the Light properties dialog (for more information on the 
Light properties tool, please refer to Chapter 4.6.4 

 

Fig. 38 Data hierarchy.  
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Light Properties). 

The Front light source is positioned in 0°, i.e. in the eye of the observer, the Shadow light 
source is positioned in 45°, to the right of the observer. The light sources are located at fixed 
positions relative to the observer. 

 

Activating the shadow light source will considerably enhance the 3D perception of an image.  

3.2.5 VGStudio MAX Clipboard 

VGStudio MAX has its own clipboard and does NOT use the standard clipboards of your operat-
ing system since these clipboards are not capable to handle the different data used by VGStudio 
MAX. Due to this you will not be able to use the cut, copy, and paste commands to copy data or 
images into other applications or from other applications into VGStudio MAX. Use the Save 
Image command to export rendered 3D images or slice images in standard image files. 

3.2.6 Exiting VGStudio MAX 

To exit VGStudio MAX, click File in the menu bar and select Quit. If there are any unsaved 
scenes, VGStudio MAX will ask you whether you want to save them before exiting. You may 
also exit VGStudio MAX by clicking the Close Window button in the upper right corner of the 
window. 

 

Fig. 39 Usage of the light sources in VGStudio MAX will 
enhance the 3D perception of an image. 
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3.3 Image Quality versus Rendering Speed 

With every decision you make in VGStudio MAX, you make a trade-off between rendering 
speed and image quality. As a rule of thumb, the higher the quality of the rendered images, the 
slower the rendering speed. Additional lights or many semitransparent structures in the image 
will increase the rendering time. 

As you go through the scene creation process, you will probably want to keep the rendering qual-
ity low in order to increase the rendering speed. 

When you are satisfied with your scene, you may increase the rendering quality to see what the 
scene looks like in its final form. 

Here are some hints on how to adjust parameters in order to achieve optimal settings for per-
formance or quality. 

Optimal settings for performance: 

�� Use the Scatter HQ algorithm, 

�� use small result image sizes, e.g. 256x256, 

�� use only front light and disable shadow light source, 

�� use oversampling factor of 1.0, 

�� deactivate color rendering, 

�� use opaque data structures and avoid transparent data. 

Optimal settings for image quality: 

�� Use the Scatter HQ or Scatter + Gradients algorithms, 

�� use large result image sizes, 

�� use oversampling factor of 3.0 or more, 

�� activate color rendering. 





 

 

4 VGStudio MAX Interface & Tools 

This chapter will guide you through the various functions of VGStudio MAX. Before you actu-
ally start working with the program, you should familiarize yourself with the various parts of the 
interface. In this chapter, the following parts of the interface will be explained in detail: 

�� Menu bar 

�� Tool bar 

�� Tool box  

�� Slice windows 

�� 3D window 

�� Status bar 
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4.1 Basic Concepts of the VGStudio MAX User Inter-
face 

4.1.1 2D slices and 3D images 

In the past, working with volume or voxel data meant working with stacks of 2D image slices. 
Radiologists got tenths of images from a CT scanner and viewed them slice by slice along the 
scan axis to get a 3D impression of the data. Thanks to the upcoming computer technology, radi-
ologists now have the possibility do use MPR (Multi Planar Reconstruction) image slices, which 
means that they can view image stacks not only along the scan axis but also along all three axes 
of a voxel data set. VGStudio MAX overcomes the limitations of simple 2D image viewing. It 
provides full 3D visualization and analysis functionality. In addition, VGStudio MAX supports 
the MPR technology. The VGStudio MAX user interface includes a 3D view window as well as 
the 2D image viewing windows with the three orthogonal cross sections axial, frontal, and sagit-
tal. 

 

 

Fig. 40 In addition to the 3D view window, VGStudio MAX also displays 2D im-
age viewing windows with the three orthogonal cross sections axial, frontal, and 
sagittal. 



4.1 Basic Concepts of the VGStudio MAX User Interface 

VGStudio MAX 1.0 User’s Manual 63

4.1.2 VGStudio MAX Color Coding 

The x-, y-, and z-axes and the planes orthogonal to these axes are coded by a color scheme 
throughout the whole VGStudio MAX user interface. The x-axis and image planes orthogonal to 
the x-axis are displayed in red, the y-axis and image planes orthogonal to the y-axis in green, and 
the z-axis and image planes orthogonal to the z-axis in blue. In the three slice windows, a small 
colored tripod is displayed in the lower left corner, which shows the orientation of the respective 
image in the 3D data set. Labels in tools as well as scene axes or grids are displayed in the same 
colors.  

The bounding box of an object includes a colored tripod at voxel position (0,0,0). The axes are 
colored in the same scheme, i.e. the x-axis is red, the y-axis is green, and the z-axis is blue.  

 

4.1.3 Tool tips 

A tool tip will pop up and display the function of an element of the VGStudio MAX user inter-
face when the mouse pointer is placed on an element, e.g. buttons or tools.  

 

Fig. 41 A tripod colored according to the VGStudio MAX 
color scheme is displayed at voxel position (0,0,0). 

 

Fig. 42 Tool tips will pop up when the mouse pointer rests on an icon. 
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4.2 Title Bar Elements 

Title bar 

In the title bar, "VGStudio MAX" and the filename of the current scene are displayed. 

Control icon 

In the left corner of the title bar you find the Control icon, which is used to access the Control 
menu (see following section). Double-clicking the Control icon will close VGStudio MAX. 

Control menu 

You open the Control menu by clicking the Control icon with the left mouse button. You can 
use the Control menu to position the main window or to exit VGStudio MAX. 

Window buttons 

The window buttons can be found in the right corner of the title bar. You can use the buttons to 
position the main window or to exit VGStudio MAX. 
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4.3 Menu Bar 

The Menu bar displays VGStudio MAX’s menu titles. Each menu lists a group of entries, and 
with each entry, a specific action is performed. 

Menus or menu items that are not available are disabled. 

Using the menus 

1. You open a menu by clicking it, or by pressing <Alt> plus the letter that is underlined in the 
menu's title. For example, to open the File menu, you press <Alt> + <F>.  

2. Once you have opened a menu, you choose a menu item by clicking it, by pressing the under-
lined letter, or by using the cursor keys to highlight it and then pressing <Enter>. Menu 
items that appear in gray are currently not available. 

In the following sections, you will find a description of each of these menus in the order in which 
they appear in the menu bar. 

4.3.1 File Menu 

Click File to open a pulldown menu containing the following entries: 

Fig 43 The File menu
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�� New—Select this command to create a new scene. Note that selecting this entry will close 
the scene you are currently working on. After you have created a scene, you can save it by 
using the Save command. The scene can be accessed again using the Open command. Both 
commands are described below. You may also use the keyboard shortcut Ctrl+N to create a 
new scene. 

�� Open—Select this command to open an existing scene. You may load Volume Graphics Info 
files (.vgi extension) as well as old info files (.info extension) by selecting the desired file 
and clicking Open or by simply double-clicking the file in the Open info file window. You 
may also use the keyboard shortcut Ctrl+O to open an existing scene. 

�� Save—Select this command to save your work. You should save your work frequently 
throughout the scene creation process. Saving a scene with Save or Save as will generate a 
Volume Graphics Info file (.vgi extension). The *.vgi file includes data-relevant information 
such as the file name and path, data type, file type, file size, and data mapping as well as 
scene-relevant information such as light settings, rendering algorithm, or background color. 
You may also use the keyboard shortcut Ctrl+S to save a scene. 

�� Save As—Select this command to save the current scene under a different name. You could 
use this, for example, to save the current scene to a different drive or to save the changes un-
der a different name, thereby keeping the original scene intact. You may also use the F12 key 
on your keyboard to save a scene under a different name. 

�� Merge Object—Select this command to load additional objects into the active scene. To 
merge objects, select a *.vgi file and click Open. If the *.vgi file includes more than one ob-
ject, a dialog box will open where you may select one or several of the included objects that 
are to be loaded into the active scene. The scene properties of the active scene, e.g. back-
ground color, scene resolution or illumination, will remain unchanged. 

 

 

Fig. 44 Select the objects to be imported and click OK. 
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�� Save Object—Select this command to save the currently selected object only. The object 
will be saved in its default settings; no scene-relevant settings such as position, rotation, or 
clipping will be saved with the object. Only the object’s voxel resolution will be saved. Use 
the Save or Save As command to save an object with all scene parameters.  

�� Import—Select this command to import objects and data of different data types into VGStu-
dio MAX. VGStudio MAX supports image stacks of TIFF, JPEG, BMP, PPM, DICOM, and 
RAW Images as well as RAW data volumes (un-/signed 8, 16, 32 bit Integer, 32 bit Floating 
Point and 32 bit RGBA), HDF volumes, Analyze volumes, and DICOM data. Polygonal data 
can be imported in OFF file format. For more information on how to import images, please 
refer to Chapter 5.1 Importing Data. 

�� Import DICOM images—Select this command to import DICOM volume data or image 
files into VGStudio. Use the file dialog to select one or several data files. For more informa-
tion on how to import images, please refer to Chapter 5.1.6  Importing DICOM Data. 

�� Export—Select this command to export the currently selected object. For more information 
on how to import images, please refer to Chapter 5.2 Exporting Data. 

�� Load camera trajectory—Select this command to load a previously saved camera trajec-
tory. For more information on camera trajectories, please refer to Chapter 4.6.14 Keyframer. 
The file format for camera trajectories is *.trj. 

�� Save camera trajectory—Select this command to save the current camera trajectory. 

�� Save Image—Select this command to save a rendered image or a slice image to a file. Sup-
ported file formats are TIFF, JPEG, BMP, or PPM. The rendered 3D image or one of the 
three slice images may be saved. To save an image, select one of the four windows in the 
workspace by clicking into the image (View window, 3D Scene view, Camera view or one 
of the three slice windows) and then selecting Save Image in the File menu. 

 

 

Reminder: The size, width, and height in pixels of a saved image is independent of 
the applied zoom factor in the 3D or slice windows.  

The size of a saved slice image is the original size of the cross section of the volume 
data set. When saving a slice image, only the cross section of the current volume 
data set will be saved. No bounding box cross sections or instruments will be saved 
in the image. 

The size of a saved 3D image is the size (width and height) which is adjusted in the 
Render properties tool. When saving a 3D image, the full scene as shown in the 
3D window will be saved, including all instruments, active bounding boxes, coordi-
nate axes, or grids. To remove the bounding box of an object use the Deselect option 
in the Edit menu. 

�� Save Window—Select this command to save a rendered image or a slice image with all in-
formation displayed in a window, e.g. measurement tools to a file. For more information re-
fer to  Save Image. 
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�� Print Setup—Select this command to access the standard print options dialog box. 

�� Print Image—Select this command to print the image within the active window. You may 
select one of the three slice windows or the 3D window as the active window by clicking the 
title bar or into one of the windows. You may also use the keyboard shortcut Ctrl+P to print 
the active window. 

 

 

Reminder: The Print option will scale the printed image so that it fits best to the 
page.  

When printing a slice image, only the cross section of the current volume data set 
will be printed. No bounding box cross sections or instruments will be printed. 

When printing a 3D image, the full scene as it is shown in the 3D window will be 
printed, including all instruments, active bounding boxes, coordinate axes, or grids. 
To remove the bounding box of an object use the Deselect option in the Edit menu. 

�� Print Window—Select this command to print the active window with all information dis-
played in a window, e.g. measurement ttols.. For more information refer to  Print Image. 

�� Quit—Select this command to exit VGStudio MAX. Note that if there is an open scene that 
you have not yet saved, VGStudio MAX will ask you whether you want to save your changes 
prior to exiting. You may also use the keyboard shortcut Alt+F4 to exit VGStudio MAX. 

�� List of the last four edited scenes. 
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4.3.2 Edit Menu 

Click Edit to open a pulldown menu containing the following entries: 

�� Undo—Select this command to undo your previous action. This menu item changes depend-
ing on the action you last performed. For instance, if you have pasted an object into your 
scene, the text reads undo: paste object and the object will be removed from the scene when 
you select this command. You may also use the keyboard shortcut Ctrl+Z to undo your last 
command. You may undo the last 100 actions and commands. Only one exception will de-
stroy the undo history. 

 

Reminder: The undo history will be destroyed in a few cases, e.g. when modifying 
a data set by segmentation or when deleting an object. You have to select the undo 
command immediately after having modified or deleted the object. 

�� Redo—Select this command to redo your previous Undo action. This menu item changes 
depending on the Undo action you last performed. For instance, if you have undone the past-
ing of an object, the text reads redo: paste object and the object will be pasted into the scene 
again when you select this command. You may also use the keyboard shortcut Ctrl+Y to 
redo your last Undo command. 

�� Cut—Select this command to cut objects within a scene in VGStudio MAX. The cut objects 
will remain in the VGStudio MAX clipboard. When you cut objects, you cut all related in-
formation such as opacity and color along with whatever you cut. Note that VGStudio MAX 
objects cannot be pasted into another program. You may also use the keyboard shortcut 
Ctrl+X to cut objects. 

 

Fig. 45 The Edit menu. 
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�� Copy—Select this command to copy selected objects into the VGStudio MAX clipboard. 
When you copy objects, you copy all related information such as opacity and color along 
with whatever you copy. Note that VGStudio MAX objects cannot be copied into another 
program. You may also use the keyboard shortcut Ctrl+C to copy objects. 

�� Paste—Select this command to paste previously copied or cut objects into a scene. You may 
also use the keyboard shortcut Ctrl+V to paste objects. 

�� Delete—Select this command to delete any selected object in the scene. Note that you can 
undo this action by using the Undo command explained above. You must, however, undo 
your action immediately after having deleted the object. You may also use the Del key to de-
lete an object. 

�� Duplicate—The Duplicate option is the fastest possibility to generate and use a copy of an 
object. You may also use the keyboard shortcut Ctrl+D to duplicate objects. In contrast to 
the Copy and Paste command the duplicate command does not use the clipboard. The copied 
object will be placed directly into the scene where it can be used immediately. When dupli-
cating an object, VGStudio MAX places the object directly above the original object. The 
relative position will be used as default offset. If the new object is moved, its offset to the 
original object is used as offset for every new duplication process. This procedure is called 
smart duplicate. 

 

 

Reminder: The offset adjusted during a smart duplicate will be set to its default 
value (zero) as soon as the duplicated object is deselected or another object is se-
lected. 

�� Select All—Select this command to select all objects in the scene. You may also use the 
keyboard shortcut Ctrl+A to select all objects. 

�� Deselect—Select this command to deselect all selected objects in the scene. You may also 
use the keyboard shortcut Alt+D to deselect all objects. 

�� Select Inverse—Select this command to invert the active objects in the scene. You may also 
use the keyboard shortcut Alt+I to generate an inverse selection. 

�� Preferences—Select this command to access the Preferences dialog box where you can set 
VGStudio MAX preferences. For more information on this dialog please refer to Chapter 
4.3.3 Setting Preferences. 

4.3.3 Setting Preferences 

Numerous program settings are stored in the preferences file (vgstudio.cfg), located in the 
VGStudio MAX application folder. The settings stored in this file include general appearance 
options, directory information, tool options, and options such as time periods for auto-saving the 
scenes you are currently working on. In the Preferences dialog, you may adjust the settings for 
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Directory information, other Options such as auto-saving, measurement and scene wide used 
Units and Tuning parameters. Preference settings are saved each time you exit VGStudio MAX. 

To open the Preferences dialog box select Preferences in the Edit menu. Then choose the de-
sired preference index card by clicking it. 

The index card Directories is used to set up where VGStudio MAX should look up or save dif-
ferent kinds of files. Enter the appropriate path or click the Browse button to select a directory in 
the Find Directory dialog box. 

The Scenes path is the default directory where the Open file dialog looks up scene files saved as 
Volume Graphics Info files (.vgi).  

The Polygons path is the default directory where the Import - Polygon file dialog looks up po-
lygonal data files (.off). 

The Objects path is the default directory where the Merge object file dialog looks up Volume 
Graphics Info files (.vgi).  

The Raw Imports path is the default directory where the Import - Raw volume import wizard 
looks up raw data files. 

The HDF Imports path is the default directory where the Import - HDF volume file dialog 
looks up Hierarchical Data Format files (.hdf). 

 

Fig. 46 The Preferences dialog box with the Directories 
index card selected. 
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The Dicom Imports path is the default directory where the Import - DICOM image series file 
dialog looks up Dicom and Papyrus files. 

The Images path is the default directory where the Save image file dialog saves image files. 

The Export path is the default directory where the Export file dialog saves volumes. 

The index card Options is used to apply several parameters to VGStudio MAX. 

Auto Saving – Click the Auto Saving Enabled checkbox and enter the Time Step in minutes, 
i.e. the regular interval when VGStudio MAX should auto-save the scene you are currently 
working on. A file named #last.vgi will then be saved. You may use this file to restore your work 
after e.g. a system crash by loading it using the Open command in the File menu. 

CFG-File Options – If the checkbox Use CFG-File is activated VGStudio MAX will load the 
application settings from the vgstudio.cfg file in your VGStudio MAX application folder at 
every startup. If the option Use CFG-File is disabled, VGStudio MAX will start with its default 
settings. If the checkbox Save CFG-File is activated VGStudio MAX will save the application 
settings to the vgstudio.cfg file in your VGStudio MAX application folder every time you exit 
VGStudio MAX. If Save CFG-File is disabled VGStudio MAX will not save any new applica-
tion settings and will use the last vgstudio.cfg configuration file at every startup. 

 

Fig. 47 The index card Options in the Preferences dialog 
box. 
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The index card Units is used to apply units settings to the current scene. 

Measurement Units are the units in which distances, surfaces areas, volumes and cursor posi-
tions are displayed. You can choose every metric unit from nanometers to kilometers, inch and 
units, where units are arbitrary units. All measurement results are displayed in "virtual" voxel 
units if there was no unit applied to the actual scene. The word unit is displayed in the VGStudio 
MAX 1.0 status bar in that case. 

If check box Scene Resolution Settings is activated, then resampling of scene during the render-
ing process will be changed according to the resolution factor applied by the user. Changing this 
setting may cause changes in the appearance of the rendered images and the behavior of the 
scene illumination. As default the Scene resolution is optimized automatically by VGStudio 
MAX 1.0 according to the data loaded so that no user interaction is required.  
 

 

Reminder: Scene Resolution Settings should only be manipulated by the advanced 
user since it may cause very large memory and computation time consumption. 

 
 

 

Fig. 48 The index card Units  in the Preferences dialog 
box. 
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The Tuning index card is used to adjust interactivity to the computing power of your computer. 

If you are changing the data, which will change the rendering. The standard maximum preview 
volume size is half the size of the original volume in every direction, i.e. an eighth of the original 
volume. The preview volume is used, if you, for example, change the opacity level. Before space 
leaping, other precomputing steps and rendering will be done on the whole volume, this steps 
will be done for the preview volume. If you want interactivity, you may adjust the maximum 
preview volume size. So, if you have a volume of size 512^3 voxels and the maximum preview 
volume size is 128, the preview volume will be 128^3. Being 64 times smaller, the preview vol-
ume will be rendered a lot faster (about the same factor). On the other hand, the image may 
change a lot for the finally rendered volume, if the size difference is to great, since you are prac-
tically rendering only every forth voxel in every direction in the example given above. Try to 
find settings, that are a trade off of your computing power and the preview quality. 

The standard maximum preview resolution is half the render resolution you specify in the ren-
der tool. Choosing a specific maximum preview resolution will lead to a nearly constant render 
frame rate regardless the specified render resolution, because the render time per volume is 
mainly resolution dependent. 

 

Fig. 49 The index card Tuning  in the Preferences dialog 
box. 
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In the General options index card of the preferences dialog you can change the orientation of 
the coordinate system in the slice windows. The standard orientation for the xy slice is that of a 
standard right handed coordinate system, where the x-axis shows to the right and the y-axis up-
wards. In the medical slice window mode, the y-axis shows downwards, the x-axis shows to the 
right. This is the medical convention for the orientation of axial projections. 

In the Classification tool default mode, you can choose, in which mode the classification tool 
will appear. See Chapter 4.6.1 Classification Tool for further information about level/window 
and advanced mode. 

 

 

Reminder: To restore all preferences to their default settings open the VGStudio 
MAX application folder and rename or delete the VGStudio MAX 1.0 configuration 
file (vgstudio.cfg). New default preferences files will be created the next time you 
start VGStudio MAX. 

 

Fig. 50 The index card General options in the preferences 
dialog box. 
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4.3.4 Object Menu 

Click Object to open a pulldown menu containing the following entries: 

�� Disable—Select this command to disable an object or object group. A disabled object will 
not be displayed in the scene. No action can be applied to a disabled object; you first have to 
enable it again. To do so, select the object in the Scene tree tool by clicking it and then se-
lecting the Enable option in the Object menu. The Enable and Disable menu options will 
toggle in the object menu, i.e. will only be visible one at a time. 

�� Enable—Select this command to enable a previously disabled object or object group. To 
enable an object, select a disabled object in the Scene tree tool by clicking it and then select-
ing the Enable option in the Object menu. The Enable and Disable menu options will tog-
gle in the object menu, i.e. will only be visible one at a time. 

�� Move—Select this command to move the selected object or object group. The Move mode is 
characterized by the green bounding box around the selected object or group of objects. 
When moving the cursor into the bounding box, it will take the shape of one vertical and one 
horizontal arrow (see the table in Chapter 3.1.2 Mouse Usage). The object may be moved in 
the image plane by clicking into the bounding box and dragging the mouse while the left 
mouse button is pressed. The object may be moved forwards or backwards (and thus will be 
enlarged or reduced) by clicking into the bounding box and dragging the mouse while the 
middle mouse button (or the Alt key and the left mouse button) is pressed. The whole bound-
ing box may be used as active area to apply the appropriate action. For more information on 
the Move mode, please refer to Chapter 4.6.7 Object Properties. 

�� Rotate—Select this command to rotate the selected object or object group. The Rotate mode 
is characterized by the red bounding box around the selected object or group of objects. 
When moving the cursor into the bounding box, it will take the shape of one vertical and one 
horizontal circular arrow (see the table in Chapter 3.1.2 Mouse Usage). The object may be 
rotated around the x- or y-axes of the image plane by clicking into the bounding box and 
dragging the mouse while the left mouse button is pressed. The object may be rotated around 

 

Fig. 51 The Object menu. 



4.3 Menu Bar 

VGStudio MAX 1.0 User’s Manual 77

the viewing direction by clicking into the bounding box and dragging the mouse while the 
middle mouse button (or the Alt key and the left mouse button) is pressed. The whole bound-
ing box may be used as active area to apply the appropriate action. For more information on 
the Rotate mode, see also Chapter 4.6.7 Object Properties. 

�� Scale —Select this command to scale the selected object or object group. The Scale mode is 
characterized by the dark blue bounding box with squared handles, i.e. active areas on each 
side of the selected object or group of objects. A rectangular shape will appear next to the 
cursor when moving it into the active area (see the table in Chapter 3.1.2 Mouse Usage). The 
object may be scaled along the x-, y-, or z-axes by clicking the handle, i.e. the active area on 
one side of the bounding box and dragging the mouse while the left mouse button is pressed. 
Isotropic scaling may be performed by clicking into the bounding box and moving the mouse 
up or down while the middle mouse button (or the Alt key and the left mouse button) is 
pressed. When several objects are selected, only isotropic scaling is supported. Group the ob-
jects first if you need to perform unisotropic scaling for several objects at a time. For more 
information on the Scale mode, see also Chapter 4.6.7 Object Properties. 

�� Clipbox —Select this command to box clip the selected object or object group along the axes 
of its bounding box. The Clipbox mode is characterized by the cyan bounding box with 
squared handles, i.e. active areas on each side of the selected object or group of objects. 
When moving the cursor into the active area, a scissors will appear next to the cursor (see the 
table in Chapter 3.1.2 Mouse Usage). The object may be clipped by clicking one of the han-
dles of the bounding box and dragging the mouse along the desired clip direction while the 
left mouse button is pressed. Group the objects first if you want to clip several objects at a 
time. For more information on the Clipbox mode, see also Chapter 4.6.7 Object Properties. 

�� Clipplane —Select this command to clip the selected object or object group by an arbitrary 
clipplane. The Clipplane mode is characterized by the cyan bounding box with a normal 
vector on one side of the currently selected object. When moving the cursor into the bound-
ing box, a scissors will appear next to the cursor (see the table in Chapter 3.1.2 Mouse Us-
age). The object may be clipped along an arbitrary clipplane by moving the mouse up and 
down while the middle mouse button (or the Alt key and the left mouse button) is pressed. 
To rotate the clipplane around the origin of the clipplane’s normal vector click into the clip-
plane and drag the mouse while the left mouse button is pressed. The origin of the clipplane’s 
normal vector may be moved to any arbitrary position on the clipplane by clicking the clip-
plane’s normal vector origin with the left mouse button and dragging the mouse while the left 
mouse button is pressed. The clipplane will be disabled if several objects are selected. Group 
the objects first if you want to clip several objects with one clipplane at a time. For more in-
formation on the Clipplane mode, see also Chapter 4.6.7 Object Properties. 

�� Reset —Select this command to reset actions of all categories applied to the selected object 
such as translation, rotation, clipping, and scaling to their default values. Reset single catego-
ries of actions in the Object properties tool. For more information see also Chapter 4.6.7 
Object Properties. 

�� Group —Select this command to combine the current selection of objects or groups to a sin-
gle group. A group of objects can be handled like a single object. The Group command re-
mains disabled until more than one object is selected. Several objects can be selected by 
dragging a frame over the objects in the 3D view window, by clicking the objects with the 
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left mouse button while the Ctrl key is pressed or by clicking the object’s name in the Scene 
tree tool with the left mouse button while pressing the Ctrl or the Shift key. The bounding 
boxes of each selected object will be visible when several objects have been selected. After 
grouping, a single bounding box around all the selected objects will be displayed. You may 
also use the keyboard shortcut Ctrl+G to group the objects. For more information see also 
Chapter 4.6.7 Object Properties. 

�� Ungroup —Select this command to ungroup an object group previously created with the 
Group command. The Ungroup command remains disabled until an object group is se-
lected. You may also use the keyboard shortcut Ctrl+U to ungroup objects. For more infor-
mation see also Chapter 4.6.7 Object Properties. 

 

 

Reminder: The clipping of an object group will be reset as soon as you ungroup the 
object group. 

�� Create reference —Select this command to create a reference of an object. A reference is a 
copy of an object which uses the same classification tool settings (color and opacity settings) 
as the original object. Due to this special property, a reference needs hardly any additional 
system memory. Therefore, a reference is a memory-saving possibility to copy objects. You 
may also use the keyboard shortcut Ctrl+R to create a reference. In the Scene tree tool, a 
small arrow will appear in the symbol displayed on the left-hand side of the scene name  
and next to the scene name, the text reference: # will appear. Applying the Create reference 
command to a polygon object will result in a “normal” copy of the object. Creating a refer-
ence includes a smart placement functionality. An example: select an object and click Create 
reference in the Object menu or press Ctrl+R. The new referenced object will appear as the 
currently selected object. Move the reference to a new position in the scene. Select Create 

 

Fig. 52 Use the keyboard shortcut Ctrl + G to group two or more objects. After hav-
ing grouped the objects, a single bounding box will be displayed around the selected 
objects. Press Ctrl + U to ungroup the objects again. 
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Reference in the Object menu or press Ctrl+R once again. The second referenced object 
will appear in the same relative position as in the first reference. 

 

 

Reminder: The new offsets of the smart create reference procedure will be reset to 
their default values as soon as you deselect the object. 

4.3.5 Scene Menu 

Click Scene to open a pulldown menu containing the following entries: 

�� Camera mode / World view mode—Select this command to switch between Camera mode 
and World view mode. These options are toggles, i.e. only visible one at a time depending 
on the mode you are currently working in. If you are working in World view mode (indi-
cated in the 3D view window with the text scene view), you may switch to Camera mode 
and vice versa. 

�� Axis—Select this command to activate or deactivate the axes within a scene. A small check 
mark in front of the menu item indicates that the axes are activated. The axes can be custom-
ized within the Grid, Axes & Instrument properties dialog which you open by clicking 
Properties in the Scene menu (see below). 

�� Grid—Select this command to activate or deactivate the grid within a scene. A small check 
mark in front of the menu item indicates that the grid is activated. The grid can be custom-
ized within the Grid, Axes & Instrument properties dialog which you open by clicking 
Properties in the Scene menu (see below). 

�� Instrument—Select this command to activate or deactivate the 3D cursor within a scene. A 
small check mark in front of the menu item indicates that the instrument is activated. You 
can move the cursor around in the three slice windows. The cursor position and the appropri-
ate gray or color values are displayed in the status line of the VGStudio MAX user interface. 
The instrument can be customized within the Grid, Axes & Instrument properties dialog 

 

Fig. 53 The scene 
menu. 
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which you open by clicking Properties in the Scene menu (see below). 

�� Distance—Select this command to activate or deactivate the 3D distance measurement tool. 
A small check mark in front of the menu item indicates that the distance tool is activated. 
You can move both ends of the distance tool around independently in the three slice win-
dows. The distance will be displayed in scene units in each slice window somewhere in the 
middle of the distance. The distance tool also will be used to obtain density profiles of your 
voxel objects (see Chapter 4.5.4 Profile Window for more information about profiles). 

�� Angle—Select this command to activate or deactivate the 3D angle measurement tool. A 
small check in front of the menu item indicates, that the angle tool is activated. The angle 
tool consists out of three handles, which define an angle. Each handle can be placed in any of 
the three slice windows. The size of the angle will be displayed in each slice window near the 
angle tool. 

�� Keyframer—Select this command to activate the keyframer. The keyframer can be used to 
create aninamtions, which can be stored frame by frame in one of the supported image for-
mats. For further information see Chapter 4.6.14 Keyframer. 

�� Properties —Select this command to open the Grid, Axes & Instrument properties dialog 
where you may adjust the display of the grid, axes, and instrument. 

Every single grid plane may be enabled or disabled by clicking the checkbox in front of it. The 
grids’ origins can be defined in scene coordinates. The spacing of a single grid cell can be ad-
justed independently for every direction. The number of grid cells in positive and negative direc-
tion can also be adjusted separately for each axis. Click Apply to accept the new settings. To 
reset the values to their default, simply click Reset. If you want to quit the dialog without accept-

 

Fig. 54 The Grid, Axes & Instrument 
properties dialog where you may adjust 
the display of the grid, axes and instru-
ment. Here, the index card Grid is dis-
played. 
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ing the new settings, click Cancel.  

Every single coordinate axis can be enabled or disabled by clicking the checkbox in front of it. 
The coordinate system’s origin can be defined in scene coordinates. The length of each axis in 
positive and negative direction can be adjusted separately for each axis. Click Apply to accept 
the new settings. To reset the values to their default, simply click Reset. If you want to quit the 
dialog without accepting the new settings, click Cancel. 

Use the dialog shown in Fig. 56 to adjust the instrument position in scene coordinates. The size 
of the instrument can also be adjusted. With the instrument you can draw into the current voxel 
object. The parameters for drawing will be set in the Brush box. Size defines the size of the 

 

Fig. 55 The Axes index card in the Grid, 
Axes & Instrument properties dialog. 

 

Fig. 56 The Instrument index card in the 
Grid, Axes & Instrument properties dia-
log. 
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brush in voxels. You can choose the shape of the Brush with the check box 3D: if it is checked, 
the brush will be a cube of the chosen size otherwise the brush will only be a 2D square. Back-
ground and Foreground fields allow to enter the appropriate color in gray values. For more 
information on drawing, please refer to Chapter 4.4.3 Measurement Utilities. Click Apply to 
accept the new settings. To reset the values to their default, simply click Reset. If you want to 
quit the dialog without accepting the new settings, click Cancel. 

All labels related to axes or planes orthogonal to the appropriate axis are colored according to the 
VGStudio MAX color scheme, i.e. all labels related to the x-axis are displayed in red, all labels 
related to the y-axis in green, and all labels related to the z-axis in blue. 

�� Background color —Select this command to choose a background color for the current 
scene. Select one of the default colors from the menu shown in the figure below. 

You may also select Custom color to activate a color selection tool shown in Fig. 58. 

 
 
 
 
 
 
Fig. 57 Select a 
color for handles, 
intervals, and 
segments. 

 

Fig. 58 In the background color win-
dow you may define a background 
color for the active scene. 
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4.3.6 Tools Menu 

Click Tool to open a pulldown menu containing the following entries: 

Use the Tools menu to activate or deactivate the various tools of VGStudio MAX. A check mark 
in front of each entry indicates that a tool is activated. 

�� Classification—Select this command to activate or deactivate the Classification tool. For 
more information on the Classification tool please refer to Chapter 4.6.1. 

�� Render properties—Select this command to activate or deactivate the Render properties 
tool. For more information on the Render properties tool, please refer to Chapter 4.6.3. 

�� Stereo properties—Select this command to activate or deactivate the Stereo properties 
tool. For more information on the Stereo properties tool, please refer to Chapter 4.6.5. 

�� Scene tree—Select this command to activate or deactivate the Scene tree tool. For more 
information on the Scene tree tool, please refer to Chapter 4.6.2. 

�� Light properties—Select this command to activate or deactivate the Light properties tool. 
For more information on the Light properties tool, please refer to Chapter 4.6.4. 

�� World view—Select this command to activate or deactivate the World view tool. For more 
information on the World view tool, please refer to Chapter 4.6.8. 

 

Fig. 59 The Tools 
menu. 
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�� Camera view—Select this command to activate or deactivate the Camera view tool. For 
more information on the Camera view tool, please refer to Chapter 4.6.9. 

�� Polygon properties—Select this command to activate or deactivate the Polygon properties 
tool. For more information on the Polygon properties tool, please refer to Chapter 4.6.6. 

�� Object properties—Select this command to activate or deactivate the Object properties 
tool. For more information on the Object properties tool, please refer to Chapter 4.6.7. 

�� Registration—Select this command to activate or deactivate the Registration tool. For more 
information on the Registration tool, please refer to Chapter 4.6.12. 

�� Keyframer—Select this command to activate or deactivate the Keyframer tool. For more 
information on the Keyframer tool, please refer to Chapter 4.6.14. 

�� Filter operations—Select this command to activate or deactivate the Filter tool. For more 
information on the Filter tool, please refer to Chapter 4.6.11. 

�� Polygon Extract—Select this command to activate or deactivate the Polygon extraction 
tool. For more information on the Polygon extraction tool, please refer to Chapter 4.6.13. 

�� Segmentation—Select this command to activate or deactivate the Segmentation tool. For 
more information on the Segmentation tool, please refer to Chapter 4.6.10. 

4.3.7 Window Menu 

Click Window to open a pulldown menu containing the following entries: 

�� New slice windows—Select this command to open the three slice windows within VGStudio 
MAX’s workspace. The menu entry remains disabled as long a these windows are open in 
the workspace. 

 

Fig. 60 The Window 
menu. 



4.3 Menu Bar 

VGStudio MAX 1.0 User’s Manual 85

�� New 3D window—Select this command to open the 3D window within VGStudio MAX’s 
workspace. The menu entry remains disabled as long a this window is open in the workspace. 

�� New Profile window—Select this command to open the profile window within the VGStu-
dio MAX’s workspace. The menu entry remains disabled as long as this window is open in 
the workspace. 

�� Arrange modes and Cascade—Click one of the Arrange modes 0 to 3 to choose a prede-
fined layout for the windows within the workspace. VGStudio MAX uses a Multiple Docu-
ment Interface (MDI). The 3D window and the three slice windows may also be arranged 
arbitrarily within the workspace by clicking into the title bar of the corresponding window 
with the left mouse button and dragging the window to the desired position. The arbitrarily 
arranged windows may be rearranged by one of the Arrange modes or by the Cascade op-
tion. 

4.3.8 Help Menu 

Click Help to open a pulldown menu containing the following entries: 

�� About—Select this command to open a window with information on your VGStudio MAX 
release. 

 

Fig. 61 The Help 
menu. 

 

Fig. 62 In this window, you will find information on your VGStudio MAX release. 
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�� License update—Select this command to open VGStudio MAX’s Node Locked License 
update window. The license key shown as wildcards, if a valid license is in use, the current 
license date will be shown, too. If you running the application in demo mode, the license key 
fields will be empty. Here you can enter your license key, if you purchased a new license. 
Click Cancel or the Escape key to leave license dialog, click OK or Enter if entered a new 
license key. 

 

�� Manual—Select this command to open VGStudio’s Manual. Please keep in mind that the 
Adobe Acrobat Reader has to be installed on your computer to be able to open up the man-
ual. 

 

 

 

Fig. 63 VGStudio MAX’s License update window. 
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4.4 Icon Bar 

The tools in the icon bar provide quick access to many common VGStudio MAX functions. 
When placing the cursor on an icon, a tooltip will appear which shows the function of the icon. 
The tools are divided into five main categories: 

 

4.4.1 Standard Icon Section 

New  

New—Click this icon to create a new scene. Note that selecting this command will close the 
scene you are currently working on. After you have created a scene, you can save it by using the 
Save command. The scene can be accessed again using the Open command. Both commands are 
described below. You may also use the keyboard shortcut Ctrl+N to create a new scene. 

Open 

 

Fig. 64 The VGStudio MAX icon bar. 

Standard icon section  

Object manipulation section  

Measurement section  

Scene utilities section  

View selection section  

Window layout tools section  

What’s this section  
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Open—Click this icon to open an existing scene. You may load Volume Graphics Info files (.vgi 
extension) as well as old info files (.info extension) by selecting the desired file and clicking 
Open or by simply double-clicking the file in the Open info file dialog. You may also use the 
keyboard shortcut Ctrl+O to open an existing scene. 

Save 

Save—Click this icon to save your work. You should save your work frequently throughout the 
scene creation process. Saving a scene will generate a Volume Graphics Info file (.vgi exten-
sion). The *.vgi file includes data-relevant information such as the file name and path, data type, 
file type, file size, and data mapping as well as scene-relevant information such as light settings, 
rendering algorithm, or background color. You may also use the keyboard shortcut Ctrl+S to 
save a scene. 

Print 

Print—Click this icon to print the active window. You may select either one of the three slice 
windows or the 3D window as the active window by clicking the title bar or into one of the win-
dows. You may also use the keyboard shortcut Ctrl+P to print the active window. 

Cut 

Cut—Click this icon to cut objects within a scene in VGStudio MAX. The cut objects will re-
main in the VGStudio MAX clipboard. When you cut objects, you cut all related information 
such as opacity and color along with whatever you cut. Note that VGStudio MAX objects cannot 
be pasted into another program. You may also use the keyboard shortcut Ctrl+X to cut objects. 

Copy 

Copy—Click this icon to copy selected objects into the VGStudio MAX clipboard. When you 
copy objects, you copy all related information such as opacity and color along with whatever you 
copy. Note that VGStudio MAX objects cannot be copied into another program. You may also 
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use the keyboard shortcut Ctrl+C to copy objects. 

Paste 

Paste—Click this icon to paste previously copied or cut objects into a scene. You may also use 
the keyboard shortcut Ctrl+V to paste objects. 

Undo 

Undo—Click this icon to undo your previous action. This menu item changes depending on the 
action you last performed. For instance, if you have pasted an object into your scene, the text 
reads undo: paste object and the object will be removed from the scene when you select this 
command. You may undo the last 100 actions and commands. Only one exception will destroy 
the undo history. You may also use the keyboard shortcut Ctrl+Z to undo your last command. 
 

 

Reminder: The undo history will be destroyed in case of deleting an object. You 
have to select the undo command immediately after the delete command to undo a 
delete process. 

Redo 

Redo—Click this icon to redo your previous Undo action. This menu item changes depending 
on the last Undo action. For instance, if you have undone the pasting of an object, the text reads 
redo: paste object and the object will be pasted into the scene again when you select this com-
mand. You may also use the keyboard shortcut Ctrl+Y to redo your last Undo command. 

4.4.2 Object Manipulation Section 

VGStudio MAX provides five object manipulation modes: translation, rotation, scaling, clipbox, 
and clipplane. All five modes allow interactive object manipulation. The mode can be selected 
by clicking the icons in the icon bar after you have selected an object. 
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Object manipulation can also be applied by using the Object properties tool which allows the 
user to type in exact translation, rotation, clipping, and scaling values. For more information on 
the Object properties tool, please refer to Chapter 4.6.7. 

Object Selection and Deselection 

Before any object manipulation can be applied, you have to select an object or a group of ob-
jects. A bounding box around an object will indicate that the object is selected. This means that 
the object is the active object to which actions may be applied. When loading an object into 
VGStudio MAX, the object will automatically be the active object, indicated by a green bound-
ing box around the object. You may deselect an object by selecting another object, by clicking 
into the scene outside an object’s bounding box, or by clicking Deselect in the Edit menu (alter-
natively, you may also use the keyboard shortcut Alt+D). 

Click an object to select 
it. A bounding box will 
appear around the ob-
ject. 

Click outside an object’s 
bounding box or press 
Alt+D to deselect an 
object. The bounding 
box around the object 
will disappear. 

Fig. 65 Select or deselect an object. A bounding box around the object indicates that an ob-
ject is selected. 
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Move 

Click this icon to move the selected object or object group. The Move mode is characterized by 
the green bounding box around the selected object or group of objects. When moving the cursor 
into the bounding box, it will take the shape of one vertical and one horizontal arrow (see the 
table in Chapter 3.1.2 Mouse Usage). The object may be moved in the image plane by clicking 
into the bounding box and dragging the mouse while the left mouse button is pressed. The whole 
bounding box may be used as active area to apply the appropriate action. The object may be 
moved forwards or backwards (and thus will be enlarged or reduced) by clicking into the bound-
ing box and dragging the mouse while the middle mouse button (or the Alt key and the left 
mouse button) is pressed. The whole bounding box may be used as active area to apply the ap-
propriate action. Using the Shift modifier in Move mode allows you to move the object along 
either the vertical or horizontal direction of the 3D window image plane. For more information 
on the Move mode, please refer to Chapter 4.6.7 Object Properties. 

 

 

 

 

Fig. 66 The 3D window in Move mode indicated by 
the green bounding box and the tripod displayed next 
to the cursor when moving it into an active area.. 
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Rotation 

Click this icon to rotate the selected object or object group. The Rotate mode is characterized by 
the red bounding box around the selected object or group of objects. When moving the cursor 
into the bounding box, it will take the shape of one vertical and one horizontal circular arrow 
(see the table in Chapter 3.1.2 Mouse Usage). The object may be rotated around the x- or y-axes 
of the image plane by clicking into the bounding box and dragging the mouse while the left 
mouse button is pressed. The object may be rotated around the viewing direction by clicking into 
the bounding box and dragging the mouse while the middle mouse button (or the Alt key and the 
left mouse button) is pressed. The whole bounding box may be used as active area to apply the 
appropriate action. Using the Shift modifier in Rotate mode allows you to rotate the object ei-
ther around the vertical or horizontal axes of the 3D window image plane. For more information 
on the Rotate mode, please refer to Chapter 4.6.7 Object Properties. 

 

 

 

 

Fig. 67 The 3D window in Rotate mode indicated by 
the red bounding box and the ball with arrows dis-
played next to the cursor when moving it into an ac-
tive area.. 
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Scaling 

Click this icon to scale the selected object or object group. The Scale mode is characterized by 
the dark blue bounding box with squared handles, i.e. active areas on each side of the selected 
object or group of objects. A rectangular shape will appear next to the cursor when moving it 
into the active area (see the table in Chapter 3.1.2 Mouse Usage). The object may be scaled 
along its x-, y-, or z-axes by clicking the handle, i.e. the active area, of one side of the bounding 
box and dragging the mouse while the left mouse button is pressed. Isotropic scaling may be 
performed by clicking into the bounding box and moving the mouse up or down while the mid-
dle mouse button (or the Alt key and the left mouse button) is pressed. When several objects are 
selected, only isotropic scaling is supported. Group the objects first if you need to perform uni-
sotropic scaling for several objects at a time. For more information on the Scale mode, please 
refer to Chapter 4.6.7 Object Properties. 

 

 

 

 

Fig. 68 The 3D window in Scale mode indicated by 
the blue bounding box and the perspective box dis-
played next to the cursor when moving it into an ac-
tive area.. 
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Clipbox 

Click this icon to box clip the selected object or object group along the axes of its bounding box. 
The Clipbox mode is characterized by the cyan bounding box with squared handles, i.e. active 
areas on each side of the selected object or group of objects. When moving the cursor into the 
active area, a scissors will appear next to the cursor (see the table in Chapter 3.1.2 Mouse Us-
age). The object may be clipped by clicking one of the handles of the bounding box and drag-
ging the mouse along the desired clip direction while the left mouse button is pressed. The box 
clipping will be disabled if several objects where selected. Group the objects first if you want to 
clip several objects at a time. For more information on the Clipbox mode, please refer to Chap-
ter 4.6.7 Object Properties. 

 

 

Clipplane 

Click this icon to clip the selected object or object group by an arbitrary clipplane. The Clip-
plane mode is characterized by the cyan bounding box with a normal vector on one side of the 
active object. When moving the cursor into the bounding box, a scissors will appear next to the 
cursor (see the table in Chapter 3.1.2 Mouse Usage). The object may be clipped along an arbi-
trary clipplane by moving the mouse up and down while the middle mouse button (or the Alt key 
and the left mouse button) is pressed. To rotate the clipplane around the origin of the clipplane’s 

 

 

Fig. 69 The 3D window in Clipbox mode indicated by the cyan bounding box and the scissors 
displayed next to the cursor when moving it into an active area.
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normal vector click into the clipplane and drag the mouse while the left mouse button is pressed. 
The origin of the clipplane’s normal vector may be moved to any arbitrary position on the clip-
plane by clicking the clipplane’s normal vector origin with the left mouse button and dragging 
the mouse while the left mouse button is pressed. The clipplane will be disabled if several ob-
jects are selected. Group the objects first if you want to clip several objects with one clipplane at 
a time. For more information on the Clipplane mode, please refer to Chapter 4.6.7 Object Prop-
erties. 

 

  

Fig. 70 Clip the object along an arbitrary clipplane by dragging the mouse up or down while 
the middle mouse button is pressed. By dragging the mouse inside the active area while the left 
mouse button is pressed, the clipplane will be rotated in any arbitrary direction. 
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4.4.3 Measurement Utilities 

Three different utilities may be activated for data analysis and better evaluation. 

Activate the utilities by clicking one of the three icons in the icon bar. You may only activate one 
utility at the same time 

or by using 3D Instrument, Distance or Angle options in the Scene menu. 

3D Instrument  

Click this icon to activate or deactivate the 3D instrument in the scene. A small cross will appear 
in each slice window as well as in the 3D Window. The 3D instrument can be positioned any-
where in the scene or an object within the three slice windows.  

 

 

 

Fig. 71 The 3D instrument can be used to steer the three slice windows. 
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After activated the 3D instrument information about the instruments position and the data at this 
position will be displayed in the very left section of the status bar. The position is displayed in 
voxel coordinates of the current object (in peaked brackets) and in object coordinates in scene 
units. The gray value at the 3D cursors position is also displayed. In the second section of the 
status bar the current scene unit, e.g. �m, mm, cm, m are displayed. 

The cursor can be moved in two ways: 

- You can click near the center of the cursor, which will focus the slice windows to the slice 
where the cursor is located and you can drag the cursor to any place in the slice. 

- Or you can click in any slice not near the cursor’s center, which will set the cursor to that 
position. You can drag the cursor to any place in that slice until you release the left button. 

When moving the cursor in the slice windows, the three cross sections through the volume data 
will be displayed with the 3D instrument in the center of the three sections. You may use the 3D 
instrument to scroll through the volume data set in the slice windows in two directions simulta-
neously by clicking it with the left mouse button and then dragging the mouse while the left 
mouse button is pressed. 

 

In a slice image, the cursor will appear in red when the cursor is located in the slice that is cur-
rently selected. It will appear in white as soon as the displayed slice is another one than the one 
in which the cursor is positioned at the moment. In the example shown in Fig. 72, the cursor is 
located in slice # 54 and the cursor in the left image slice # 54 is displayed in red. In the right 
image, slice # 55 is shown and the cursor is displayed in white. 

 

  

Fig. 72 The 3D instrument will be displayed in red when the cursor is located in the currently 
selected slice. 
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If the cursor is placed outside the selected voxel data set or if the active object is a polygon ob-
ject, only a red bounding box will appear in the slice windows (see figure below). 

Drawing with the 3D Instrument 

With the instrument you can draw, too. You have a palette of two colors, which will be displayed 
in the status bar. If you want to draw, just press the Shift key and left-click into a slice window 
to draw with the foreground color or press the Shift key and middle-click into a slice window to 
draw with the background color. Drawing also places the instrument to the position, where you 
draw. Drawing outside an object is not possible and will only place the instrument. When the 
Shift key is pressed and the cursor is over an activated slice window, the cursor will have the 
shape of a brush, indicating, that you are in the drawing mode. 

You can choose the back- and foreground colors in two ways: 

�� By pressing the Ctrl key and press the corresponding mouse button (Left button for fore-
ground and Middle button for background) at the location in the slice from where you want 
to peek the color. The cursor will become a pipette as long as you hold the Ctrl key. The 
newly taken drawing colors will be updated in the status bar immediately. 

�� Or by selecting the properties dialog in the scene menu and choosing the instruments section. 
Here you not only can change back- and foreground color, but the size and the shape (square 
or cube) of the brush. Please see Chapter 4.3.5 Scene Menu for further details. 

 

 

Fig. 73 A red bounding box will be displayed when the cursor is placed outside the selected 
voxel data set. 
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Distance Measurement Tool 

 

Click on this Icon to activate the distance measurement tool in the scene. Two short delimiting 
lines connected by a green line will appear in each slice window as well in the 3D window. If the 
delimiting lines are in the slice displayed in a slice window, they will be red, white otherwise. 

Near the center of the green line will appear a marking which shows the distance. The distance 
between the two points will be shown in scene units (for setting units see Chapter 4.3.3 Setting 
Preferences). The distance will be shown in the first field of the status bar, too. 

You can change measure distances in two ways: 

- By clicking on one of the two delimiting lines in any slice and dragging it to another posi-
tion. If the delimiting line is not in the slice displayed, the slice window will “jump” to the 
slice. The delimiting line will appear in red color in case that the slice displayed is the slice 
where the delimiting line is located. 

- Or by clicking anywhere in a slice window, specifying the first point of the line and dragging 
the second point of the line until the line fits your choice. The line defined that way will 
“snap” to the two most significant edges between the two points (for further details see 
Chapter 4.5.4 Profile Window). 

 

Fig. 74 A distance delimiter will be red when 
it is the slice, which is displayed and white if 
not. 
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Angle Measurement Tool 

Click on this icon to activate the Angle Measurement Tool. 

 

The angle measurement tool consists out of two line segments, an arc and three points, defined 
by the centers of squares, which lie at the ends of the line segments. If a point does not lie in the 
displayed slice the square will be displayed white, if it does lie in the displayed slice it will be 
red. A label at the arc shows the value of the angle between the to line segments. The value of 
the angle is also displayed in the first field of the status bar. 

 

Fig. 75 The three points defining the angle 
will be displayed as red squares in the slice 
window if they are in the current slice, white 
otherwise. 
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You can manipulate the angle by left-clicking on one of the points and dragging them to any 
position. If the square defining the point is white, the slice window will jump to the slice where 
the square lies and you will move it there. If you left-click anywhere in a slice window the angle 
measurement tool will be placed to that position with an default angle of about 50°. 

4.4.4 Scene Utilities 

Two different utilities may be activated for better orientation in the scene. 

Activate the utilities by clicking one of the two icons in the icon bar 

or by using the Axis and Grid options in the Scene menu. 

Scene Axes 

Click this icon to activate the scene coordinate axes. The display of the axes can be customized 
in the Properties dialog which you open via the Scene menu. 

 

Fig. 76 Clicking into a slice window with acti-
vated angle measurement tool will set the tool 
to that position with an angle of about 50°. 
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Scene Grid 

Click this icon to activate a grid in the scene. The display of the grid can be customized in the 
Properties dialog in the Scene menu. 

 

Fig. 77 The coordinate axes are displayed. 

 

 

Fig. 78 The grid is activated in the scene. 
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4.4.5 View Selection 

The 3D view window supports three different viewing modes (for more information on the 3D 
view, please refer to Chapter 4.5.2). Click the View selection buttons to activate the appropriate 
mode. 

Camera View 

Use this button to activate the Camera mode. For more information on the Camera mode, 
please refer to Chapter 4.6.9. 

World View 

Use this button to activate the World View mode. For more information on the World view 
mode, please refer to Chapter 4.6.8. 

Keyframer 

Use this button to activate the Keyframer mode. For more Information on the Keyframer, 
please refer to Chapter 4.6.14. 

 

4.4.6 Window Layout Section 

Click one of these icons to select a predefined layout for the windows within the workspace. 
VGStudio MAX uses a Multiple Document Interface (MDI). The 3D window, the profile view 
window and the three slice windows may also be arranged arbitrarily within the workspace by 
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clicking into the title bar of the window and dragging the window to the desired position. The 
arbitrarily arranged windows may be rearranged by clicking one of the window layout buttons. 

You may also arrange the windows by using the options of the Window menu (see Chapter 
4.3.7). 

 

Fig. 79 The VGStudio MAX interface with arbitrarily arranged windows. 
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4.4.7 “What‘s this” Section 

Click this icon to change into “What’s this” mode. A question mark will then be displayed next 
to the cursor. If you need help or information on a certain function simply click into a window or 
on a component of the user interface; a popup window containing online help topics about the 
selected component will then appear. There you will find short information on the functions and 

also on where to find the information in the User’s Manual. 

 

 

Fig. 80 VGStudio MAX’s online help. 
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4.5 The Workspace 

The VGStudio MAX workspace includes four elements, i.e. the 3D window and the three slice 
windows. The 3D window, the slice windows and the profile window may be activated or deac-
tivated by simply clicking into the title bar or into the windows. The three slice windows form 
one entity which means that they can only be opened or closed all together and not separately. 
To close either the 3D window, the profile window or the slice windows, click the Close  but-
ton in the upper right corner of the window. To activate a disabled window again use the Win-
dow menu and select New slice windows, New profile view or New 3D window. For more 
information on how to work with the windows, see also Chapter 4.3.7 Window Menu. 

The layout of the windows in the workspace can also be adjusted arbitrarily by simply clicking 
into the title bar with the left mouse button and dragging the window to the desired position. 
Each window can be positioned or enlarged independently from the other windows. 

You may use the Window menu or the window icons to enlarge, minimize, or close a window. 

Use the Minimize button  to minimize a window within the workspace. 

 

Fig. 81 Default layout screen after VGStudio MAX has been started. 
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Use the Maximize button  to maximize a window within the workspace. 

4.5.1  Slice Windows and Multiplanar Reformatting 

The slice windows provide the VGStudio MAX user with full Multi Planar Reformatting (MPR) 
functionality for voxel data sets. In the slice windows, three perpendicularly oriented cross sec-
tions (axial, sagittal, and frontal) of the currently selected object are displayed. The projection of 
the origin is always displayed in the lower left corner of the window. The coordinate system used 
in the slice images is always the object coordinate system of the currently selected object. Axial 
slices are perpendicular to the z-axis, frontal slices are perpendicular to the y-axis, and sagittal 
slices are perpendicular to the x-axis. 

 

Fig. 82 In the three slice windows of VGStudio MAX, the cross sections axial, 
frontal, and sagittal are displayed. 
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In the title bar of the slice windows, the orientation (i.e. axial, sagittal, or frontal) and the image 
planes (i.e. the xy, yz, and xz planes) are displayed. In the left corner of the title bar you find the 
Control icon, which you use to access the Control menu. Double-clicking this icon will close all 
three slice windows. You can use the Control menu to maximize or minimize the slice windows 
or to close them. The window buttons can be found in the right corner of the title bar. These but-
tons can also be used to maximize, minimize, or close the slice windows. 

In each slice window you will also find two scrollbars to pan large images as well as two zoom 
buttons and one slice selection box. In the lower left corner of each slice window a small tripod 
colored in the VGStudio MAX color scheme will be displayed, which shows the orientation of 
the corresponding slice in the object coordinate system. 

Use the slice selection box in the lower left corner of the slice windows to scroll through the im-
age stack by clicking the up and down arrows or to select a specific slice by typing in the slice 
number and then clicking into another window. The selected slice will then be displayed. 

Use the zoom in and zoom out buttons in the lower right corner of the slice windows to zoom in 
on an image (i.e. enlarge the image) or to zoom out (i.e. reduce the image). The images will then 
be enlarged or reduced by a preset zoom factor. 

 

 

Fig. 83 VGStudio MAX’s frontal view window. 
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When clicking into a slice window with the right mouse button, a context menu will be opened. 

�� Zoom—Select this command to open the Zoom menu. 

The slice window may be zoomed in (enlarged) or zoomed out (reduced). These functions 
may also be applied by using the zoom buttons in the lower right corner of the slice win-
dows. The images will then be enlarged or reduced by a preset zoom factor. The Fit to scene 
option will zoom the slice window so that all objects included in the scene may be seen. The 
Fit to object option allows to zoom the active object so that it is displayed with maximum 
zoom factor. The Actual Pixels option applies a zoom factor so that one pixel in the image of 
the slice window will be one pixel on your screen. 

�� Use original color—Select this command to display the slice images in its original color, 
brightness, and contrast settings. 

�� Use classification color—Select this command to apply the color, brightness, and contrast 
settings of the classification tool to the slice images. 

 

 

Fig. 84 A context menu will be opened 
when clicking into one of the slice 
windows with the right mouse button.

 
 
Fig. 85 The 
Zoom menu of 
the slice im-
ages. 
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�� Object relative mode— Select this command to switch the three orthogonal slice windows 
into Object relative mode. The object will be sliced along the axes of the object coordinate 
system. The originally scanned slice data will be displayed in this case. 

 

�� Scene relative mode—Select this command to switch the three orthogonal slice windows 
into Scene relative mode. The object will be sliced along the axes of the scene coordinate 
system. This mode allows the user to slice the object along any arbitrary axis. To define the 
slicing orientation rotate the object against the scene coordinate system. Select the rotate 

 

Fig. 86 MRI scan sliced in object relative.  
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mode in the 3D window and rotate the object against the scene coordinate system. The scene 
coordinate system can be seen when activating the Axis in the 3D window. 

 

 

 

Fig. 87 MRI scan sliced in scene relative mode.  
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Cross Sections Displayed in the Slice Images 

If several objects are loaded into the scene, only one of the objects will be displayed as slice im-
ages. All other objects or groups of objects will appear as a cross section through their bounding 
box if the box is crossed by the slice plane of the currently selected object. Only the bounding 
boxes will be displayed in the slice windows if several objects, a group of objects, or a polygon 
object are selected. 

If a slice outside the active volume data set is chosen, only a red bounding box will be displayed 
in the slice windows to display the currently selected object. 

 

Fig. 88 If several objects are loaded into the scene, one of the objects will be displayed as a 
slice image; for the other objects, only the bounding boxes will be shown.  

 

Fig. 89 A red bounding box will be displayed if a slice outside the current volume data set is 
chosen. 
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The object that was selected last will remain visible in the slice windows when it is deselected 
until a new object is selected. This feature helps the user to navigate in Camera mode with no 
bounding box visible (for more information on the Camera mode please refer to Chapter 4.6.9 
Camera View). 

4.5.2 3D Window 

The 3D window shows the result image of the rendering process. Two modes are supported in 
the 3D window: Scene view (i.e. World View mode) and Camera view (i.e. Camera mode). 

In the title bar of the 3D window the currently selected mode (World view mode or Camera 
view mode) is displayed. In the left corner of the title bar you find the Control icon, which you 
use to access the Control menu. Double-clicking this icon will close the 3D window. You can 
use the Control menu to maximize or minimize the 3D window or to close it. The window but-
tons can be found in the right corner of the title bar. These buttons can also be used to maximize, 
minimize, or close the 3D window. 

In the 3D window you will also find two scrollbars to pan large images as well as two zoom but-
tons. 

When clicking into the 3D window with the right mouse button, a context menu will be opened. 

 

Fig. 90 The 3D window in scene view mode. 
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Use the Zoom option to open the Zoom menu. 

The 3D window may be zoomed in (i.e. enlarged) or zoomed out (i.e. reduced). These functions 
may also be applied by using the zoom buttons in the lower right corner of the 3D window. The 
image will then be enlarged or reduced by a preset zoom factor. 

The Fit to Window option allows to zoom the active object so that it is displayed with maximum 
zoom factor. The Actual Pixels option applies a zoom factor so that one pixel in the 3D image of 
the 3D window will be one pixel on your screen. 

In the following, the other options of the 3D view context menu will be explained. 

�� Move— Select this command to move the selected object or object group. The Move mode 
is characterized by the green bounding box around the selected object or group of objects. 
When moving the cursor into the bounding box, it will take the shape of one vertical and one 
horizontal arrow (see the table in Chapter 3.1.2 Mouse Usage). The object may be moved in 
the image plane by clicking into the bounding box and dragging the mouse while the left 
mouse button is pressed. The object may be moved forwards or backwards (and thus will be 
enlarged or reduced) by clicking into the bounding box and dragging the mouse while the 
middle mouse button (or the Alt key and the left mouse button) is pressed. The whole bound-
ing box may be used as active area to apply the appropriate action. Using the Shift modifier 
in Move mode allows you to pan the object along either the vertical or horizontal direction of 
the 3D window image plane. For more information on the Move mode, please refer to Chap-
ter 4.6.7 Object Properties. 

 

Fig. 91 The context menu in the 
3D window.

 

Fig. 92 The Zoom 
menu of the 3D 
window. 
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�� Rotate— Select this command to rotate the selected object or object group. The Rotate 
mode is characterized by the red bounding box around the selected object or group of ob-
jects. When moving the cursor into the bounding box, it will take the shape of one vertical 
and one horizontal circular arrow (see the table in Chapter 3.1.2 Mouse Usage). The object 
may be rotated around the x- or y-axes of the image plane by clicking into the bounding box 
and dragging the mouse while the left mouse button is pressed. The object may be rotated 
around the viewing direction by clicking into the bounding box and dragging the mouse 
while the middle mouse button (or the Alt key and the left mouse button) is pressed. The 
whole bounding box may be used as active area to apply the appropriate action. Using the 
Shift modifier in Rotate mode allows you to rotate the object in either around the vertical or 
horizontal axes of the 3D window image plane. For more information on the Rotate mode, 
please refer to Chapter 4.6.7 Object Properties. 

�� Scale — Select this command to scale the selected object or object group. The Scale mode is 
characterized by the dark blue bounding box with squared handles, i.e. active areas on each 
side of the selected object or group of objects. A rectangular shape will appear next to the 
cursor when moving it into the active area (see the table in Chapter 3.1.2 Mouse Usage). The 
object may be scaled along the x-, y-, or z-axes by clicking the handle, i.e. the active area on 
one side of the bounding box and dragging the mouse while the left mouse button is pressed. 
Isotropic scaling may be performed by clicking into the bounding box and moving the mouse 
up or down while the middle mouse button (or the Alt key and the left mouse button) is 
pressed. When several objects are selected, only isotropic scaling is supported. Group the ob-
jects first if you need to perform unisotropic scaling for several objects at a time. For more 
information on the Scale mode, please refer to Chapter 4.6.7 Object Properties. 

�� Clipbox — Select this command to box clip the selected object or object group along the 
axes of its bounding box. The Clipbox mode is characterized by the cyan bounding box with 
squared handles, i.e. active areas on each side of the selected object or group of objects. 
When moving the cursor into the active area, a scissors will appear next to the cursor (see the 
table in Chapter 3.1.2 Mouse Usage). The object may be clipped by clicking one of the han-
dles of the bounding box and dragging the mouse along the desired clip direction while the 
left mouse button is pressed. Group the objects first if you want to clip several objects at a 
time. For more information on the Clipbox mode, please refer to Chapter 4.6.7 Object Prop-
erties. 

�� Clipplane — Select this command to clip the selected object or object group by an arbitrary 
clipplane. The Clipplane mode is characterized by the cyan bounding box with a normal 
vector on one side of the active object. When moving the cursor into the bounding box, a 
scissors will appear next to the cursor (see the table in Chapter 3.1.2 Mouse Usage). The ob-
ject may be clipped along an arbitrary clipplane by moving the mouse up and down while the 
middle mouse button (or the Alt key and the left mouse button) is pressed. To rotate the clip-
plane around the origin of the clipplane’s normal vector click into the clipplane and drag the 
mouse while the left mouse button is pressed. The origin of the clipplane’s normal vector 
may be moved to any arbitrary position on the clipplane by clicking the clipplane’s normal 
vector origin with the left mouse button and dragging the mouse while the left mouse button 
is pressed. The clipplane will be disabled if several objects are selected. Group the objects 
first if you want to clip several objects with one clipplane at a time. For more information on 
the Clipbox mode, please refer to Chapter 4.6.7 Object Properties. 
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�� Reset —Select this command to reset actions of all categories applied to the selected object 
such as translation, rotation, clipping, and scaling to their default values. Reset single catego-
ries of actions in the Object properties tool. For more information see also Chapter 4.6.7 
Object Properties. 

�� Camera mode / World view mode—Select this command to switch between Camera mode 
and World view mode. These options are toggles, i.e. only visible one at a time depending 
on the mode you are currently working in. If you are working in World view mode (indi-
cated in the 3D view window with the text scene view), you may switch to Camera mode 
and vice versa. 

4.5.3 World and Camera View 

VGStudio MAX provides two different modes to view your data: World view mode and Cam-
era view mode.  

By default, VGStudio MAX will start in world view mode. You may switch between World 
view mode and Camera view mode by clicking the icons in the icon bar or by using the Camera 
view or World view option in the Scene menu. 

In World view mode you can view your data from “outside”. By using the World view tool you 
may rotate and move the whole scene or change the viewing angle without affecting the scene 
itself. For more information see Chapter 4.6.8. 

In Camera view mode you can view your data from “inside”. This means that you can place a 
camera into the scene and adjust all camera parameters such as camera position, look-at point, up 
vector, and viewing angle. For more information see Chapter 4.6.9. 

VGStudio MAX users will be able to perform an arbitrary data walkthrough when activating the 
Camera view mode. A camera may be placed into any position within the scene or even within a 
data set. The viewing direction and viewing angle may also be chosen arbitrarily. 
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The camera symbol will appear in all slice images after having activated the Camera view 
mode. The camera symbol looks as follows: 

Several handles are included in the camera symbol. The Camera position handle is marked with 
a small circle. The Look-at point is marked by the tip of the viewing vector. The two front 
edges of the View frustum are the viewing angle handles.  

Each handle may be manipulated by using the mouse. To do so, click the camera handle in one 
of the slice images with the left mouse button and then drag the handle while the left mouse but-

 

Fig. 93 The Camera view mode allows you to view your data 
from inside. You may adjust all camera parameters shown here 
according to your needs. 

 
 
Fig. 94 The camera 
symbol as it is dis-
played in the slice 
images. 

 

Fig. 95 All camera parameters may 
be changed by dragging the handles. 
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ton is pressed to change the camera position. By using two slice images the user will gain full 3D 
control over the camera position. Grab one of the viewing angle handles and drag the View frus-
tum so that it becomes wider or more narrow. This will change the viewing angle of your cam-
era. The changes of the camera position will become visible in all images, i.e. all slice images 
and the 3D window simultaneously. 

The up vector (the up direction defined in scene coordinates) of your camera may also be ad-
justed by clicking with the middle mouse button (or with the left mouse button while holding the 
Alt key pressed) into a slice window and dragging the mouse up or down while the middle 
mouse button is pressed. This will rotate the rendered image around the viewing vector. 

 

Reminder: The option to adjust the up vector with the middle mouse key may not 
be used when the Keyframer is activated. The middle mouse key will add or remove 
Keyframe handes when the Keyframer is activated. For detailed information about 
the Keyframer please refer to Chapter 4.6.14 Keyframer.  

 

The length of the viewing vector is of no importance. 

 

Fig. 96 Reduce or enlarge the view frustum by 
dragging the handles.

 

Fig. 97 Rotate the image around 
the viewing vector.
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While moving the camera the slice images will show the three cross sections through the volume 
data with the appropriate handle either in camera position or the look-at handle as the center of 
the three sections. The active handle which marks the center of the slice sections will be dis-
played in red. The following image shows the slice images with the camera tool activated. The 
look-at handle is the active handle and the slices show the sections with the look-at handle as 
center. 

All camera parameters described here may be adjusted exactly by typing in numerical values in 
the Camera view tool. For more information on this tool, please refer to Chapter 4.6.9 Camera 
View. 

 

 

Reminder: The camera and look-at position are defined in scene coordinates while 
most of the other tools are displayed in object coordinates! Also, the color coding in 
the slice tools may not correspond to the color coding of the camera tool in case of a 
rotated object. 

 

Fig. 98 The 3D window and the slice images while the Camera view mode is selected. 
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4.5.4 Profile Window 

In the Profile Window you can see the data profile along the line defined by the Distance 
Measurement Tool (see Chapter 4.4.3 Measurement Utilities) if it is activated. The Profile 
Window is active only in conjunction with the Distance Measurement Tool . If the Distance 
Measurement Tool is not activated the Profile Window will just show an empty rectangle. If 
Distance Measurement Tool is activated the Profile Window shows the profile of the volume 
object as a function gray value or opacity against scene units. 

You can choose between two profile modes: the opacity profile and the gray value profile. The 
gray value profile is activated if you choose Use original color in any slice window, the opacity 
profile is activated by choosing Use classification color in any slice window. Please refer to 
Chapter 4.5.1 Slice Windows and Multiplanar Reformatting. 

In the title bar of the profile window the currently horizontal and vertical zoom values are dis-
played (see description below). In the left corner of the title bar you find the Control icon, which 
you use to access the Control menu. Double-clicking this icon will close the Profile Window. 
You can use the Control menu to maximize or minimize the Profile Window or to close it. The 
window buttons can be found in the right corner of the title bar. These buttons can also be used 
to maximize, minimize, or close the profile window. 

In the profile window you will also find two scroll bars and for each scroll bar two zoom buttons. 
The vertical scroll bar scrolls the values (either gray values or classification values) and the cor-
responding zoom buttons zoom the range of values displayed. The horizontal scroll bar selects 
the region of the line, where the profile will be displayed. The corresponding zoom buttons select 
the range of the region. 

The Distance Measurement Tool will be displayed by a vertical red dashed line for the first 
point of the distance and a vertical green dashed line for the second point of the distance. In the 

 

Fig. 99 The profile window showing a profile of classification color data . 
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middle between both lines, the distance in the chosen units will be displayed. Where each line 
cuts the profile the value of the profile will be displayed. You can left click on each line and drag 
it to an anrbitrary position, except, that you cannot drag a line above or beyond the other line. 
You can replace the distance by left clicking anywhere into the profile window where no line 
lies, to define the start point of the line. Now you can drag the second point to any place left of 
the starting point until the left mouse button is released. Once the button is released, the two 
points will “snap” to the two most significant points within the two starting points (for “snap-
ping” see below). 

When clicking into the profile window with the right mouse button, a context menu will be 
opened. 

Use the Zoom option to open the Zoom menu. 

Choosing In or Out will zoom both value range and distance range, Value in or Value out will 
zoom value range and Distance in or Distance out will zoom distance range. 

The other menu items of the context menu will be described in the following. 

�� Focus on line— Select this command to adjust region and zoom to the start and end point of 
the Distance Measurement Tool in that way, that the profile within the two points is fully 
visible and the distance (i.e. the two points), too. 

�� Snap line— Select this command to let the two points of the Distance Measurement Tool 
snap at the two most significant edges between the two points, where an edge is defined as an 
inflection point of the profile. The most significant edges are those where of all inflection 
points the first derivative has the highest absolute value. After “snapping” a Focus on line 
action as described above will be performed. 

 

 

Fig. 100 The context menu in the 
profile window.

 

Fig. 101 The 
Zoom menu of the 
profile window. 
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Since the Profile Window is deeply connected with the Distant Measurement Tool, each 
change of one of the points either in a Slice Window or in the Profile Window will effect the 
other window. Especially when you make a new line in a Slice Window by pointing anywhere in 
the Slice Window (assuming Distance Measurement Tool is activated) and dragging the second 
point to any position, you can always see the profile of that line. Releasing the left button will 
immediately be followed by “snapping” the line and a focus on that line as described at Snap 
line above. Also changing the line in the Profile Window as described above will be shown di-
rectly in the Slice Windows. 

 

Fig. 102 The workspace with slice windows, 3D window and profile window. Distance 
measurement tool is activated. 
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4.6 Tool Box 

The tool box is located on the right-hand side of the VGStudio MAX user interface. The acti-
vated tools will all be located in the tool box. You may scroll through the tool box by means of 
the scroll bar located on the right-hand side of the tool box. 

Tools can be enabled or disabled. To do so click the corresponding menu item in the Tools 
menu. A check mark next to the entries will show that the tool is enabled. A tool which was just 
enabled will appear at the bottom end of the tool box. 

You may also arrange the tools in an arbitrary vertical order within the tool box by clicking into 
their title bar with the left mouse button and then dragging them to the desired position within 
the tool box while the left mouse button is pressed. 

Tools can also be dragged out of the toolbox by clicking into their title bar with the left mouse 
button and then dragging them to the desired position outside the tool box. The tools are then 
“floating” tools which are independent of the main application window. Tools dragged out of the 

 

Fig. 103 The tool box of VGStudio MAX. 
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tool box will stay on top all the time. Inside the tool box, the tools have a fixed size. If you need 
to enlarge or reduce the windows, e.g. for better handling, you first have to drag them out of the 
tool box. Most tools can be resized when they are located outside the tool box by clicking into 
the frame of the corresponding window and then dragging the mouse until the desired size is 
reached. When placing the tool back into the tool box, it will be reduced or enlarged to its default 
size. The tool will be resized to the size defined by the user once it is dragged out of the tool box 
again. 

When you deactivate all tools, the tool box will shrink so that the whole window can be used as 
workspace. Activate a tool to expand the toolbox again. 

 

 

Fig. 104 The Classification tool is now inside the tool box. Click into the title bar 
of the tool and drag it out of the tool box while the left mouse button is pressed. 
You may then adjust the size of the tool.
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You may use the Close button  to close a tool. Use the Tools menu to enable a tool again by 
clicking it. A check mark will then appear next to the menu item. For further information on the 
Tools menu, see also Chapter 4.3.6. 

Use the minimize button  to minimize the tool. If you press the minimize button in a floating 
tool, the tool will be placed back into the tool box as a minimized tool and will appear at the end 
of the tool box. 

When you click the maximize button  of a tool, it will be taken out of the tool box and will 
become a floating tool. If you press the maximize button  in a floating tool, the tool will be 
placed back into the tool box as the last tool in the box. 

4.6.1 Classification Tool 

The Classification tool is one of the most important and most powerful tools of VGStudio MAX 
1.0. The main purpose of the Classification tool is used to apply user-defined transfer functions 
to the data for both opacity and color. The opacity transfer function can be adjusted in the graph 
which is shown in the Opacity manipulation area. 

 

Fig. 105 The Classification tool is dragged out of the tool box where you may adjust 
its size to your needs. 
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The default transfer function maps the darkest gray values to transparent and the brightest gray 
values to totally opaque. The default color mapping is set to white. The default mappings may be 
manipulated arbitrarily. Thus, the Classification tool allows the user to apply any transparency 
level or color to any gray value within the data set. The examples below show what the images 
will look like when you change the opacity values. 

 

 

Reminder: Exceptions occur in case of RGBA color data, e.g. colored TIF, JPEG, 
BMP, or PPM images or RAW RGBA data. No color mapping will be possible for 
color data. The color intensity is used as “gray value” in the classification tool for 
color data. 

 

 

Fig. 106 The Opacity manipulation area of the Classification tool.

Default Reduce noise Soft tissue  
semi-transparent 

Remove soft tissue 

 

 

Fig. 107 When changing the opacity values, the images will look like shown here. 
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The classification tool can be used in two different modes: Level/Window mode and Advance 
mode. Level/Window mode provides an easy to use interface which allows to apply a simple 
opacity ramp with a defined width and center. Window-leveling is mostly used and well known 
in the medical community. Advanced mode allows the user to apply arbitrary opacity functions 
which can not be generated by using a simple ramp. Both modes are described in this chapter.  

 

The Classification tool consists of several elements: 

�� Preset selection 

In Advanced mode: 

�� Object overview 

�� Opacity manipulation area 

In Level/Window mode: 

�� Level – Window area 

�� Opacity manipulation area 

�� Color manipulation area 

Preset selection 

The Preset selection contains a set of predefined Window-Level/Opacity and color settings. 
Clicking the Preset selection will show several predefined settings. Clicking one of these presets 
changes the Window and Level settings or the opacity function in the classification tool to the 
preset values. You may apply the various presets to see which works best for displaying the vol-
ume.  

   

Fig. 108 Select a classification tool preset from the pull down 
list. 
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The following presets for medical users are included as default and therefore may not be re-
moved from the preset list: Ramp, Inverse Ramp, CT-Bone, CT-Tissue, CT-Lung, CT-Liver, 
CT-Abdomen, CT-Bone/Tissue, CT-Color and MR-Head. 

You may add your own or overwrite existing settings in the preset list by saving the current set-
tings defined in the classification tool. Press the right mouse key within the classification tool to 
bring up the context menu. Select the Save preset option to save the current settings. 

 

A dialog will come up to where you have to either select an existing preset to overwrite or to 
enter an name to create a new preset. 

A Preset will be applied relative to the existing data range of your data. This means that the color 
and opacity/window – level settings for a certain gray value may vary in case that the data range 
(minimum to maximum gray value in your data) changes. You may save absolute Presets to pre-
vent this behavior. Activate the Absolute Preset check box in case that the Presets should be 
applied according to absolute gray values. 

You may delete a preset from the preset list. To do so press the right mouse key within the clas-
sification tool to bring up the context menu. Select the Delete preset option to delete the selected 
preset. Keep in mind that default Presets can not be deleted. 

Fig. 109 The context menu 
with the Save/Delete preset 
options.. 

 

Fig. 110 The Save preset dialog..
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Object overview (Advanced mode) 

The Object overview section of the Classification tool is divided into two parts, i.e. the opacity 
area which shows the grayscale to opacity mapping function and the color area which shows the 
color mapping. 

As the name says, the Object overview section provides the user with an overview of the entire 
grayscale and opacity range as well as the color settings of the selected object. To display the 
grayscale and opacity range of the active object, click with the left mouse button into the opacity 
area of the Object overview section. The values will disappear as soon as you release the mouse 
button. 

The Object overview section may also be used to define a Region of Interest (ROI) within the 
opacity area. The ROI will be displayed enlarged in the Opacity manipulation area of the clas-
sification tool. 

 

 

Fig. 111 The Object overview section is divided into two parts, i.e. the opacity area and the 
color area. 

 

Fig. 112 When clicking into the opacity 
area of the Object overview section, the 
grayscale and opacity values of the active 
object will be displayed.
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By default, the ROI covers the whole opacity area. The background of the opacity area will be 
white.  

When defining a ROI the background of the opacity area will be gray while the ROI has a white 
background. 

The ROI may also be set for a single segment by clicking with the left mouse button into the 
appropriate segment of the color area in the Object overview section. 

 

Fig. 113 Define regions of interest in the Object overview section of the Classification tool.

Fig. 114 The ROI covers the 
entire opacity area. 

Fig. 115 Once you have de-
fined a ROI, the opacity area 
will be displayed in gray and 
the ROI in white. 

 

Fig. 116 Set a ROI for a single segment 
only. 
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Arbitrary ROIs may be defined by moving the mouse cursor to one of the four borders of the 
opacity area. The mouse cursor will change as shown in the images below which indicates that 
the manipulation of the ROI is possible. When the mouse cursor changes click the left mouse 
button and drag the ROI border in the desired direction. The appropriate border value will be 
displayed while changing the ROI. 

A ROI may be moved in the opacity area like a magnifier. Click with the left mouse button into 
the ROI and drag the ROI around while keeping the left mouse button pressed. The appropriate 
border values will be displayed while moving the ROI. 

Click with the right mouse button into the Object overview area to open a context menu con-
taining the entries shown in the following figure. 

The menu option Reset ROI will reset all ROI settings. 

 

 

Fig. 117 Change a ROI by dragging the 
ROI’s borders to the desired position.

 

Fig. 118 Drag the ROI around in the opac-
ity area. 

Fig. 119 The context menu which opens 
upon clicking into the opacity area with the 
right mouse button.
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The menu option Delete all segments allows you to reset all segment, opacity, and color settings 
to default values which means that all segments will be removed. The default opacity ramp is 
applied and the color is set to white. The Save/Delete preset options may be used to save or de-
lete Window-Level/Opacity and color presets from the Preset selection list. See Preset selection 
within this chapter. 

Opacity manipulation area (Advanced mode) 

The Opacity manipulation area contains the following elements: 

�� Histogram  

�� Opacity function 

�� Opacity handles 

�� Segment borders 

�� Segment names 

 

Fig. 120 The Opacity manipu-
lation area. 
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The gray value histogram of the active data set is displayed in the background of the opacity ma-
nipulation area. You may zoom in or zoom out on the histogram or disable the histogram by 
clicking with the right mouse button into the Opacity manipulation area and then clicking His-
togram in the context menu. Another menu will then open where you may select the appropriate 
function (Disable/Enable histogram, Zoom in, Zoom out, or Zoom reset). 

The default opacity mapping function will look like shown in the following figure. The opacity 
function looks like a linear ramp from the opacity handle at the lowest, darkest gray value with 
zero opacity to the opacity handle at the brightest gray value with maximum opacity. 

The opacity function may be adjusted to any arbitrary shape. New opacity handles may be in-
serted by clicking the desired position with the middle mouse button (or with the left mouse but-
ton while keeping the Alt key pressed). You may also insert a new handle by using the context 
menu which you open by clicking into the Opacity manipulation area with the right mouse 
button. Click the desired position with the right mouse button and then select Insert handle in 
the context menu. 

 

Fig. 121 The different elements of the Opacity manipulation 
area. 

 

Fig. 122 The default opacity 
mapping function. 
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The handle may be moved by clicking it with the left mouse button and then dragging it to the 
desired position while keeping the left mouse button pressed. Opacity handles may be removed 
by clicking them with the middle mouse button (or with the left mouse button while keeping the 
Alt key pressed). You may also remove a handle by using the context menu which you open by 
clicking into the Opacity manipulation area with the right mouse button. Click the handle you 
wish to remove with the right mouse button and then select Remove handle in the context menu. 
Please note that the two outer handles can neither be moved nor removed. 

Any element of the opacity function, i.e. opacity handles or line segments, may be moved within 
the opacity manipulation area by clicking the element and dragging it around while the left 
mouse button is pressed. The cursor’s shape will change when moving it on a handle or the opac-
ity function line to indicate that the appropriate element may be moved. The cursor’s shape also 
indicates into which direction the element may be moved (generally in horizontal and vertical 
direction, which is indicated by one vertical and one horizontal arrow). Please note that the two 
outer handles may only be moved in vertical direction. 

VGStudio allows the user to generate the maximum number of one opacity handle per gray 
value. This provides a maximum degree of freedom when applying an arbitrary opacity mapping. 

 

Fig. 123 Insert a new handle by clicking the 
desired position with the middle mouse but-
ton. 

 

Fig. 124 The new handle is 
displayed.  

 

Fig. 125 You may drag the line and the handles to new positions with 
the left mouse button pressed.
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VGStudio MAX 1.0 provides the user with a powerful tool to separate structures within a vol-
ume data set by their gray value range. This process is called gray value segmentation. A seg-
ment is defined by a gray value range within a data set. A segment may include a range from one 
single gray value up to the full gray value range of the volume data set. 

To define a gray value segment, place the cursor on the borders of the Opacity manipulation 
area so that the cursor’s shape changes as shown in the following figure. 

Keep the left mouse button pressed and drag the line to the desired position in the Opacity ma-
nipulation area. The segment ranges will be displayed while dragging the line. 

A new segment may be generated by dragging either the left or the right border of the Opacity 
manipulation area or the blue segment border line. When placing the cursor on one of the seg-
ment border lines, it will assume different shapes. Each shape indicates the action that can be 
applied when clicking the line with the left mouse button and then dragging the line (see Fig. 129 
for the different shapes the cursor may assume).  

 

Fig. 126 The Opacity manipu-
lation with four new handles. 

 

Fig. 127 To define a segment, 
drag the line to the desired 
position. 

 

Fig. 128 While dragging the line, the seg-
ment ranges will be displayed.
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VGStudio allows the user to generate the maximum number of one segment per gray value. This 
provides a maximum degree of freedom when applying arbitrary opacity and color values. 

The segment names displayed in the Opacity manipulation area may be changed. To do so, 
simply click the name with the left mouse button and type in the new name. 

Press the right mouse button within the Opacity manipulation area to the context menu. Fea-
tures such as Copy opacity curve, Paste opacity curve, Cut segment, and Delete segment may 
be disabled; this depends on the position you click with the right mouse button within the Opac-
ity manipulation area. In the context menu of the Opacity manipulation area you will find the 
following functions: 

   

Fig. 129 The cursor shown in the left image indicates that you may generate a new segment to 
the left of the current segment’s border. The middle image indicates that the segment border may 
be moved to the left or right. The right image indicates that you may generate a new segment to 
the right of the current segment’s border.

 

 

Fig. 130 Change the segment name in the Opac-
ity manipulation area by clicking the name with 
the left mouse button and then typing in the new 
name. 
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�� Insert handle—Select this command to generate a new opacity handle in the Opacity ma-
nipulation area. The handle will be inserted at the position you click with the right mouse 
button. 

�� Delete handle—Select this command to remove an opacity handle from the Opacity ma-
nipulation area. Click the handle to be removed with the right mouse button and then select 
Delete handle in the menu. 

�� Reset opacity curve—Select this command to open the following menu: 

- Default—Select this command to apply the default opacity function to the appropriate 
segment. 

- Full transparent—Select this command to set the opacity to totally transparent. 

- Full opaque—Select this command to set the opacity to totally opaque. 

�� Copy opacity curve—Select this command to copy the current segment’s opacity curve into 
the clipboard. Use Paste opacity curve to paste the copied opacity settings to another object 
or segment. 

�� Paste opacity curve—Select this command to paste a previously copied opacity curve to 
another object or segment. 

�� New segment—Select this command to generate a new segment. Use the following menu to 
decide on which side of the current segment the new segment is to be generated, i.e. either on 

 
 
 
 
 

 
 
 
 
 
 
Fig. 131 The context 
menu of the Opacity ma-
nipulation area. 
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the left-hand side or the right-hand side. 

�� Cut segment—Select this command to cut the current segment. Use the following menu to 
decide which segment should be expanded when cutting the current segment. 

�� Delete segment—Select this command to delete the current segment. Use the following 
menu to decide which segment should be expanded when deleting the current segment. 

�� Disable/Enable—Select this command to disable a segment. In the Opacity manipulation 
area, a disabled segment will be shown with a gray background; the text disabled will be 
displayed in brackets beneath the segment name. In the 3D and the slice windows, the seg-
ment will no longer be visible. The same effect may be achieved by mapping the opacity 
curve to totally transparent. A disabled segment’s opacity or color mapping may be manipu-
lated, but the results of such a manipulation can only be observed in the 3D and the slice 
windows when the segment is enabled again. 

�� Extract—Select this command to extract a segment from the original volume object. 
VGStudio’s Extract function allows the user to separate parts of a volume data set which are 
defined by a segment, i.e. by a gray value range. The extract process will generate a new in-
dependent object in the scene. The new object may be manipulated independently from the 
original object. 

Extract Example 

Since it is a very powerful and useful feature of VGStudio MAX 1.0, the Extract function will 
be explained here by means of an example. We will use a CT scan of a human jaw. 
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The classification tool above shows three gray value segments within the CT data set. Segment 1 
includes the gray value range from 0 to 658. It represents the noise and air within the CT data 
set. Segment 2 ranges from 659 to 1443 and represents the soft tissue. Segment 3 includes the 
brightest gray values from 1444 to 4095. It represents the bone structures and the metal of the 
braces in the CT data set. As we can see in Chapter 4.6.1 Classification Tool, the opacity and 
color mapping of the three segments can be handled independently of each other. However, the 
geometric settings such as position, rotation, scaling, and clipping of one of the segments cannot 
be handled independently from the rest of the CT scan. The Extract function is an easy-to-use 
and powerful tool to generate images as shown below in Fig. 136 where the soft tissue is re-
moved from half of the jaw. 

In the example shown here we need to clip the soft tissue only. In order to clip only one segment 
the segment has to be extracted. 

 

Fig. 132 The CT scan of a human jaw and the Classification tool with three gray value 
segments defined. 
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In the Opacity manipulation area, click into Segment 2 (named “soft tissue”) with the right 
mouse button. Select Extract segment in the context menu. After the extraction process, only 
the extracted soft tissue segment with a gray value range from 659 to 1443 will be shown in the 
Classification tool. 

 

Fig. 133 To extract a segment, click into the segment with the 
right mouse button and select Extract segment from the context 
menu.

 

Fig. 134 After the extraction process, only the 
soft tissue segment will be shown. 
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In the Scene tree the new object will be displayed with the following name: “soft tissue [ex-
tracted of CT scan of a human jaw: 1]”. 

The newly created object only includes the soft tissue and may now be manipulated independ-
ently from all other objects in the scene like any other object. It may be positioned, rotated, 
scaled, or clipped; the opacity and color mapping may also be changed. In our example, the soft 
tissue object was clipped half by means of the clipbox mode, so that half of the bone structure 
can be seen. Please note that you have to enable both the CT scan of the jaw and the extracted 
soft tissue; otherwise the bone structure will not be visible when clipping the object. 

The extracted segment in the original volume data object will not be destroyed. The extracted 
segment will only be disabled in the original object.  

 

Fig. 135 In the Scene tree, the newly created object will be 
displayed. 

 

Fig. 136 The CT scan of a human jaw 
after the soft tissue has been removed 
from half of the jaw. 
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The extracted and disabled segment may be enabled again by using the Enable segment option 
in the context menu of the Opacity manipulation area. This allows the VGStudio user to ex-
tract a segment several times to apply different clippings or opacities as shown in the following 
example. 

Data extracted from an object may be saved to disk as a separate data file. If data from an ex-
tracted segment is saved with the Export raw option of the File menu, only the gray value range 
of the extracted segment will be saved. All other voxels with gray values below the data range of 
the extracted segment will be mapped to the minimum value of the appropriate data representa-
tion, all values above the data range will be mapped to the maximum value of the appropriate 
data representation. 

 

Fig. 137 The soft tissue segment will be disabled 
after the extraction process. 

 

Fig. 138 Different clippings or opaci-
ties may be applied to an object. 
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In the example shown here a segment was extracted out of a signed 8 bit integer data set (data 
range –128 to 127). The voxels with gray values below the extracted segments data range will be 
mapped to –128 while the voxels with values above the extracted segments data range will be 
mapped to 127. Only the gray values within the extracted segments data range will remain. 

In most cases, the size of the bounding box of an extracted object will differ from the size of the 
original object. The new bounding box will be cropped so that the extracted object will fit ex-
actly into the bounding box. 

In the following you will find a description of the remaining context menu entries of the Opacity 
manipulation area. 

�� Histogram—Select this command to open the histogram menu. 

 

Fig. 139 After the extraction process, only the gray values within the 
extracted segments will remain. 



4. VGStudio MAX Interface & Tools 

VGStudio MAX 1.0 User’s Manual 144 

- Disable histogram—Select this command to disable the histogram within the Opacity 
manipulation area. 

- Zoom in—Select this command to zoom in the histogram within the Opacity manipula-
tion area. 

- Zoom out—Select this command to zoom out the histogram within the Opacity ma-
nipulation area. 

- Zoom reset—Select this command to reset the zoom factor of the histogram within the 
Opacity manipulation area to its default value. 

�� Change to Level/Window mode —Select this command to switch the classification tool 
into Level/Window mode. 

�� Save/Delete preset —Select this command to save or delete Window-Level/Opacity and 
color presets from the Preset selection list. See Preset selection within this chapter. 

Level-Window area (Level/Window mode) 

The user may apply a value for Center (also known as Level value) and Width (also known as 
Window value) of a ramp in Level-Window mode. To adjust the values, simply type in the ap-
propriate values or use the up and down arrows to either increase or reduce the Center or Width 
value. The resulting opacity ramp can be seen immediately in the Opacity manipulation area. 

 

 

 

Fig. 140 The Opacity manipu-
lation area. 
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Opacity manipulation area (Level/Window mode) 

The opacity manipulation area can be used as an convenient tool to adjust the Level and Window   
values. Left-click into the opacity manipulation area and keep the left mouse button pressed 

while moving the cursor up and down will change the Center value while moving the cursor in 
the left and right direction will change the Width value. 

 

Fig. 141 The Opacity manipu-
lation area. 

 

Fig. 142 Moving the cursor horizontal changes the Width 
value while moving the cursor vertical changes the Center 
value . 
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Color  manipulation area 

The Color manipulation area is used to apply and modify the color mapping of an object. The 
default color of a voxel object is white. 

 

 

Reminder: No color mapping will be possible for RGBA color data.  

A color may be applied to a color handle, an interval between two handles, or a whole segment. 
The appropriate element will be marked in the Color manipulation area. 

To apply a color to a handle, interval, or segment double click the appropriate element with the 
left mouse button or open the context menu by clicking the element with the right mouse button. 

 

Fig. 143 The Color manipulation area of the Classification tool. 
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The two handles at an interval or segment border will receive the identical color when applying a 
color to an interval or a segment. Colors between two handles will be interpolated. This allows 
the VGStudio user to easily define color transitions. To create a sharp color transition either cre-
ate gray value segments or insert two color handles with the appropriate color and place the han-
dles directly side by side. 

A single color handle or an interval not adjoined to a segment border may be moved. The mouse 
cursor will change to a two sided arrow as soon as your cursor is placed on a movable element of 
the color mapping area. Click a single color handle with the left mouse button or click into the 
appropriate interval and drag the mouse to the left or right to move the color mapping. The gray 
values of the appropriate color handles will be displayed while moving the color handles or in-
tervals. 

The color mapping will be shifted during the creation process of new gray value segments. Color 
mapping will only be applied to a segment. Color mappings will not be interpolated across seg-
ment borders. You may apply a color to each color handle on both sides of a segment border.  

 

 
 
Handle 

 

 
 
Interval 

 

 
 
Segment 

 

Fig. 144 Different colors may be applied to handles, 
intervals, and segments.

  

Fig. 145 Color handles or intervals that are not adjoined to a segment border may be moved by 
clicking them and then dragging the mouse while the left mouse button is pressed. 
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VGStudio allows the user to insert the maximum number of one color handle per gray value. 
This provides a maximum degree of freedom by applying an arbitrary color mapping. 

Press the right mouse button within the color manipulation area to open the context menu. Fea-
tures such as Copy, Paste segment color, Set segment color, Set interval color, or Set handle 
color may be disabled; this depends on the position you click with the right mouse button within 
the Color manipulation area. 

�� Insert handle—Select this command to generate a new color handle in the Color manipula-
tion area. 

�� Delete handle—Select this command to remove a color handle in the Color manipulation 
area. 

 

Fig. 146 A color is applied to 
segment 2. 

 
 
 
 
 
 

 

 
 
Fig. 147 The context menu of 
the Color manipulation area. 
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�� Set handle color—Select this command to apply a color to a single color handle in the 
Color manipulation area. Use the following menu to choose a color or to open the color se-
lection tool to define a custom color. 

�� Set interval color—Select this command to apply a color to an interval between two color 
handles in the Color manipulation area. 

�� Set segment color—Select this command to apply a color to a whole segment in the Color 
manipulation area.  

�� Copy segment color—Select this command to copy the current segment’s color mapping to 
the clipboard. Use Paste segment color to apply the copied color mapping to another object 
or segment. 

�� Paste segment color—Select this command to apply a previously copied segment color 
mapping to the currently selected object or segment. 

�� Import segment color—Select this command to import a previously saved segment color 
map file.  

�� Export segment color—Select this command to save the color mapping of the currently 
selected segment to a human readable colormap file on your disk.  

�� Save/Delete preset —Select this command to save or delete Window-Level/Opacity and 
color presets from the Preset selection list. See Preset selection within this chapter. 

�� Change to Level/Window mode —Select this command to switch the classification tool 
into Level/Window mode.  

4.6.2 Scene Tree 

The Scene tree shows an overview of all objects included in the scene. It also shows the sections 
of an object, the object type and the hierarchical organization of objects in groups of objects. The 
hierarchy within the scene tree tool is organized as follows: The highest hierarchy level within 
the Scene tree tool is the Scene object  itself. The next level contains voxel-  and polygon-

 
 
 
 
 
 
Fig. 148 Select a 
color for handles, 
intervals, and 
segments. 
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objects  and groups of these objects . A voxel-object contains on or several sections . Sec-

tions are the last hierarchy level within the Scene tree tool. The Scene tree may be used to select 
one or several objects in the scene or a section of an object. Select a single object in the scene 
tree by clicking it with the left mouse button. Use the Shift or Ctrl modifier to select several 
objects. Keep the Ctrl key pressed and select several objects in the Scene tree by clicking the 
objects with the left mouse button. Keep the Shift key pressed and click a second object in the 
scene tree, e.g. the last object in the row. Then all objects in between the two selected objects 
will be selected, too.  

Overview of the symbols used in the Scene tree tool: 

The selection of an object in the scene tree will be indicated with a blue bar highlighting its entry 
in the Scene tree tool. The selected object/objects can now be manipulated by the different  

VGStudio MAX 1.0 features, e.g. move rotate or clip the object. The selection of a section 
within a voxel object will automatically result in the selection of the superior voxel object at the 
same time. The red color of a section entry in the Scene tree tool will indicate the current se-

 

Fig. 149 The Scene tree shows 
objects are included in the scene. 

Object type Enabled Disabled 

Scene Object   

Voxel objects   

Polygon objects   

Reference of a voxel object   

Group of objects 
  

Section of an Object 
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lected section. The current selected sections color and opacity mapping can be manipulated in 
the classification tool.      

 

You may change the name of an object, a section or an object group. Simply double click the 
object with the left mouse button and then type in the new name. 

Objects within the Scene tree tool are sorted in alphabetic order. Changing the name of an object 
within the Scene tree tool will change its position in the Scene tree tool display order. 

 

Fig. 150 The Scene tree shows 
an object with section (8) se-
lected. 

 

Fig. 151 The name of the object may be 
changed by double-clicking it and then typ-
ing in the new name. 
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Clicking into the Scene tree tool or on an object within the Scene tree tool with the right mouse 
button will bring up the context menu for the chosen object. 

Context menu for the Scene tree tool  and toplevel Objects: 

�� Disable—Select this command to disable an object or object group. A disabled object will no 
longer be displayed in the scene. No action can be applied to a disabled object. You first have 
to enable it again. To do so, click the object in the Scene tree window with the left mouse 

button, then click with the right mouse button into the Scene tree window to open the con-
text menu and select the Enable option. The Enable and Disable options will toggle in the 
context menu, i.e. will only be visible one at a time. 

�� Enable—Select this command to enable a previously disabled object or object group. To do 
so, select a disabled object in the Scene Tree window by clicking it with the left mouse but-
ton, then click with the right mouse button into the Scene tree window to open the context 
menu and select the Enable option. The Enable and Disable options will toggle in the con-
text menu, i.e. will only be visible one at a time. 

�� Reset —Select this command to reset actions of all categories applied to the selected object 
such as translation, rotation, clipping, and scaling to the default values. Reset single catego-
ries of actions in the Object properties tool . See also Chapter 4.6.7 Object Properties. 

�� Group —Select this command to combine the current selection of objects or groups to a sin-
gle group. A group of objects can be handled like a single object. The Group command re-
mains disabled until more than one object is selected. Several objects can be selected by 
dragging a frame over the objects in the 3D view window, by clicking the objects with the 
left mouse button while the Ctrl key is pressed or by clicking the object’s name with the left 
mouse button while the Ctrl key or Shift key is pressed in the scene tree tool. The bounding 
box of each selected object will be visible when several objects have been selected. After 
grouping the objects, a single bounding box around all the selected objects will be visible. 

 

Fig. 152 The context menu of a 
top level object. 
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You may also use the keyboard shortcut Ctrl+G to group objects. See also Chapter 4.6.7 
Object Properties. 

�� Ungroup —Select this command to ungroup an object group previously created with the 
Group command. The Ungroup command remains disabled until an object group is se-
lected. You may also use the keyboard shortcut Ctrl+U to ungroup objects. See also Chapter 
4.6.7 Object Properties. 

 

Reminder: The clipping of an object group will be reset as soon as you ungroup the 
object group. 

�� Delete—Select this command to delete any selected object in the scene. Note that you can 
undo a deletion process by selecting the Undo command defined earlier. Remember that you 
have to select the Undo command immediately after having deleted the object. You may also 
use the Del key to delete an object. 

�� Duplicate— The Duplicate option is the fastest possibility to generate and use a copy of an 
object. You may also use the keyboard shortcut Ctrl+D to duplicate objects. The copied ob-
ject will be placed directly into the scene where it can be used immediately. When duplicat-
ing an object, VGStudio MAX places the object directly above the original object. The 
relative position will be used as default offset. If the new object is moved, its offset to the 
original object is used as offset for every new duplication process. This procedure is called 
smart duplicate. 

 

Reminder: The offset adjusted during a smart duplicate will be set to its default 
value (zero) as soon as the duplicated object is deselected or another object is se-
lected. 

�� Create Reference — Select this command to create a reference of an object. A reference is a 
copy of an object which uses the same classification tool settings (color and opacity settings) 
as the original object. Due to this special property, a reference needs hardly any additional 
system memory. Therefore, a reference is a memory-saving possibility to copy objects. You 
may also use the keyboard shortcut Ctrl+R to create a reference. In the Scene tree tool, a 
small arrow will appear in the symbol displayed on the left-hand side of the scene name  
and after the scene name, the text [reference: #] will appear. Applying the Create Refer-
ence command to a polygon object will result in a “normal” copy of the object. Creating a 
reference includes a smart placement functionality. An example: select an object and click 
Create Reference in the context menu or press Ctrl+R. The new referenced object will ap-
pear as the currently selected object. Move the reference to a new position in the scene. Se-
lect Create Reference in the context menu or press Ctrl+R once again. The second 
referenced object will appear in the same relative position as in the first reference. 

 

Reminder: The new offsets of the smart create reference procedure will be reset to 
its default values as soon as you deselect the object. 



4. VGStudio MAX Interface & Tools 

VGStudio MAX 1.0 User’s Manual 154 

�� Select All—Select this command to select all objects in the scene. You may also use the 
keyboard shortcut Ctrl+A to select all objects. 

�� Deselect—Select this command to deselect all selected objects in the scene. You may also 
use the keyboard shortcut Alt+D to deselect all objects. 

�� Select Inverse—Select this command to invert the active objects in the scene. You may also 
use the keyboard shortcut Alt+I to generate an inverse selection. 

�� Properties—Select this command to open the object properties dialog. The dialog provides 
you with two index cards: General analysis and Structural analysis. General analysis 
shows basic information about the volume object, such as data type, size, mean value of the 
voxel values and derivation of the voxel values. Structural analyisis. The volume of the voxel 
object will be displayed as well. 

�� Background color—Select this command to choose a background color for the current 
scene. Select a color within the color selection tool. See also section Background color in 
Chapter 4.3.5 Scene Menu. 

 

Fig. 153 The Properties dialog. 
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Context menu for sections: 

�� Enable/Disable section—Select this command to disable an section of an object. A disabled 
section will no longer be displayed in the scene. No action can be applied to a disabled sec-
tion. You first have to enable it again. To do so, click the section in the Scene tree window 
with the right mouse button to open the context menu and select the Enable option. The En-
able and Disable options will toggle in the context menu, i.e. will only be visible one at a 
time. 

�� Merge section—Select this command to merge two section. Select the section to merge to 
the current selected section from the pull-down menu. 

�� Extract—Select this command to extract a section from the original volume object. VGStu-
dio MAX’ Extract function allows the user to separate parts of a volume data set which are 
defined by a section. The extract process will generate a new independent object in the scene. 
The new object containing only the current section may be manipulated independently from 
the original object and e.g. can be saved as separate data set to a file. 

�� Delete section—Select this command to delete any selected object in the scene. Note that 
you can undo a deletion process by selecting the Undo command defined earlier. Remember 
that you have to select the Undo command immediately after having deleted the object. You 
may also use the Del key to delete an object. 

�� Properties—Select this command to open the object properties dialog. The dialog provides 
you with two index cards: General analysis and Structural analysis. General analysis 
shows basic information about the volume object, such as data type, size, mean value of the 
voxel values and derivation of the voxel values. Structural analyisis 

 

 

 

Fig. 154 The context menu of a 
section. 
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4.6.3 Renderer Properties 

The Renderer properties tools allows you to control the rendering-relevant settings of VGStu-
dio MAX 1.0. The rendering algorithm may be selected as well as the resolution of the resulting 
image and the image rendering quality. 

Rendering algorithms 

In VGStudio MAX 1.0 you may choose between six different rendering algorithms. Use the 
Rendering algorithm section to select one of the following algorithms: 

�� Scatter – This algorithm is a volume rendering algorithm which is suited best for the visuali-
zation of transparent structures only, e.g. in computational fluid dynamics.   

�� Scatter HQ – This algorithm is a volume rendering algorithm. It is the “all-rounder” of 
VGStudio MAX’ visualization algorithms. It is well suited for the visualization of faint gray-
value differences within the voxel data as well as to visualize surface structure details.  

�� Scatter + gradients – This algorithm is a volume rendering algorithm which emphasizes the 
local gradients within the voxel data. Therefore it is suited best to visualize objects with a 
clearly defined surface structure. 

�� Maximum projection (MIP) – The Maximum intensity projection casts rays, one for each 
pixel in the rendering, into the data set. For each ray, the maximum voxel intensity encoun-
tered along the ray is determined. This maximum intensity becomes the value of the pixel as-
sociated with the ray. 

�� Sum along ray – The Sum along ray algorithms casts rays, one for each pixel in the render-
ing, into the data set. For each ray, the voxel opacities are summed along the ray. This opac-
ity sum becomes the value of the pixel associated with the ray. 

 

Fig. 155 The Render proper-
ties dialog. 
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�� X-ray – The X-ray algorithms casts rays, one for each pixel in the rendering, into the data 
set. For each ray, the absorption of each voxel is calculated proportional to its opacities and 
integrated along the ray. This integrated absorption value becomes the value of the pixel as-
sociated with the ray. 

The Renderer Properties, are tightly coupled with the Light Properties (refer to Chapter 4.6.4 
Light Properties). The appearance and quality of the rendered images are especially a result of 
the render algorithm and the light settings. There are two extreme examples rendered of one data 
set shown in Fig. 156.  

The left image emphasizes the surface structures of the object. It was rendered by the Scatter + 
Gradients algorithm with an oversampling of 3.0 and only the Front light source activated. The 
ambient part of the Front light source was set to a very low value while the diffuse part was set 
to a high value The right image emphasizes the transparent tissue and was rendered by the Scat-
ter HQ algorithm with an oversampling of 3.0 and the Front and Shadow light source activated. 
This time the ambient parts of the light sources were set to high values while the diffuse parts 
were set to low values. 

 

 
Fig. 156 Images rendered emphasizing surfaces (left) and transparent structures (right). 
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The following examples show one data set rendered by the six different rendering algorithms. 

 

Result image size  

Use the Result image size in the Render properties dialog to set the size in which the image 
should be rendered by VGStudio MAX. In addition, the image on the screen may be enlarged or 
reduced by applying a zoom factor to the 3D View window. Set the image size by simply typing 
in the desired values or by using the up and down arrows to either enlarge or reduce the width or 
height of the image. 

Rendering quality 

Images may be rendered in true color or in monochrome. Rendering in monochrome will in-
crease the rendering speed by a factor of two. 

 
Scatter Scatter HQ Scatter + gradients 

 
Maximum projection (MIP) Sum along ray X-ray 

Fig. 157 One image is shown in the six rendering algorithms available in VGStudio MAX.
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Oversampling allows to adjust the resampling step width during the rendering process. Higher 
values normally lead to higher image quality. Images may appear darker with higher oversam-
pling factors due to higher light absorption during the rendering process. 

To adjust the values, simply type in the appropriate values or use the up and down arrows to ei-
ther increase or reduce the oversampling value. 

Motion smoothing 

Motion smoothing allows to apply and adjust a reduction factor by which the image size is re-
duced in x- and y- direction while manipulating a scene. Higher reduction factors will lead to 
more smooth interaction. This is a helpful function especially on computers with a lower per-
formance. Type in the appropriate value or use the arrows or the scroll function to enlarge or 
reduce the motion smoothing value. 

Additional settings can be done in the Tuning Dialog in (see Chapter 4.3.3 Setting Preferences 
for further details). 

Perspective rendering  

This switch allows to disable/enable perspective rendering. 
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4.6.4 Light Properties 

VGStudio MAX supports the illumination of the scene by two light sources with parallel light. 
You may adjust the light settings in the Light properties dialog. 

The Overall intensity determines the total brightness of the scene’s illumination. To adjust this 
value, simply drag the slider to the left or the right or type in the desired value and press Enter. 

The Front light source is positioned in 0°, i.e. in the eye of the observer, the Shadow light 
source is positioned in 45°, to the right of the observer. The light sources are located at fixed 
positions relative to the observer. 

The two light sources Front light and Shadow light consist of two parts each, i.e. an Ambient 
part and a Diffuse part. Each part’s intensity can be adjusted independently by typing in the de-
sired values or using the up and down arrows. The diffuse part of the light sources provide a 

 

Fig. 158 The Light properties dialog. 

 

Fig. 159 The front light source and the shadow light source 
are located at fixed positions relative to the observer. 
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shading of the data which emphasizes structures (gradients) within the data while the ambient 
light parts provide an illumination which is independent of the orientation of structures (gradi-
ents) within the data. 

Deactivating the shadow light source will result in an increased rendering speed (when working 
with the Scatter or Scatter HQ algorithms, the speed will be increased by a factor up to two). 

Click the white/colored push buttons to apply a color to the appropriate light source. 

Use the checkbox on the right-hand side to enable or disable the light sources. 

4.6.5 Stereo Properties 

VGStudio MAX supports several stereo image rendering modes. 

Select one of the following rendering modes in the Stereo parameters listbox: 

�� Red-green (red on right eye) 

�� Red-blue (red on right eye) 

�� Interlaced v(ertical) (e.g. for autostereoscopic 3D displays) 

VGStudio MAX 1.0 supports the D4D display. The D4D is a flat autostereoscopic 3D dis-
play, a new type of computer output device for true 3D visual representation of data or other 
three-dimensional information. Information on the D4D can be found on http://kastor.inf.tu-
dresden.de/D4D/ 

�� Interlaced h(orizontal) (e.g. for HMD devices) 

Select a stereo mode in the listbox to activate stereo rendering. Use the Swap checkbox to swap 
between left and right images. By changing the Focal distance and Eye distance values you 
may adjust the stereo projection parameters. Simply type in the appropriate value or use the up 
and down arrows to increase or reduce the values. 

If the upper Auto checkbox is activated, the focal distance will be set to the distance between 
observer and currently selected object. If no object is selected the focal distance will not be up-
dated automatically.  

 

Fig. 160 The Stereo properties 
dialog. 
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If the lower Auto checkbox is activated, a default relation of 30:1 between focal distance and eye 
distance will be applied. 

While a stereo mode is activated images will be saved as stereo images when the Save Image 
option in the File menu is selected. 

4.6.6 Polygon Properties 

Select a polygon object in the scene and use the Polygon properties tool to adjust the polygon 
rendering mode for the selected object.  

Choose between a shading mode or wireframe mode. If no polygon object is selected, the Poly-
gon properties tool will be disabled. 

4.6.7 Object Properties 

The Object properties tool provides four index cards for the different kinds of actions which 
may be applied to an object (i.e. translation, rotation, scaling, and clipping). 

Each index card allows you to reset the properties to their default values by simply pressing the 
Reset button. 

The entered values may be applied by pressing the Apply button. The appropriate action will 
also be applied when moving the mouse cursor away from the Object properties tool into the 
3D window. 

 

Fig. 161 The Polygon properties 
dialog. 
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Position/Translation 

When the Pos index card (i.e. the position/translation index card) is selected, the bounding box 
of the selected object will be displayed in green, the color of the Position/Translation mode.  

All positions in the Position index card refer to scene coordinates. On the position/translation 
index card, the current position of an object is displayed in scene coordinates. 

The position/translation dialog allows you to type in the exact position values in x, y and z coor-
dinates. You may also use the up and down arrows to increase or reduce the values.  

Press the Reset button to move the currently selected object back to the scene’s origin. 

Press the Apply button to accept the new values entered in the position dialog. 

Rotation 

When the Rotate index card is selected the bounding box of the selected object will be displayed 
in red, the color of the Rotate mode. 

The index card Rotate provides the VGStudio MAX user with two different interfaces to rotate 
the selected object in the scene, i.e. the Standard dialog and the Advanced dialog. Use the 
Standard/Advanced toggle button to switch between the two modes. 

The Standard dialog looks like the following image. 

 

Fig. 162 The Object properties 
dialog with the index card 
Position selected. 
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The Standard dialog provides you with an interface where you may enter incremental rotation 

values for each axis. Type in the incremental rotation around the x, y, or z axis or use the up and 
down arrows to increase or reduce the rotation values. 

The Advanced dialog looks like the following image. 

The Advanced dialog provides you with an interface where you may enter absolute rotation 
values for the selected object. The absolute rotation is defined by a normalized vector in the 3D 
space and a rotation angle around this vector. Non-normalized vectors may also be entered. They 
will be normalized when the values are applied. 

 

Fig. 163 The Standard dialog 
of the Rotate index card. 

 

Fig. 164 The Advanced dialog 
of the Rotate index card. 
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Type in the x, y, or z coordinates to define the vector around which you want to rotate the image 
or use the up and down arrows to increase or reduce the x, y, or z values. 

Type in the absolute rotation angle around the axis defined by the x, y, or z value or use the up 
and down arrows to increase or reduce the rotation angle. 

Press the Reset button to reset the orientation of the selected object to its original value. 

Press the Apply button to activate the new values entered in the rotation dialog. 

Scaling 

When the Scale index card is selected the bounding box of the selected object will be displayed 
in dark blue, the color of the Scale mode. 

When several objects are selected, the index card Scale will be disabled. If you wish to manipu-
late several objects together, you have to group the objects first. For more information on the 
grouping and ungrouping of objects, please refer to Chapter 4.3.3 Setting Preferences.  

The index card Scale provides you with an interface which allows you to type in the scaling fac-
tors for the selected object. You may also use the up and down arrows to increase or reduce the 
values. 

Use the checkbox on the right-hand side to lock the three values for isotropic scaling. The three 
values will then be changed simultaneously and cannot be changed independently of each other. 

Use the Reset button to set the scaling values to the default values of 1.0. 

 

Fig. 165 The Scale index cad 
of the Object properties dia-
log. 
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On the index card Scale you may also enter the initial voxel resolution of the selected voxel ob-
ject. The Resolution area will be disabled if an object group is selected.  

You may also apply the unit, e.g. �m, mm, cm, m, of the applied resolution values in the Reso-
lution area. Applying an measurement unit to an object leads to the automated process, if no 
object with a unit was loaded into the scene before, that this measurement unit will be also ap-
plied as measurement unit within the whole scene. You can see the current scene measurement 
unit displayed in the Status Bar, please refer to Chapter 4.7 Status Bar.   

Press the Reset button to reset the scaling of the selected object. The index card Scale Reset 
leaves the resolution settings untouched. 

Press the Apply button to activate the new scaling values entered in the rotation dialog. 

 

 

Reminder: You should not scale objects down to factors less than 0.1! Please take 
into account that scaling and resolution will end up in an effective object scaling. 
Very low object scaling values will result in reduced image quality. Higher over-
sampling values may enhance the image quality again. In scenes that include objects 
with different scaling values you should scale up all objects so that the smallest ob-
ject will have an effective scaling value of at least 1.0. 

Clipping 

When the Clip index card is selected the bounding box of the selected object will be displayed in 
cyan, the color of the Clip mode. 

The index card Clip provides the VGStudio MAX user with two different interfaces to clip the 
selected object in the scene, i.e. the Clipbox dialog and the Clipplane dialog. Use the Clip-
box/Clipplane toggle button to switch between the two modes. 

All parameters in the Clipbox or Clipplane dialogs are in object voxel coordinates. 

Clipbox — Select this command to box clip the selected object or object group along the axes of 
its bounding box. The Clipbox mode is characterized by the cyan bounding box with squared 
handles, i.e. active areas on each side of the selected object or group of objects (a small scissors 
will appear next to the cursor when you place it on one of the handles). The object may be 
clipped by typing in the position of each of the six clipplanes on the Clip index card. Use the two 
values for each coordinate axis to apply a clipplane to all sides of the selected object. Type in the 
values for the clipplane position or use the up and down arrows to increase or reduce the clip-
plane position values. Group the objects first if you want to clip several objects at a time. 
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Press the Reset button to remove the clipping of the selected object. Press the Apply button to 

activate the appropriate parameters. 

Clipplane — Select this command to clip the selected object or object group by an arbitrary 
clipplane. The Clipplane mode is characterized by the cyan bounding box with a normal vector 
on one side of the current object. The object may be clipped along an arbitrary clipplane by typ-
ing in the values for the arbitrary clipplanes in the Clipplane dialog of the Clip index card. The 
clipplane will be disabled if several objects are selected. Group the objects first if you want to 
clip several objects with one clipplane at a time. 

 

Fig. 166 The Clipbox index 
card of the Object properties 
dialog. 

 

Fig. 167 The Clipplane index 
card of the Object properties 
dialog.  
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The arbitrary clipplane is defined by the clipplane’s normal vector and the distance between 
the clipplane and the origin of the clipped object. The clipplane’s origin may be placed to any 
arbitrary position in order to be able to rotate the clipplane around the specified point. 

The clipping of an object group will be reset if the object group is ungrouped.  

When several objects are selected, the Clip index card will be disabled. If you wish to manipu-
late several objects together, you have to group the objects first. For more information on the 
grouping and ungrouping of objects, please refer to Chapter 4.3.3. 

Press the Reset button to remove any clipplane from the selected object. Press the Apply button 
to activate the new values. 

 
Fig. 168 The clipplane is defined by the clipplane’s normal 
vector and the distance between the clipplane and the ori-
gin of the clipped object. 
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Center 

When the Center index card is selected the center of an object or say the origin of the object 
coordinate system can be applied in voxel coordinates. By default the origin of an object is at 
(Xmax/2, Ymax/2, Zmax/2). If several objects are selected, the default center will be the center 
of the bounding box containing all objects. 

You can enter any value for the center, that seems appropriate for you. Press the Reset button to 
reset values to the default center. Press the Apply button to activate the new values. 

  

 

Reminder: Any rotation of an object will be around the center, so using a center 
which lies outside the object will rotate the object very differently from the default 
center. 

 

 

Fig. 169 The Center index 
card of the Object properties 
dialog. 
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Gantry 

Several imaging devices, especially CT-scanners allow to acquire a data set with a gantry-tilt. 
This procedure will result in an sheered image stack. 

Special visualization techniques are necessary for a proper visualization of such sheered image 
stack. VGStudio MAX 1.0 includes support for sheered data set. The user may apply any arbi-
trary gantry tilt when the Gantry index card is selected.   

VGStudio MAX 1.0 supports DICOM 3 image data including gantry tilt.  

 

Fig. 170 The Gantry index card of the Object properties dialog. 

 

Fig. 171 The Gantry index 
card of the Object properties 
dialog. 
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4.6.8 World View  

The World view tool is used to steer your view on the scene. The position, rotation, and the 
viewing angle may be manipulated. In the World view tool an overview of the current scene is 
displayed in form of the bounding boxes of each object or group of objects. 

You activate the World view tool by pressing the World view mode button in the icon bar or by 
clicking World view mode in the Scene Menu. All changes can be observed in the 3D view 

window. Changes in the World view tool will not affect the scene itself. 

Click the Move button to activate the World view tool’s Move mode.  

The Move mode is characterized by the green color of the scene coordinate system axes in the 
World view tool. The scene may be moved in the image plane by clicking into the Scene viewer 
area with the left mouse button and dragging the mouse while the left mouse button is pressed. 
The scene may be moved forwards or backwards by clicking into the Scene viewer area and 
dragging the mouse while the middle mouse button (or the Alt key and the left mouse button) is 
pressed. 

Using the Shift modifier in Move mode allows you to move the scene in vertical or horizontal 
direction. 

Click the Rotation button to activate the World view tool’s Rotate mode.  

 

Fig. 172 The World view tool 
of VGStudio MAX. 
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The Rotate mode is characterized by the red color of the scene coordinate system axes in the 
World view tool. The scene may be rotated around the x-, or y-axes of the image plane in the 
Scene viewer window by clicking into the Scene viewer area with the left mouse button and 
dragging the mouse while the left mouse button is pressed. The scene may be rotated around the 
viewing direction by clicking into the Scene viewer area and moving the mouse while the middle 
mouse button (or the Alt key and the left mouse button) is pressed. 

Using the Shift modifier in Rotate mode allows you to rotate the scene around the vertical or 
horizontal axes of the image plane. 

Click one of the six Default view buttons to view the scene either from the front, back, left, 
right, top, or bottom.  

The distance between the observer and the scene’s center, which can be adjusted in Move mode, 
will remain unchanged when one of the Default view buttons is pressed. 

Drag the Viewing angle slider to the left or right or type in the desired value to adjust the view-
ing angle. 

By clicking into the Scene viewer window with the right mouse button you open the following 
context menu.  

When clicking Zoom the following menu will be opened. 

The Scene viewer window may be zoomed in or out. Click Reset to reset the zoom factor to its 
default value. 

In the context menu, click Move or Rotate to access the Move or Rotate mode. 

Select Reset to reset the World view settings to its default values. 

For more detailed information on the World view mode, please refer to Chapter 4.5.3 World and 
Camera View. 

 

 

Fig. 173 The context menu 
of the Scene viewer area.
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4.6.9 Camera View 

While the Camera mode is activated you may use the Camera View tool to adjust camera-
relevant settings. The Camera View tool is activated by pressing the Camera mode button in 
the icon bar or by clicking Camera mode in the Scene Menu. 

 

You may either type in the exact values for the Camera position and for the Look-at point or 
use the up and down arrows to increase or reduce the x, y, and z position values. 

Use the Up vector section to type in the exact value for the up vector relative to scene coordi-
nates. 

 

Reminder: The camera and look-at position are defined in scene coordinates while 
most other tools work in object coordinates! The color coding in the slice tools may 
not fit to the color coding of the camera tool in case of an rotated object. 

Click one of the six Default view buttons to view the scene either from the front, back, left, 
right, top, or bottom. 

 

Fig. 174 The Camera view tool 
of VGStudio MAX. 
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The distance between the observer and the scene’s center, which can be adjusted in Move mode, 
will remain unchanged when one of the Default view buttons is pressed. 

Drag the Viewing angle slider to the left or right or type in the desired value to adjust the view-
ing angle. 

For more detailed information on the Camera view mode, please refer to Chapter 4.5.3 World 
and Camera View. 

 

 

Fig. 175 The Camera view mode allows you to view your data from 
inside. You may adjust all camera parameters shown here accord-
ing to your needs. 
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4.6.10 Segmentation 

VGStudio MAX 1.0 includes a powerful set of segmentation functions. The process of segmen-
tation can be informally described as the task of partitioning an volumetric data set into separate 
regions, e.g. representing different materials or tissue. In contrast to gray value classification, 
which can be performed within the classification tool, the segmentation tool provides capabilities 
to separate structures which can not be separated by a simple gray value classification but only 
on a morphological level. Examples can be seen in Fig. 176. 

            

   

 

Fig. 176 Tomography of an engine and an MRI scan of a human 
head (2D and  3D). Original data and segmented data. 
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VGStudio MAX’ segmentation capabilities are accessed by the segmentation tool. The segmen-
tation tool includes 

- the icon bar including 3D and 2D segmentation modes 

- the magic wand options  

- the 2D propagation mode section 

- the morphological operations section 

- and the button section 

 

The different functions and elements are explained in the following chapter. We will first explain 
some vocabulary used and the principle concepts of VGStudio MAX’ segmentation modes on 
the basis of an example.  

Working selection and sections 

Drawing an outline within the data will create a green colored working selection. A working 
selection may consist of  an single area within one 2D slice image,  it may be an area in 3D or 
even several 2D or 3D areas throughout the whole data set. 

The result of a segmentation process within VGStudio MAX is called a section (see also Chap-
ter 3.2.3 Data Sets, Sections and Segments).  A working selection will become a section when 
the accept button is pressed within the segmentation tool. A section will be outlined in red color 
when the section is selected while a segmentation mode is activated. 

 

Fig. 177 The Segmentation 
tool of VGStudio MAX. 
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Segmentation example 

We use the lasso tool  within our example, however all the described features are also appli-
cable with all other segmentation modes. We use the lasso tool to outline the brain tissue within 
the axial slice image of an MRI scan of a human head (see Fig. 178).  

The current so called working selection shows up in green color. If the selection process was not 
optimal the user may just start to draw a new selection. The existing selection will be destroyed 
when drawing a new one. A working selection may also be modified by adding or subtracting 
parts. This is possible by using the Shift or Control modifiers. In our example shown in Fig. 178 
we can see that the outline of the brain tissue was not optimal at the right side. Not all the brain 
tissue was selected. We can add parts to the current working selection by keeping the Shift key 
pressed while outlining an additional area within the data set. A little “+”  symbol will show up 
as long as the Shift key remains pressed (see Fig. 179). 

 

Fig. 178 A green line surrounds the selection. 

 

Fig. 179 Adding areas to the current selection. 
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In our example we surround the missing parts of the brain tissue with the lasso tool while the 
Shift key is pressed. The resulting working selection is the sum of the initial selection and the 
added selection.   

The final selection can be seen in Fig. 180. In the same way we used the Shift modifier to add 
parts to the selection we can use the Ctrl modifier to subtract areas from the working selection. 

As an example we activate the marquee tool  to remove a rectangle area from the working 
selection. 

We bring up a rectangle area within the working selection while the Ctrl key is pressed. A little 
“-“ symbol appears to show up that we subtract this area from the current working selection. The 
result of this process can be seen in Fig. 182.   

 

Fig. 180 Final selection. 

 

Fig. 181 Subtract a rectangle area from the selection. 
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This example shows that a working selection can be optimized by adding (Shift) or subtracting 
(Ctrl) areas by any of the segmentation modes. The different segmentation modes may be used in 
any combination to create a selection. The user may even create a working selection by the 3D 
Magic Wand and optimize the result slice by slice with the different 2D segmentation modes.  

Our working selection will become a “true” section when the Accept button in the segmentation 
tool is pressed. The green outline of the working selection will become a red outline of the cur-
rent section (see Fig. 183).  

A section may also be modified. The user may simply draw a new working selection to add or 
subtract it from the red outlined section. In our example shown in Fig. 184 the working section 
was added to the section by pressing the Add button within the segmentation tool. 

 

Fig. 182 The final selection. 

 

Fig. 183 The resulting section. 
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In the presented example the resulting section includes data from a single slice image only since 
we created a selection within this single slice image using 2D segmentation modes. However the 
user may create section in the whole 3D data set by using 2D segmentation modes stepping 
through the data slice by slice or he may use the 3D Magic Wand to generate a 3D selection at 
once. 

One important fact of VGStudio MAX’ segmentation tools is that you have to decide in which 
slice window you want to work while creating a working selection. If you change the slice win-
dow, while segmenting data in another slice window, you will loose the working selection within 
all slices. 

 

 

Reminder: You must not change the slice window, while segmenting data in an-
other slice window. Changing the slice window will result in loosing the working 
selection within all slices. 

You may change between the slice windows after accepting a working selection so that it be-
comes a section. A section will not be lost when changing the slice window and it may be modi-
fied in any of the three slice windows. 

 

Fig. 184 Drawing a working selection within an existing section and adding it to the section. 
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The segmentation tool icon bar 

The icon bar allows activate/deactivate on of five segmentation modes. A segmentation mode 
remains active as long as the appropriate icon is pressed. Using several features of VGStudio 
MAX, e.g. activating measurement tool, will automatically deactivate the segmentation mode. 
The segmentation modes are: the 3D magic wand, 2D magic wand, marquee tool, ellipse tool, 
lasso tool and the polygon lasso tool. 

 

Unlike the other segmentation modes, the 3D  and 2D  Magic Wand tool works by se-
lecting content rather than defining edges. The Magic wand tools use a so called region growing 
algorithm to create a selection. Region growing is an image processing technique that segments 
all voxels that are connected to a seed point and that are within a user defined tolerance of voxel 
values. The larger the tolerance value the more areas will be included into the selection. The tol-
erance as well as other parameters of the Magic Wand modes can be adjusted in the Magic Wand 
options section of the classification tool. There are two different modes available for the Magic 
Wand tools: the Dynamic and the Static mode. Using static region growing, adds all adjoining 
points of the current voxel to the selection, which are within the tolerance from the gray value of 
the voxel at the seed point position. Using Dynamic region growing adds all adjoining points of 
the current voxel to the selection, with voxel values that are within the tolerance in respect to the 
mean gray value of all voxels that are already in the selection. The dynamic mode is used as de-
fault since it is less susceptible to noise within the data. Another convenience mode is the auto 
update mode. Changing the tolerance value requires in addition that the seed point has to be set 
to start the region growing process. Changing the tolerance value will automatically start the 
region growing process with the seed point of the previous selection if the auto update checkbox  
is activated.   

 

Fig. 185 The Segmentation 
tool of VGStudio MAX. 
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Creating a 3D Magic Wand Selection 

To make a Magic Wand selection: 

1 Activate the 3D Magic Wand mode 

2 Apply a tolerance value  

3 Move the cursor over one of the three slice windows.  

4 Click the area you want to select. 

5 Release the mouse button. A marquee surrounds the selection. 

6 The selection can be optimized by choosing another tolerance value and restart with 
Step 3. 

Creating a 2D Magic Wand Selection 

To make a Magic Wand selection: 

1 Activate the 2D Magic Wand mode 

2 Apply a tolerance value  

3 Move the cursor over one of the three slice windows.  

4 Click the area you want to select. 

5 Release the mouse button. A marquee surrounds the selection. 

6 The selection can be optimized by choosing another tolerance value and restart with 
Step 3. 
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The marquee tool  let you select rectangular or square areas and the ellipse tool  let you 

select elliptic or circular areas. The lasso  and polygon lasso  tools let you draw both 
straight-edged and freehand segments of a selection border. 

Creating a Marquee or a Ellipse Selection 

To make a selection: 

1 Click the marquee button  on the Tool palette for rectangular outlines and the  
button for an elliptic outline. To create square or circular outline, click with the mid-
dle mouse button instead of the left one (if your mouse got no middle mouse button, 
click with the left mouse button and hold the Alt button simultaneously). 

2 Place the mouse on the image at one of two places: 

a. To create a rectangular selection, place the cursor at a corner of the area you want 
to select..  

b. To create a circular or elliptical selection, place the cursor at the edge of the area 
you want to select. 

3 Click and drag the mouse until the selection is the size you want. As the mouse 
moves, a line appears to indicate the border of the selection. 

4 Release the mouse button. The selection border becomes a marquee. 

Making a Lasso Selection 

To make a lasso selection: 

1 Click the lasso button  on the Segmentation Tool icon bar. 

2 On the Tool Options palette, choose lasso as the Selection Type and set the options. 

3 Move the cursor over the image.  

4 Click the image at a point that you want to become the border of the selection. 

5 Drag the cursor to create an outline of the area you want to select. IMPORTANT: Do 
not release the mouse while creating your selection.  

6 When the line encloses the selection, release the mouse. The line becomes a marquee 
indicating the border of the selection. 
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Making a Polygon Lasso Selection 

To make a polygon lasso selection: 

1 Click the polygon lasso button  on the Segmentation Tool icon bar. 

2 Click the cursor on the point in the image where you want to begin the line. As the 
mouse moves, a straight line connects it to the starting point. 

3 Click the image wherever you want to anchor the line and change its direction. 

4 Click the middle mouse key to finish the polygon lasso selection. 

The 2D selection propagate mode  

VGStudio MAX’ 2D segmentation tools can be used for the convenient segmentation of a 3D 
data set in conjunction with the 2D propagate mode. A 2D selection generated in a slice image 
can easily be propagated to any slice image by choosing another slice within the slice selection 
box in the lower left corner of the slice windows when the 2D selection propagate mode was 
activated within the segmentation tool. 

The user may step through the volumetric data set slice by slice and segment the whole data set 
by propagating the 2D selections through the data set. The user may optimize the working selec-
tion while stepping from slice to slice. If there is already a working selection within a slice the 
propagate mode will not overwrite the existing selection. Therefore the best way to use the 
propagate mode is to step through the data set in one direction.  

The propagate mode used in combination with the 2D Magic Wand will propagate the seed point 
not the selection itself. Starting from the same seed point coordinates with the same tolerance 

 

Fig. 186 A selection gerenated in slice no 59 (left) can be propagated to slice no 58(right). 
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value the 2D region growing will start within the next slice selected.  There is an additional op-
tions when using the propagate mode in combination with the  2D Magic Wand mode. The Cen-
ter Of Mass (COM) mode will calculate the new seed point coordinates as the “center of mass” 
of the current slice’s working selection before propagating the seed point to the next slice. The 
default setting for propagating the 2D Magic Wand is  the standard mode.  

Modify selection  /  Morphological operators  

VGStudio MAX includes the morphological operators Contact (Erosion) and Expand (Dila-
tion). Pressing the Contract button within the segmentation tool will contract the current working 
selection about one voxel in each direction. Pressing the Expand button within the segmentation 
tool will expand the current working selection about one voxel in each direction. Depending on 
which type of segmentation mode (2D or 3D) is selected the contract or expand function will be 
applied to the 2D working selection within the current slice only or to the whole selection in the 
3D data set. The corresponding text can also be seen on the text written on the corresponding 
button, e.g. Contract or Contract (3D).     

 

Fig. 187 Original selection (middle), contracted selection (left) and expanded selection (right). 
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The slice window context menu in segmentation mode  

Many of VGStudio MAX’ segmentation capabilities can be accessed through the context menu 
of the slice windows. 

The slice window context menu includes the following features when a segmentation mode is 
activated: 

�� Clear selection – This option will clear the current working selection within the current slice 
only or within all slices.   

�� Reset selection – This option will use the current section outline (red coloured outline) as 
working selection within the current slice only or within all slices.   

�� Invert selection – These option will invert the current working selection within the current 
slice only or within all slices.  

�� Expand selection – These option will expand the current working selection within the cur-
rent slice only or within all slices.  

�� Contract selection – These option contract will invert the current working selection within 
the current slice only or within all slices.  

 

 

 

Fig. 188  Slice window context menu in segmentation mode. 
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Creating several sections 

Each time the Accept button is pressed within the segmentation tool a new section will be cre-
ated. A new section will appear within the scene tree tool when you expand the current data set 
with the “+” sign. 

Each volumetric data set includes a base section called section [0]. The first section generated by 
the segmentation tool will become section [1] within the scene tree. You may rename the sec-
tions within the scene tree by double click the section entry. The red colored section entry within 
the scene tree shows the current section under access. 

To generate a new section, e.g. section [2] the user has to select the base section - section [0] – 
first. As long as any other section than the base section is selected the user may modify the cur-
rent section.   

       

Fig. 189  Sceene tree entry of an unsegmented (left) and 
a segmented (right) data set.. 

   

Fig. 190  Segmentation tool when section [0] is selected (left) 
and when any other section than section [0] is selected (right). 
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Depending on which section is selected the segmentation tool will include an Accept or a Re-
place button. The Accept button shows the user that he will create a new section from current his 
working selection. The Replace button shows the user that he may replace the current selected 
section (other than section [0]) by his current working selection as well as he is able further mod-
ify the current section by adding or subtracting the current working selection. 

Increasing the data size while segmenting data 

If the current data value range within your volumetric data set is to large to allow the storage of a 
new sections tag information within the data set a warning dialog will appear (see Fig. 191 ). If 
you choose Yes the data set will be expanded to the next larger data type, clicking No will make 
no new segment.  

 

 

Reminder: You will double the memory requirement of your volumetric data set 
when you expand the data set size. 

 

 
Fig. 191  If you create a new section, VGStudio MAX 1.0 might warn 
you, if the data range allows no further section. 
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4.6.11 Filter 

VGStudio MAX includes a set of different 3D filter algorithms like Gaussian, Median, Gradient 
and Non Linear Diffusion filters. The different filters can be selected within the Filter type selec-
tion of the Filter tool.  

 

Reminder: You can not apply Gauss, Gradient or Non linear diffusion filters to 32-
bit color data. The Filter tool remains disabled as long as no voxel data set or a 
polygonal data set is selected. 

Reminder: The memory requirements of several filter operations may become 
very large! In some cases you will need up to five times of the memory of the 
original data set. 

 

To apply a filter to an object, select the desired object, select the filter type, adjust the filters pa-
rameter and press Start.  

Use the Filter tools Preview capabilities to see the effect of the selected filter and settings to the 
data by activating the filter preview checkbox.. 

 

Fig. 192 The Filter tool of 
VGStudio MAX. 
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Reminder: The preview may differ slightly form the final result. The reason for the 
slight differences result from the fact that the preview is calculated on the 2D pre-
view image only while the final filter is calculated in 3D. 

The Preview window includes two scrollbars to pan large images as well as two zoom buttons, a 
slice orientation button and one slice selection box. The orientation button in the lower right 
corner shows the axis orthogonal to the displayed slice colored in the VGStudio MAX color 
scheme. 

A xy-slice is displayed if a blue z is displayed as shown in the example above. Use the slice se-
lection box in the lower left corner of the slice windows to scroll through the image stack by 
clicking the up and down arrows or to select a specific slice by typing in the slice number and 
then clicking into another window. The selected slice will then be displayed. 

Use the zoom in and zoom out buttons in the lower right corner of the preview windows to 
zoom in on an image (i.e. enlarge the image) or to zoom out (i.e. reduce the image). The images 
will then be enlarged or reduced by a preset zoom factor. 

When clicking into the preview window with the right mouse button, a context menu will be 
opened. The context menu includes the Zoom option. The preview window may be zoomed in 
(enlarged) or zoomed out (reduced). The Fit to window option allows to zoom the image so that 
it is displayed with maximum zoom factor. The Actual Pixels option applies a zoom factor so 
that one pixel in the image of the slice window will be one pixel on your screen. These functions 
may also be applied by using the zoom buttons in the lower right corner of the preview windows. 
The images will then be enlarged or reduced by a preset zoom factor. 

The Use Classification option allows you to decide if filter operation should be performed on 
the original data set or on the data set after the classification tools opacity lookup table is ap-
plied. You may use the filter preview to see the effect of this option.  
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The Gaussian Filter 

The Gaussian Filter allows to blur the selected data set. Choose a Filter Mask Size from 3x3x3 
up to 9x9x9.  

 

 
Fig. 193 VGStudio MAX filter preview. Original data left. Gaussian filtered data right. 
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The Median Filter 

Reduces noise in an image by blending the brightness of pixels within a data set. The filter 
searches the applied mask size of a data set for pixels of similar brightness, discarding pixels that 
differ too much from adjacent pixels, and replaces the center pixel with the median brightness 
value of the searched pixels. This filter is useful for eliminating or reducing the effect of motion 
on an image. Choose a Filter Mask Size from 3x3x3 up to 9x9x9.  

 

 
Fig. 194 VGStudio MAX filter preview. Original data left. Median filtered data right. 
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The Gradient Filter 

The Gradient filter accentuate the areas of contrast and edges in the data. It identifies the areas of 
the data with significant transitions and emphasizes the edges. Choose a Filter Mask Size from 
3x3x3 up to 9x9x9. The local gradient will be calculated more precise when using larger filter 
masks. 

 

 
Fig. 195 VGStudio MAX filter preview. Original data left. Gradient filtered data right. 
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The Non Linear Diffusion Filter 

The Non Linear Diffusion Filter is a useful tool to remove noise within the selected data set 
while preserving the edges. 

 
Fig. 196 VGStudio MAX filter preview. Original data left. Non Linear Diffusion filtered data 
right.
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4.6.12 Registration 

Image coregistration is crucial to a variety of advanced image analyses. Although most 3D imag-
ing modalities are inherently in registration slice-to-slice, volume-to-volume coregistration is 
needed e.g. to combine partly overlapping sub volumes of an object scanned in two passes or to 
combine single volumes from multiple modalities. VGStudio MAX' 3-D Registration module 
provides a algorithm which allows the user to coregister two sets of user defined points. The user 
may place an arbitrary number of points to be registered within each data set. The registration 
algorithm functions by minimizing an error function, i.e. the distances between two correspond-
ing points of the two point sets. 

 
Fig. 197 The Registration tool of VGStudio MAX. 
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: 

“Registration” is the calculation of an optimal transformation between the “reference” object and 
the “registered” object. Conceptually, the registered object will be moved relative to the refer-
ence object. To register two data set load the first data set by using the Open command or 
VGStudio MAX' import features. Load the second data set by using the Merge command or 
VGStudio MAX' import features. Activate the Registration tool in the Tools menu if it is not 

already activated. Drag the registration tool out of the toolbox and resize it for optimal working 
conditions. The registration tool consists of two columns with an object-selection-pull-down and 
three orthogonal slice images each. The slice images include the same features like VGStudio 
MAX' slice images, e.g. zooming, slice no. selection scrollbars and a context menu which can be 
activated by a right mouse click (Please refer to Chapter 4.5.1 Slice Windows and Multiplanar 
Reformatting).  

Now select the reference object from the pull down selection on top of the left image column. 
Practically, the reference object should be the object of greater resolution and extent. Select the 
object to be registered from the pull down selection on top of the right image column. Now the 
user can start placing corresponding landmarks in the two data sets. Select a position within the 
reference object and left click on it. The marker No. 1 will be placed at this position. Now place 
the marker No. 1 in the registered object. Optimize the positions of the two corresponding mark-
ers within the three orthogonal slices of each data set. 

 
Fig. 198 Registration tool dragged out of the toolbox.  
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 The placement of the markers can also be verified in the 3D window. 

Select the second marker by right click into on of the Registration tools image windows. Select 
the Select Marker option out of the context menu and select Marker 2 from the sub menu. The 
active marker appears checked in the menu. Only the position of the active marker can be modi-
fied by the user. Now after the second marker is selected place the second marker to the corre-
sponding landmarks in both data set. Redo this procedure for as many markers as you like. As a 

 
Fig. 199 CT-scan (left), MR-scan (right) with registration marker no. 1 placed on the 
corresponding landmark.  

 
Fig. 200 CT-scan (left), MR-scan (right) with registration marker in 3D window.  
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minimum 4 markers have to be positioned into the two data sets to perform a registration. The 
resulting registration will be the better the more linear independent the three vectors formed by 
the markers are. Use the Add Marker option in the registration tools context menu to add an 
additional pair of markers. A pair of markers may be removed by selecting the pair to be re-
moved as active marker and then using the Remove Marker option in the registration tools con-
text menu. Once all markers have been placed the user may check the relative error of each pair 
of markers by pressing the Check button.   

The Registration error window will appear with a list of each marker pairs error. The user may 
now optimize the position of individual markers to reduce the error. To update the Registration 
error windows content press the Check button again. Once an acceptable setting has been 
achieved, the object to be registered may then be “transformed” by pressing the Apply button. 

The objects will now appear registered in the 3D window. The objects may now e.g. be grouped 
by selecting both objects and using VGStudio MAX' Group feature. The objects may then be 
clipped like it can be seen in Fig. 202. 

 

 
Fig. 201 The registration error 

window.  

 
Fig. 202 CT-scan (left), MR-scan (middle) and result of registration and segmentation.  
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4.6.13 Polygonal Surface Extraction 

VGStudio Max includes a powerful, easy to use tool to generate polygonal surface models from 
volumentric data sets. The polygonal models may be exported as STL file which can be used in 
many further processing steps and applications, e.g. in the construction of physical replicas 
through the use of rapid prototyping machinery or nominal/actual value comparison of the model 
with a CAD construction drawing. 

The Polygonal Surface Extraction tool provides two different interfaces: the iso-gray-value sur-
face extraction and the iso-opacity-value surface extraction interface.       

 

Fig. 203 Volumetric data set of a cylinder-head and an extracted polygonal model (STL file). 



4. VGStudio MAX Interface & Tools 

VGStudio MAX 1.0 User’s Manual 200 

Iso-gray-value-surface extraction 

The first interface is used to extract polygonal models of an iso-gray-value-surface The iso 
gray-value which defines the surface within a volumetric data set can be applied by the user or 
the Auto detect option can be used for a WYSIWYG style (What You See Is What You Get) 
determination of the iso-surface extraction gray value (see Fig. 205).  

The Auto detect feature will compute a gray value for the surface extraction depending on the 
opacity lookup table setting applied in the Classification tool. The Auto detect gray value is 
computed as shown in Fig. 206. 

 

Fig. 204 The Iso-gray-value-
surface extraction interface. 
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Fig. 205 Opacity lookup table setting and the resulting volumetric data of which the 
polygonal model is computed.   

 

Fig. 206 Gray value Auto detect.
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The gray value is taken at the position where the 0.4 opacity intersects the opacity function ap-
plied in the classification tool. The gray value determined by the Auto detect feature may be used 
as an initial extraction gray value which could be optimized manually. The quality and accuracy 
of the generated polygonal model depends strong on the extraction gray value. 

Iso-opacity-value-surface extraction 

The second interface is used to extract polygonal models of surfaces defined by an iso-opacity-
value. The main difference between the iso-gray-value and the iso-opacity surface extraction 
functions is that the iso-opacity value takes the classification lookup table into account which 
maps each gray value to a defined opacity value before extracting an iso-opacity-surface. The 
gray value to opacity mapping is done within VGStudio MAX’ Classification tool (see Chapter 
4.6.1 Classification Tool).  

 

 

While the extraction of an iso-gray-value surface is limited to extract a single surface defined by 
a single gray-value at a time the iso-opacity-value extraction process allows to extract a polygo-
nal shell defined by several gray-values. An example is shown in Fig. 208. The user has applied 
a peaked opacity function in the classification tool and an extraction opacity value of 1.2. 

 

 

Fig. 207 The Polygonal Sur-
face Extraction tool of VGStu-
dio MAX, advanced mode. 
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Within this example the resulting extracted shell will consist of two iso-gray-value surfaces ex-
tracted at the gray-values 120 and 160. Depending on the applied opacity function the iso-
opacity-value extraction allows to extract shells with and arbitrary number of iso-gray-value sur-
faces. 

The Display and Export sections 

Each of the two interfaces, the iso-grayvalue and the iso-opacity interface, allow to extract the 
polygonal model for display within the current VGStudio MAX scene and for export as an STL 
or OFF file. Activate the appropriate checkbox within the tools Display or Export section to ex-
tract the polygonal model for display and/or export.   

Use the skip voxels parameter to adjust the number of voxels taken into account during the po-
lygonal surface extraction process, A Skip voxels factor of 1 will skip every second voxel in x-, 
y- and z-direction so that the total number of voxels taken into account will be only 1/8 of the 
origional data set. The full data set will be taken into account if this factor is set to 0, this will 
also lead to maximum accuracy of the extracted model. The number of polygons generated by 
the polygonal extraction process will become less by using larger Skip voxels factors. However 
the accuracy will decrease at the same time. The Skip voxels parameter may be adjusted for dis-
play and export purposes separately. 

A polygonal model extracted from an object which is bordered by the bounding box of the 
volumetric data set can be extracted in two ways. The model can be extracted in a way that the 
model will be closed at the borders of the data set or the model can be left open since the surface 
at the border can be seen as an artificial surface.  

 

Fig. 208 Iso-opacity-extraction
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 Activate the close bounds checkbox to close the polygonal model at the data set boundaries. 

To finally extract a polygonal model press the Extract button. A popup will appear which will 
appear which includes information about the number of triangles extracted and the surface area 
of the extracted shell. This feature can be used to measure the surface area of any object. Press  
Ok to export the polygonal model or press Cancel to abort the process. If Ok was pressed a file 
dialog will popup where you have to key in a file name where you can select a file type.  

 

Fig. 209 Extract polygonal model with closed bounds deactivated(left) activated 
(right)   

 

Fig. 210 Extract polygonal model with closed bounds deactivated(left) activated (right)  

 

Fig. 211 Polygonal model extract popup. 
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Accuracy of the polygonal surface extraction       

VGStudio MAX’s extraction tool computes an iso-gray-value-surface out of the volumetric data 
set. The achieved accuracy mainly depends on the spatial resolution of the volumetric data set 
under investigation, e.g. you will achieve a resolution in the order of 0.2 mm within a data set 
with a spatial voxel resolution of 0.2 mm.  

 

The vertex positions will be calculated by a tri-linear interpolation of the surrounding voxels 
gray values. By this the vertices of the resulting polygonal model are computed at sub-voxel 
accuracy. Please refer to Fig. 212 which shows an simplified 2D example of the extraction of an 
iso-surface at gray value 108. However even if the vertex position is calculated on sub-voxel 
accuracy the magnitude of the achieved accuracy will mainly depend on the spatial resolution of 
the volumetric data set. 

 

Fig. 212 Iso-gray-value-surface extraction example in 2D. Vertices will be tri-linear 
interpolated in 3D-space.   
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4.6.14 Keyframer 

VGStudio MAX 1.0 includes a powerful tool - the Keyframer - to render fascinating animations, 
e.g. flying around or even through your data. The concept of the Keyframer is to define an arbi-
trary path for the camera "flying" through the scene. The path - the camera trajectory - is defined 
by an arbitrary number of points of support - the Keyframes - within the scene. The path in be-
tween these points is defined by curves, so called bezier splines, which may be adjusted by the 
user. After the setup of the camera trajectory the Keyframer will render a user defined number of 
images while the camera moves down the camera trajectory. The render quality and the rendered 
image size can be adjusted in the Renderer properties tool (Chapter 4.6.3 Renderer Properties) 
and the Light properties tool (Chapter 4.6.4 Light Properties).    

The Keyframer is activated/deactivated by the Keyframer Icon in the VGStudio MAX Icon Bar.  

 

The camera symbol with view frustum and a circle shaped camera trajectory will appear within 
the slice windows after activating the Keyframer for the first time within a scene. The circle is 
placed within the xy-slice. The Camera and Camera tool is deeply connected to the Keyframer. 

 

Fig. 213 A scene with activated Keyframer rendered in World View mode. The ex-
ample shows a spiral shaped camera trajectory around a CT scan of a human head. 
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For details about the handling of the camera and its symbol within a slice window please refer to 
Chapter 4.5.3 World and Camera View. 

The camera trajectory consists of several Keyframe handles. The position of a Keyframe handle 
can be adjusted by the user. By doing this the user may adapt the whole camera trajectory. Grab 
a Keyframe handles by clicking it with the left mouse key and dragging it around while the left 
mouse button is pressed.  The handle may be moved anywhere within 3D space even outside the 
data set by using all three orthogonal slice windows. Zoom the Slice Windows so that you can 
place the Keyframe handle to the desired position. 

 

Fig. 214 Slice windows with activated Keyframer and default xy-circle camera trajectory. 

 

Fig. 215 Elements of a camera trajectory displayed in the slice windows. 
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Setting up a camera trajectory 

As default trajectory a circle within the xy-slice will appear when the keyframer is activated for 
the first time (see Fig. 214). This trajectory allows a simple flight around the object so that is 
rotates in front of the “users eye”. 

VGStudio MAX’ provides a set of predefined trajectories. The user may access these trajectories 
by right click the Camera trajectory section within the Keyframer tool . A context menu will 
pop up as shown in Fig. 216.  

�� Load trajectory – This option allows the user to load a camera trajectory from a trajectory 
file (trj file extension).   

�� Save trajectory – This option allows the user to save the current camera trajectory to a sepa-
rate file (trj file extension).  

�� Default xy-/yz-/xz-circle – These options allow to apply a circle shaped camera trajectory 
within the xy-, yz- or xz slice orientation . 

�� Default xy-/yz-/xz -spiral – These options allow to apply a spiral shaped camera trajectory 
within the xy-, yz- or xz slice orientation.   

The default camera trajectories may be used to render standard animation sequences very easily. 
However the default trajectories can be used as a starting point to setup user defined trajectories. 
VGStudio MAX provides a set of features to generate most complex trajectories and therefore 
high quality animation sequences. The user may: 

- modify the position of each keyframe handle and therefore the position of the camera 

- modify the tangent and curve stiffness at each keyframe handle 

 

Fig. 216 The Keyframer tool with thedefault  
trajectory selection. 
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- add/remove keyframe handle 

- modify the look at point at each keyframe handle (in free mode only) 

- modify the viewing angle and up vector of the camera at each keyframe handle. 

All camera parameters will be interpolated in between two keyframe handles so that a smooth 
movement of the camera or zooming effects are possible. 

To modify a camera trajectory simply grab a keyframe handle and place it to the desired position 
within the slice image windows. Use the orthogonal slice images to position the keyframe han-
dles in 3D. 

The camera will jump at the position of the keyframe handle grabbed by the user. The 3D image 
will be rendered according the actual camera position when VGStudio MAX is set to camera 
mode (please refer to Chapter 4.5.3 World and Camera View) each time the user modifies any 
relevant parameters. The user may switch between Camera and World View while adjusting the 
camera trajectory to get an optimal overview.  The red colored tangent and stiffness handle of the 
camera trajectory will be shown at the current selected keyframe handle. Grab one of the two 
squared red handles with a left click and move the handle while the left mouse button is pressed. 
The resulting camera trajectory can be seen immediately in the three Slice Windows.  

 

Fig. 217 Move a Keyframer handle. 

   

Fig. 218 Modifying the camera trajectory byits tangent and stiffness handles. 
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The camera trajectory may be modified by the stiffness handles also in 3D space by using the 
handles in the three Slice windows. Each of the two stiffness handles on each side of the Key-
frame handle may be adjusted independent from the opposite one. The user may modify the 
stiffness of the camera trajectory symmetrically by keeping the Shift key pressed while moving 
one stiffness handle.  

The user may add or remove additional keyframe handles by using the middle mouse button. A 
new keyframe handle will be placed in between two existing handles when the middle mouse 
button is pressed with the mouse cursor above the trajectory. A new keyframe handle will be 
added at the position clicked and connected to the next end (beginning or end) of the keyframer 
trajectory if the middle mouse button is pressed anywhere in the slice windows. Remove a key-
framer handle by middle click on the keyframe handle.  

For some reasons it might be important not to move a keyframe handle while grabbing it by a 
left mouse klick, e.g. not to modify a camera trajectory since it is used to render the same se-
quence in several passes with different settings. Use the Shift key to avoid moving the Keyframe 
handle when grabbing it. The Keyframe handles position can not be modified by left clicking it 
as long as the Shift key is pressed. 

The Keyframer tool 

The Keyframer tool includes the Camera look at mode section, the Camera trajectory section, 
the Film parameter section and the Create animation section. The tool may be acti-
vated/deactivated with the Keyframer option in the Tools menu. The Keyframer tools sections 
will be disabled as long as the Keyframer hasn't been activated with the Keyframer icon in the 
Icon Bar. 

The  VGStudio MAX Keyframer includes three Camera look at modes:  

 

Fig. 219 The Keyframer tool of 
VGStudio MAX. 
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Fixpoint Mode —Select this mode if the camera should look at the same position while moving 
along the whole camera trajectory, e.g. while flying around an object. Adjust the look at point 
within the slice windows or the camera tool for one keyframe. The look at point will then be ad-
justed for all keyframes.  

Ahead Mode —Select this mode if the camera should look ahead tangential to the camera trajec-
tory while moving along the trajectory, e.g. while flying through an object. It is not possible to 
adjust the look at point manually in the slice windows or within the camera tool when using the 
keyframer in Ahead mode.   

Free Mode —Select this mode if you want to define the viewing direction in each keyframe. 
The viewing direction will be interpolated between two keyframes. Use the camera symbol in the 
slice window or the camera tool to adjust the camera look at point in each keyframe. 

The Camera trajectory section displays the filename of the camera trajectory in case that the 
trajectory is saved to a separate file. Use the Save/Load camera trajectory option in the File menu 
to save the current camera trajectory or to load an existing camera trajectory. You may also load 
a camera trajectory from an existing vgi file by choosing the vgi file type in the Load camera 
trajectory file dialog. Press the right mouse button within the Camera trajectory section to bring 
up the context menu. The context menu include the Load/Save Camera trajectory option as well 
as 6 default trajectories. There are 3 circular trajectories, for each plane one and 3 spiral trajecto-
ries, which lie perpendicular to the main planes, too. Each default trajectory will be adjusted to 
the current scene in that way, that nearly the whole scene will be visible from any point of the 
trajectory. In each of the trajectories, the cameras will look at the center of the scene. 

The Film parameters section is used to define how many frames should be rendered on the cam-
eras path. The applied number of frames will be spread equidistant over the total camera path. 
The default number of frames is 100. Activate the Save to file checkbox and apply a file prefix 
to save each frame of your animation to the hard disc. Press the Browse button to bring up a file 
selection box. Select the directory where all file should be saved and enter a file prefix and a file 
type (BMP, TIF, JPG, PPM), e.g. enter the prefix “movie” and select BMP as file type. The ren-
dered frames will then be saved as movie001.bmp to movie100.bmp.      

The Create animation section displays the frame where the camera is actually located. You may 
enter a frame number to move the camera to the specified frame. The Create animation section 
also includes a recorder style interface to steer the animation rendering. Press the Play button  
to render the animation. The animation will be rendered in preview quality as long as the Save to 
file option is not activated and the Motion smoothing option is activated in the Renderer prop-
erties tool (Chapter 4.6.3 Renderer Properties). The animation will be rendered in high quality 
when the Save to file option is activated. The Play button will then appear in the record shape . 
The render quality and the rendered image size can be adjusted in the Renderer properties tool. 
Press the Rewind button  to jump to frame number 1. Use the Forward and back buttons  
to step through the animation frame by frame.  

Saving Keyframer settings 

All Keyframer settings will be saved together with the scene when using the Save or Save as 
option in the File menu. The resulting vgi file includes the whole camera trajectory and camera 
informations. A camera trajectory itself can be saved by the Save camera trajectory (file exten-
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sion: trj) option in the file menu. You can load a camera trajectory from a trj file or even a trajec-
tory saved with a whole scene in a vgi file with the Load camera trajectory option in the File 
menu.  

 

Reminder: The Keyframer settings will also not be lost when deactivating the Key-
framer by pressing the Keyframer Icon. You may switch the Keyframer off and on 
again at any time to continue your work. 
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4.7 Status Bar 

The status bar is displayed at the bottom of the main window. 

In the first field of the status bar you will find information about the measurement tools and the 
segmentation process. If the 3D instrument is activated, its position is displayed in voxel coordi-
nates of the current object (in peaked brackets) and in object coordinates in scene units. The gray 
value at the 3D cursor’s position is also displayed. If the distance tool is active, the current dis-
tance will be displayed in scene units. If the angle tool is active, the angle in degree will be dis-
played. And finally if segmentation is activated, the segmented area will be displayed instead. 

The second section of the status bar displays the current scene unit, e.g. �m, mm, cm, m. All 
numerical coordinates and measurement  information displayed in VGStudio MAX refers to the 
unit setting displayed in the status bar. If no unit was applied to any data set during the import 
process or within the Object properties tool "units" will be displayed in the status bar. All  nu-
merical coordinates and measurement information displayed will be counted in voxel units. 
Double click on the unit area in the status bar to open the Preferences dialog (Chapter 4.3.3 
Setting Preferences) where you can change the scene unit settings. 

The third section shows the current drawing colors, where the color of the hidden rectangle is the 
background color and the fully visible rectangle shows the current foreground color. When no 
object is activated, the field will be empty. For more information about drawing, see Chapter 
4.4.3 3D Instrument. Double click on the drawing color area will open the Grid, Axes & In-
strument properties dialog (see Chapter 4.3.5 Scene Menu), with instrument properties active, 
here you can change the drawing color, brush size and brush mode. 

The fourth section of the status bar includes information about the current process performed in 
VGStudio MAX and the progress of the different processes. 

    





 

 

5 Importing & Exporting Data 

This chapter provides information on the data I/O capabilities of VGStudio MAX. Detailed in-
formation on 

�� importing data and 

�� exporting data  

will be given in this chapter. 
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5.1  Importing Data 

5.1.1 The VGI - Volume Graphics Info - file concept 

VGStudio MAX allows its users to import a wide variety of different data files and data types. 
The voxel or volume data my be provided as a single data file or as a stack of several image data 
files. 
 

Stack of Image Slices  

BMP  color and grayscale 

TIFF  color and grayscale (8 bit only for grayscale) 

JPEG  color and grayscale 

PPM  color and grayscale 

DICOM  See Appendix  

HDF  See Appendix  

RAW  signed/unsigned 8 bit integer 

RAW  signed/unsigned 16 bit integer 

RAW  signed/unsigned 32 bit integer (20 bit effective range) 

RAW  32 bit float 

RAW  32 bit RGBA 

  

Volumes  

DICOM   

HDF   

Analyze™   

RAW  signed/unsigned 8 bit integer 

RAW  signed/unsigned 16 bit integer 

RAW  signed/unsigned 32 bit integer (20 bit effective range) 

RAW  32 bit float 

RAW  32 bit RGBA 

Select the Import option in the File menu and choose the appropriate option to import the dif-
ferent data types and files. 
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After having imported the data, you may save your scene. Saving a scene with the Save or Save 
as option in the File menu will generate a Volume Graphics Info file (.vgi extension). The vgi 
file contains all information needed by VGStudio MAX 1.0 to load data again by using the Open 
command in the File menu. You do not have to use the import procedure again. The vgi file con-
tains data-relevant information such as data file names and the path to the data files, data type, 
file type, file size, and data mapping as well as scene-relevant information such as light settings, 
rendering algorithm, or background color. 

 

Fig. 220 Select Import in the File menu and choose the appro-
priate option to import the different data types. 
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Data saved in VGStudio MAX always consists of two elements, i.e. the data file(s) and the Vol-
ume Graphics Info file. A vgi file contains references to all data included in the scene so that a 
complex scenario can be restored by loading a single vgi file. The concept of VGStudio MAX’s 
data handling is to leave the original data untouched. All information on how data has to be 
processed during the import will be saved in a vgi file.  

Example: 

A voxel data set includes 32 bit floating point data but the dynamics of the data is very low so 
that it will fit into a 8 bit integer (256 gray value) representation. During the import procedure, 
the user may specify that data should be converted into a 8 bit data representation. This will re-
duce the amount of RAM needed on your PC or workstation by a factor of 4! This conversion 
will be done automatically while loading the data into VGStudio MAX. The original data set on 
your hard disk will remain untouched and no second 8 bit data set, which would increase your 
disk capacity requirements, has to be generated. However, VGStudio MAX allows its users to 
export the data in the internal data representation chosen by the user (see Chapter 5.2 Exporting 
Data). 

If you save your current work to a vgi file all the conversion information will be saved along 
with all the other scene-specific data. The next time the vgi file is loaded, the conversion will be 
carried out automatically. 

 

Fig. 221 Import data into VGStudio MAX and then save the scene by using the save or save 
as command in the File menu to generate a vgi file. 
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5.1.2 Importing Stacks of Image Slices 

To import a stack of images, click File in the menu bar and select Import. Then click Image 
Slices in the Import menu to open the Image Slices Import Wizard.  

The Image Slices Import Wizard will guide you through the whole import process step by step. 
Click the Next or Previous buttons to go through the different steps of the import process. The 
different steps will be explained in the following: 

Step 1: File type selection 

Select the File type from the File type list. You may choose between RAW data, TIFF, JPEG, 
PPM, BMP, HDF and DICOM images. 

 

Fig. 222 Select the file type in the Import tool window. 
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Step 2: File selection 

Click Add to open a file selection dialog. Select one or several files and click Open. The list 
with the selected files will then be displayed in the Import tool window. To add more files to the 
list click again Add and repeat the procedure. 

To remove files from the list select one or several files and click Remove. You may also drag the 
selected files on the remove button to delete them from the list. The files will only be removed 
from the list and will not be deleted from the hard disk or other data source. 

 

Fig. 223 Select the files you want to import and add them to the list. 
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Step 3: File order 

To sort the files, you may use the Sort function of the Import tool window; there, you may 
choose the order in which you wish to sort the files, e.g. alphabetical order. You may also use 
drag and drop to bring the files into the correct order. 

Click Next to continue with the import process. 

 

Fig. 224 Sort the files by using the Sort function of the Import tool window. 
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Step 4: Data type selection (for RAW data only) 

The data type has to be specified if the file type RAW was selected. Select the data type of the 
chosen file from the pulldown menu. Possible data types are: 

�� signed or unsigned 8bit, 16bit, or 32bit  

�� 32bit float 

�� 32bit RGBA 

Decide whether the data is to be stored in binary or in ASCII format and select the byte order.  

VGStudio MAX is capable to import GNU zip compressed data files. Mark the GNU zip check-
box to import compressed data. 

 

 

Reminder: Compression will not work in conjunction with ASCII data. 

 

Fig. 225 Specify the data type for RAW images. 
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Step 5: Data type selection (for TIFF, JPEG, BMP, and PPM images 
only) 

Image slices may be imported as grayscale or color data. 

 

Fig. 226 Select the data type for TIFF, JPEG, BMP, and PPM images. 



5. Importing & Exporting Data 

VGStudio MAX 1.0 User’s Manual 224 

Step 6: Image size selection (for RAW data only) 

The image size and header size in bytes has to be specified if the file type RAW was selected. 

Use the sliders or type in the x-, y-, and z-size of the volume data. If the volume data set includes 
a header enter the header size in bytes. The header has to be located at the beginning of the data 
file and will be skipped while loading. You can use the Guess button after having entered the 
size to compute the header size automatically. 

Since the size of the volume has been settled, the memory consumption can be computed. It will 
be displayed in this and every following page of the import dialog. The field Memory needed 
shows the memory consumption of the volume, the field Memory available shows the amount 
of system memory, that is available. If the memory needed is greater than the memory available, 
memory needed will be displayed red, so that you can free some memory on your machine or 
reduce the volumes size, its region of interest or its skip factor (for the two latter items see next 
step). 

 

Fig. 227 Select the image and header size for RAW data by dragging the sliders or typing in 
the desired values. 
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Step 7: ROI and Skip selection 

Use this dialog of the import wizard to define a region of interest within the imported stack of 
images or to define the number of voxels to be skipped in each direction of the image planes by 
dragging the sliders or typing in the desired values. These functions may be of special interest for 
very large data volumes in order to reduce the amount of data loaded in VGStudio MAX. 

Use the six Region of Interest sliders to define a sub volume within the data set which should be 
loaded into VGStudio MAX.  

 

Fig. 228 Define Regions of Interest and choose the skip rate.  
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Use the three Skip sliders to specify the number of voxels to be skipped in x-, y- and z-direction. 
When choosing a value of 1, every second voxel will be skipped in the selected direction. To 
skip voxels in z-direction remove the appropriate files from the list of selected files (see step 1 
and step 2). 

The Preview function allows you to preview the new settings. 

The Memory needed will be updated immediately in the corresponding field. 

 

Fig. 229 Define a Region of Interest that is to 
be loaded into VGStudio MAX. 
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Step 8: Internal data representation 

The data type may be changed while loading data into VGStudio MAX, e.g. a 32 bit floating 
point data set on your hard disk may be mapped to a 16 bit integer data representation. In this 
case, this would reduce the amount of memory needed for visualization by a factor of two, which 
can be observed in the Memory needed field. 

Any data type may be mapped to any other data type. The only exception are RGBA data sets. 

 

 

Reminder: RGBA data cannot be mapped to any other data representation. Also, 
monochrome data types may not be mapped to RGBA data. 

 

 

 

Fig. 230 Specify the data representation. 
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unsigned 8bit 

signed 8bit 

unsigned 16bit 

signed 16bit 

unsigned 32bit 

signed 32bit 

32bit float 

May be mapped to 

unsigned 8bit 

signed 8bit 

unsigned 16bit 

signed 16bit 

unsigned 32bit 

signed 32bit 

32bit float 

32bit RGBA only possible mapping 32bit RGBA 

The voxel Resolution may be adjusted for data sets with non-isotropic voxel dimensions.  

A Warning dialog may come up in case that you import data series with Significant difference in 
voxel Resolution. Press Yes to resample the data. The software will calculate additional slices by 
trilinear resampling. This will result in a better 3D image quality. However keep in mind that 
slice images will be generated out of your original data which are not generated by the scanning 
device. The resampling will also result in an additional amount of memory needed by the 
VGStudio application. This process may exceed the available memory installed in your computer 
depending on your initial image data. Press No to skip the resampling process so that only the 
original image data is loaded. However this may result to low 3D image quality. 

 

 

Fig. 231 Resampling warning Pop up. 
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The Data range may be mapped arbitrarily within a maximum data range for the different data 
types. The maximum values will appear as default values when opening the dialog for the first 
time. Pressing the Reset button will restore these default values. 

The maximum data ranges for the different data types that can be handled by VGStudio MAX 
are listed in the following table: 

 

Data type Min value 
incl.  

Max value 
incl. 

Effective reso-
lution 

unsigned 8bit 0 255 8 bit 

signed 8bit -128 127 8 bit 

unsigned 16bit 0 65535 16 bit 

signed 16bit -32768 32767 16 bit 

unsigned 32bit 0 1048575 20 bit 

signed 32bit -524288 524287 20 bit 

32bit float --- --- 16 bit 

 

 

Reminder: For best results while working with scenes including several floating 
point data sets you should map the floating point data values of all data sets to the 
same data range. 

Press the Scan file button to determine the data range included in the data set to be loaded. 

Clicking Cancel will stop the scan process, but the values determined during the partial scan will 
be displayed in the dialog. 

 

Fig. 232 Use the Scan function 
to determine the data range. 
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Step 9: Optional data preview 

The Preview window may be used to view your data as slices before starting the import process. 
This may help you to choose the right parameters. If you are not satisfied with the results, you 
may always go back to any of the previous steps and change the settings and then check the re-
sults again in the Preview window. Use the slice selection slider to select the slice to be dis-
played.  

A region of interest (ROI) may also be defined. To do so, grab one of the corners of the blue 
frame around the region of interest or grab the frame itself by clicking it with the left mouse but-
ton. You may now resize the region of interest by dragging the frame to the desired position 
while holding the left mouse button pressed. 

Use the Auto contrast checkbox to automatically scan the currently displayed slice for optimal 
gray value mapping. 

Use the Flip view to X/Z button to preview the slices in the x/z plane or the Flip view to X/Y 
button to preview the slices in the x/y plane. 

 

Fig. 233 Before starting the import procedure, you may preview your data as slice images. 
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Press the Hide Preview button to hide the preview window (after finishing the import of an vol-
ume the preview hides automatically). 
 

 

Reminder: The preview performance might be low when viewing ASCII or com-
pressed data files.  
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Step 10: Manipulation of the object coordinate system 

The coordinate system of the imported data may be manipulated arbitrarily. The x- and y-axes of 
the data set may be mirrored. To mirror the z-axis change the sorting order in the file selection 
dialog (step 1). The order of the axes may be swapped. 

You may now start the import procedure by clicking Finish. 

5.1.3 Importing Raw Volume Data 

To import Raw volume data, click File in the menu bar and select Import. Select Raw Volume 
from the Import menu to open the Raw Volume Import Wizard.  

The Raw Volume Import Wizard guides you step by step through the whole import process. 
Click the Next or Previous buttons to go through the different steps of the import process. The 
different steps will be explained in the following: 

 

Fig. 234 Mirror or swap the x- and y-axes of the data set. 
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Step 1: File selection 

Click Browse to open a file selection dialog. Select one file and click Open. The selected path 
and filename will appear in the File name section of the Import Wizard. Then click Next to 
continue. 

 

Fig. 235 Select the file you want to import. 
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Step 2: Data type selection 

The data type has to be specified. Select the data type of the chosen file from the pulldown 
menu. Possible data types are: 

�� signed or unsigned 8bit, 16bit, or 32bit  

�� 32bit float 

�� 32bit RGBA 

Decide whether the data is to be stored in binary or in ASCII format and select the byte order. 

VGStudio MAX is capable to import GNU zip compressed data files. Mark the GNU zip check-
box to import compressed data. 

 

 

Reminder: Compression will not work in conjunction with ASCII data. 

 

 

Fig. 236 Specify the data type for Raw images. 
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Step 3: Image size 

Use the sliders or type in the x-, y-, and z-size of the volume data. If the volume data set includes 
a header enter the header size in bytes. The header has to be located at the beginning of the data 
file and will be skipped while loading. You can use the Guess button after having entered the 
size to compute the header size automatically. 

Since the size of the volume is known the memory consumption can be computed. It will be dis-
played in the field Memory needed, the system memory available will appear in the field Mem-
ory available. The memory needed will be displayed in all further pages of the raw volume 
image import. If the memory available will not be enough for the volume to be loaded, the mem-
ory needed will be displayed in a red field. The memory needed will be always kept up to date, 
whether you change the data type, the size of the volume, the region of interest, skip factors or 
the data type, the volume might be changed to while loading. See further steps. 

 

Fig. 237 Select the image and header size by dragging the sliders or typing in 
the desired values. 
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Step 4: ROI and Skip selection 

Use this dialog of the import wizard to define a region of interest within the imported stack of 
images or to define the number of voxels to be skipped in each direction of the image planes by 
dragging the sliders or typing in the desired values. These functions may be of special interest for 
very large data volumes to reduce the amount of data loaded in VGStudio MAX. 

Use the six Region of Interest sliders to define a sub volume within the data set which should be 
loaded into VGStudio MAX. 

 

Fig. 238 Define Regions of Interest and choose the skip rate. 
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Use the three Skip sliders to specify the number of voxels to be skipped in each direction. When 
choosing a value of 1, every second voxel will be skipped in the selected direction. The follow-
ing image shows the example for skip values of 1 in each direction. 

 

Fig. 239 Define a Region of Interest that is to 
be loaded into VGStudio MAX. 

 

Fig. 240 For each direction, a skip value of 
1 was chosen. 
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Step 5: Internal data representation 

The data type may be changed while loading data into VGStudio MAX, e.g. a 32 bit floating 
point data set on your hard disk may be mapped to a 16 bit integer data representation. In this 
case, this would reduce the amount of memory needed for visualization by a factor of two, which 
can be immediately observed in the Memory needed field. 

Any data type may be mapped to any other data type. The only exception are RGBA data sets.  
 

 

Reminder: RGBA data can not be mapped to any other data representation. Also, 
monochrome data types may not be mapped to RGBA data. 

 

 

Fig. 241 Use this dialog to specify the internal data representation. 
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unsigned 8bit 

signed 8bit 

unsigned 16bit 

signed 16bit 

unsigned 32bit 

signed 32bit 

32bit float 

may be mapped to 

unsigned 8bit 

signed 8bit 

unsigned 16bit 

signed 16bit 

unsigned 32bit 

signed 32bit 

32bit float 

32bit RGBA no mapping possible 32bit RGBA 

The voxel Resolution may be adjusted for data sets with non-isotropic voxel dimensions.  

A Warning dialog may come up in case that you import data series with Significant difference in 
voxel Resolution. Press Yes to resample the data. The software will calculate additional slices by 
trilinear resampling. This will result in a better 3D image quality. However keep in mind that 
slice images will be generated out of your original data which are not generated by the scanning 
device. The resampling will also result in an additional amount of memory needed by the 
VGStudio application. This process may exceed the available memory installed in your computer 
depending on your initial image data. Press No to skip the resampling process so that only the 
original image data is loaded. However this may result to low 3D image quality. 

 

Fig. 242 Resampling warning Pop up. 
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The Data range may be mapped arbitrarily within a maximum data range for the different data 
types. The maximum values will appear as default values when opening the dialog for the first 
time. Pressing the Reset button will restore these default values. 

The maximum data ranges for the different data types that can be handled by VGStudio MAX 
are listed in the following table: 

 

Data type Min value 
incl.  

Max value 
incl. 

Effective reso-
lution 

unsigned 8bit 0 255 8 bit 

signed 8bit -128 127 8 bit 

unsigned 16bit 0 65535 16 bit 

signed 16bit -32768 32767 16 bit 

unsigned 32bit 0 1048575 20 bit 

signed 32bit -524288 524287 20 bit 

32bit float --- --- 16 bit 

 

 

Reminder: For best results while working with scenes including several floating 
point data sets you should map the floating point data values of all data sets to the 
same data range. 

Press the Scan file button to determine the data range included in the data set to be loaded. 

Clicking Cancel will stop the scan process, but the values determined during the partial scan will 
be displayed in the dialog. 

 

Fig. 243 Use the Scan function 
to determine the data range. 
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Step 6: Optional preview 

The Preview window may be used to view your data as slices before starting the import process. 
This may help you to choose the right parameters. If you are not satisfied with the results, you 
may always go back to any previous step and change the settings and then check the results again 
in the Preview window. Use the slice selection slider to select the slice to be displayed.  

A region of interest (ROI) may also be defined. To do so, grab one of the corners of the blue 
frame around the region of interest or grab the frame itself by clicking it with the left mouse but-
ton. You may now resize the region of interest by dragging the frame to the desired position 
while holding the left mouse button pressed.  

Use the Auto contrast checkbox to automatically scan the currently displayed slice for optimal 
gray value mapping. The Auto contrast function will modify any previously adjusted data range 
mapping performed in step 5. 

 

 

Reminder: The preview performance might be low when the viewed slice is flipped 
or when viewing ASCII or compressed data files.  

 

Fig. 244 Before starting the import procedure, the Raw volume data may be pre-
viewed as slice images. 
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Step 7: Manipulation of the object coordinate system 

The coordinate system of the imported object may be manipulated arbitrarily. All three axes of 
the data set to be imported may be mirrored. The order of the axes may be swapped. 

You may now start the import procedure by clicking Finish. 

5.1.4 Importing HDF Data 

VGStudio MAX is capable to import image and volume data stored in the Hierarchical Data 
Format (HDF 4.x). Select the Import HDF volume option in the File menu to load HDF volume 
data files into VGStudio MAX. More information on HDF data can be found under the following 
internet address: http://hdf.ncsa.uiuc.edu. 

 

Fig. 245 Mirror or swap the x-, y-, and z-axes of the data set. 
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Select the HDF file you want to import in the file dialog. If the HDF file contains several data 
sets, a dialog will appear, where you can choose one or several data sets to import (see Fehler! 
Verweisquelle konnte nicht gefunden werden. The Import HDF dialog.). 

5.1.5 Importing ANALYZE™ Data 

VGStudio MAX is capable to import data stored in the Analyze™ file format. 

Select the Import Analyze volume option in the File menu to load Analyze™ volume data files 
into VGStudio MAX. More information on the Analyze™ file format can be found under the 
following internet address: http://www.mayo.edu/bir/analyze/AnalyzeFileInfo.html. 

5.1.6 Importing DICOM Data 

Select the Import DICOM image option in the File menu to load DICOM volume data or im-
age files into VGStudio. Use the file dialog to select one or several data files. The Dicom import 
dialog will pop up. Select a study and one or more acquisitions to be imported. Press OK to load 
the data or Cancel to abort the operation.  

 

 

Fig. 246 The Import HDF dialog. 
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A Warning dialog may come up in case that you import DICOM image series with non equal 
slice distances or in case that the slice distance is more than three times the pixel resolution 
within the slices. Press Yes to resample the data. The software will calculate additional slices by 
trilinear resampling. This will result in a better 3D image quality. However keep in mind that 
slice images will be generated out of your original data which are not generated by the scanning 
device. The resampling will also result in an additional amount of memory needed by the 
VGStudio application. This process may exceed the available memory installed in your computer 
depending on your initial image data. Press No to skip the resampling process so that only the 
original image data is loaded. However this may result to low 3D image quality. 

Press the Details button to get an detailed overview of the selected DICOM acquisitions which 
will be displayed in the Import Dicom files window along with other information included in 
the files such as patient name, date of birth, position etc. 

You may select or deselect one or several files. By clicking the Delete key you delete the cur-
rently selected files. 

 

 

Fig. 247 The Import Dicom files window. 
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The Preview window may be used to view your data as slices before starting the import process. 
This may help you to choose the right parameters. If you are not satisfied with the results, you 
may always go back to any previous step and change the settings and then check the results again 
in the Preview window. Use the slice selection slider to select the slice to be displayed. 

A region of interest (ROI) may also be defined. To do so, grab one of the corners of the blue 
frame around the region of interest or grab the frame itself by clicking it with the left mouse but-
ton. You may now resize the region of interest by dragging the frame to the desired position 
while holding the left mouse button pressed. 

 

Fig. 248 The Import Dicom files window. 

 

Fig. 249 The Import Dicom files window. 
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Use the Auto contrast checkbox to automatically scan the currently displayed slice for optimal 
gray value mapping. 

5.1.7 Importing Polygon Data 

VGStudio MAX is capable to import polygonal data stored in Off file format. More information 
on the off file format can be found in the Geomview Manual which can be accessed via the fol-
lowing internet address: http://www.geom.umn.edu/software/geomview/geomview_toc.html. 
The manual is provided by the Geometry Center of the University of Minnesota. 
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5.2 Exporting Data 

A single volume object can be exported to different file formats, e.g. as a stack of Images, as a 
Raw volume data file, a HDF file, an Analyze™ volume or a Dicom image series. To do so, se-
lect Export and the desired format in the File menu. 

The export options remains disabled if no object is selected or if the active object is a polygon 
object or a group of objects.  

Before every export a message box arises, asking you whether the current scene should refer to 
the currently saved data. That means, if in the present scene an object refers to Analyze-data and 
you saved that object as a raw volume and you chose Yes in the Replace volume info message 
box, the next time you load the scene, the vgi file will refer to the raw volume (provided you 
saved the scene). 

 

Fig. 250 Select Export / Raw volume to export a single 
volume object e.g. as a Raw volume data file. 

 

Fig. 251 VGStudio MAX will ask whether you want the object in 
the present scene should refer to the currently saved data. 
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Sometimes referring to saved data is no good idea, because some exports will lead to a loss of 
data, e.g. exporting a 32 bit integer volume as a stack of BMP images will reduce the data range 
to 8 bit. 

After the data files were written to disk the following dialog box will pop up.  

Click Yes if you want to save a vgi file (Volume Graphics Info file) for the exported volume. 
The vgi file will contain only the minimal information to reload the volume, that is the informa-
tion about the files to load, information about the units (if necessary) and the data range of the 
volume. Use this option, if you want to merge the exported volume to another scene as an com-
fortable alternative to importing the data to a scene. Select No to skip this step. 

In the following the specific differences of the various export types as listed in the Export sec-
tion of the File menu will be described. 

5.2.1 Exporting Image Stacks 

If you chose export image stack, a save file dialog will appear. You can chose out of a variety of 
file types: binary, ASCII or compressed raw export or in one of the supported image formats 
(BMP, JPEG, TIFF, PPM). The file name you enter or chose from the file list will be the basic 
file name. Each slice will consist of the name you entered, followed by a 4 digit slice number 
and completed by the image type specific file suffix. 

Since the data range of BMP, JPEG and PPM is practically 8 bit and the data range of TIFF is 8 
or 16 bit sometimes you will loose data if you continue export. 

If you export BMP, JPEG or PPM images and the volume has a data range greater than 8 bit, 
VGStudio MAX will warn you with the message below. If the loss of data is acceptable to you, 
you can click YES, to continue export. Clicking on NO will stop the export. 

 

Fig. 252 VGStudio MAX will ask you whether you 
want to save a vgi file for the exported volume. 
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BMP, JPEG and PPM images produced by VGStudio MAX will always be RGB images with 8 
bit for every color channel. If the volume exported is not of type RGBA it will be exported as an 
gray value image. 

Exporting JPEG images will confront you with a small dialog to specify the image quality in a 
range from 5 to 100, where 5 means the poorest quality, but best compression factor and 100 
means best quality, but nearly no compression at all. The default value of 78 is a trade of, that 
should satisfy most needs. 

If you want to export to TIFF and the data range of your data is 16 bit or greater VGStudio MAX 
will come up with this message box: 

 

 

Fig. 253 If the data range does not fit the image for-
mat, VGStudio MAX will warn you, that you might 
loose data. 

 

Fig. 254 Exporting JPEG images will 
confront you with the choice of the im-
age quality. 

 

Fig. 255 Exporting non RGB volume data to a TIFF image 
stack will give you the choice of the data range. 
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If you choose 8 bit integer, you will export the active volume as an image stack of 8 bit TIFF 
images, if you click on 16 bit integer, you will export the active volume as an image stack of 16 
bit TIFF images. If neither 8 bit nor 16 bit export satisfy your needs click No to cancel TIFF ex-
port. 

TIFF export in VGStudio MAX supports 8 and 16 bit gray value and 8 and 16 bit RGBA export. 

5.2.2 Exporting RAW Volumes 

The user may select from the Filetype selection within the file dialog box the file format in 
which the raw data file should be written to disk. The file could be written as a single raw data 
file, a ASCII data file or as gzip'ed raw data file. A single raw data file will be written to disk in 
the same data type (e.g. 8, 16, 32 bit unsigned/signed integer, 32 bit float, or 32 bit RGBA) the 
object was represented in VGStudio MAX. For example, a data set which was loaded as 16 bit 
unsigned integer data into VGStudio MAX will be written to disk as 16 bit unsigned integer data. 
The byte order will be the original byte order of your hardware. The voxel at position (0,0,0) will 
be written first, x is the inner loop variable, y the second loop variable, and z the outer loop vari-
able. 

 

 

Fig. 256 The voxel at position (0,0,0) will be writ-
ten first, x is the inner loop variable, y the second 
loop variable, and z the outer loop variable. 
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5.2.3 Exporting HDF Volumes 

VGStudio MAX is capable to export image and volume data in the Hierarchical Data Format 
(HDF 4.x). 

Select the Export HDF volume option in the File menu to save the current volume as a HDF 
volume data file. More information on HDF data can be found under the following internet ad-
dress: http://hdf.ncsa.uiuc.edu. 

5.2.4 Exporting Analyze™ Volumes 

VGStudio MAX is capable to export data in the Analyze™ file format. 

Select the Export Analyze volume option in the File menu to save the current active volume as 
an Analyze volume data file. More information on the Analyze™ file format can be found under 
the following internet address: http://www.mayo.edu/bir/analyze/AnalyzeFileInfo.html. 

5.2.5 Exporting DICOM  Image Series 

Select the Export DICOM image series option in the File menu to save the current active vol-
ume as a series of Dicom files. 

If the volume to export has been previously loaded from an Dicom image series itself, the ex-
ported Dicom files will contain as much of the Dicom information as will be displayed in the 
Import Dicom Files window (see Fig. 248 The Import Dicom files window.). If the volume is not 
Dicom based the exported Dicom files contain no further information, than the slice number and 
the name of the object as patient’s name. 

 

Reminder: Any Dicom data written by VGStudio MAX will be tagged as derived 
data! 
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6.1 VGStudio MAX 1.0 and memory consumption 

6.1.1 Memory consumption of voxel data 

A data set loaded into VGStudio MAX is divided into sub-volumes of the size 16x16x16 voxels. 
The dimensions of a data set of the size 252x252x204 will be rounded up to a size of 
256x256x208 in memory. This is called the Data Size in Memory (DSM). Every data set in 
memory needs an additional amount of memory which is needed for performance optimization 
reasons. It is called  the “Spaceleaping Data” (SD). The SD has the same dimensions as the 
original data in memory but it allocates only one byte per voxel, independent of the data type of 
the original data. In addition to the DSM and SD a few kByte additional memory are needed. 

Memory consumption of data set of different data types: (size 252x252x204) 
 

Data type DSM in MB SD in MB Total Size in MB 

8 Bit 13 13 26  

16 Bit 26 13 39  

32 Bit 52 13 65 

RGBA 52 13 65 

Memory consumption of objects in a VGStudio MAX 1.0 scene 
 

Original data DSM + SD 

Copy of an object SD 

References of an object few kByte 

6.1.2 Rendering large high quality images 

The rendering of large images - VGStudio MAX allows the user to render images up to 
4096x4096 pixels which is 64 MB - requires large amounts of memory. 

The amount of memory may be reduced by reducing the image size and the oversampling rate. 
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6.2 Limitations and Known Bugs 

�� The shadows appear to be bent. 

The shadows rendered by VGStudio MAX 1.0 are bent due to the lighting model used in 
VGStudio MAX's renderer. This behavior will be corrected in one of the next VGStudio 
MAX releases. 

�� Windows NT 4.0 crashes when visualizing very large amounts of data. 

Under certain conditions, Windows NT 4.0 with Service Pack 3 or lower may crash when 
visualizing very large data amounts using up almost all available memory (RAM + Swap) on 
your system. To correct this fault, install the latest Windows NT 4.0 Service Pack. 

�� VGStudio MAX 1.0 crashes during printing on a Linux system. 

VGStudio MAX 1.0 crashes when printing on a Linux system where no valid printer is con-
figured. Please refer to your Linux distribution's manual and set up a printer.
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2D magic wand 182 
2D selection propagate 185 
3D instrument 96 
3D magic wand 182 
3D window 32, 85, 113 
about VGStudio 85 
active areas 36 
active handle 119 
angle measurement tool 100 
animation 207 
auto update 182 
axis 79 
axis properties 80 
background color 82, 212 
bounding box 35, 112 
camera mode 79, 116, 173 

camera position 173 
default view buttons 173 
look-at point 173 
up vector 173 
view frustum 174 
viewing angle 174 

camera position 116, 173 
camera symbol 117 
camera trajectory 207 
camera view 84, 103, 113, 116, 173 

camera position 116 
look-at point 116, 117 
up vector 116, 118 
view frustum 117 
viewing angle 116 

camera view mode 116 
Center 144 
CFG file 72 
CFG file options 72 
classification 83, 125 
classification tool 125 

color manipulation area 127 
object overview 127, 129 
object selection 127 
opacity manipulation area 132 

clipboard 58 
clipbox 77, 94, 115, 166 
clipping 166, 169, 170 
clipplane 77, 94, 115, 166 

distance 168 
normal vector 168 
origin 168 

close bounds 205 

color 125 
apply 146 

color coding 63 
color handle 

move 147 
color interval 

move 147 
color manipulation area 127, 146 

copy segment color 149 
delete handle 148 
export segment color 149 
import segment color 149 
insert handle 148 
paste segment color 149 
set handle color 149 
set interval color 149 
set segment color 149 

color mapping 146 
color scheme 63 
command line option 32 
contract 186 
control icon 64, 108, 113, 120 
control menu 64, 108, 113, 120 
coordinate system 242 

manipulation 232, 242 
mirror 232, 242 
swap 232, 242 

copy 70, 88 
copy opacity curve 137 
create reference 78 
cross section 107 

axial 107 
frontal 107 
sagittal 107 

cut 69, 88 
data files 

compressed 222, 234 
data range 240 
data range mapping 229 
data representation 227, 238 

data range 240 
reset 229, 240 
resolution 239 

data type 
32bit float 222 
32bit RGBA 222 
8/16/32bit signed 222 
8/16/32bit unsigned 222 

data value mapping 143 
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default view buttons 172, 173 
delete 70 

handle 137, 148 
segment 138 

deselect 70, 154 
Dilation 186 
disable 76 
distance measurement tool 99 
duplicate 70 

objects 153 
Dynamic 182 
edit menu 69 
ellipse tool 182 
enable 76 
Erosion 186 
exiting VGStudio 58 
expand 186 
export 67 
exporting data 215, 247 
exporting Raw volumes 247 
extract function 138 
extract segment 138, 155 
extracted segment 

export raw data 142 
feedback 18 
file menu 65 
first steps 39 
floating tools 123 
front light source 58, 160 

ambient 160 
diffuse 160 

Gantry 170 
GNU zip 222, 234 
grayvalue range 135 
grayvalue segment 135 
grayvalue segmentation 135 
grid 79 

axis & instrument properties 79 
properties 80 

group 77 
group objects 152 
guess button 224, 235 
handle 

active 119 
apply color 146 
delete 137, 148 
insert 133, 137, 148 
move 134 
set color 149 

help 
e-mail 17 
Volume Graphics sales 17 
Volume Graphics technical support 17 

Volume Graphics web site 17 
help menu 85 
histogram 132, 143 

disable 144 
reset zoom 144 
zoom in 144 
zoom out 144 

icon bar 32, 87 
object manipulaton section 87 
scene utilities section 87 
standard icon section 87 
view selection section 87 
what's this section 87 
window layout tools section 87 

illumination model 57 
image quality 59 

optimal settings 59 
image slices import wizard 219 
import 67 

add file 220 
Analyze™ data 243 
data type selection 222, 223 
DICOM data 243 
file order 221 
file selection 220 
file type 219 
file type selection 219 
guess button 224 
HDF data 242 
image size selection 224 
internal data representation 227 
manipulation of object coordinate system 232 
non-isotropic voxel dimensions 228 
optional data preview 230 
polygon data 246 
preview function 226 
Raw volume data 232 
region of interest 225 
remove file from list 220 
ROI and Skip selection 225 
scan file 229 
skip function 226 
sort function 221 
voxel resolution 228 

import stacks of image slices 219 
import tool 220 
importing data 215 
importing Raw volume data 

browse 233 
data type selection 234 
file name 233 
file selection 233 
guess button 235 
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header size 235 
image size 235 
internal data representation 238 
manipulation of coordinate system 242 
optional preview 241 
region of interest 236 
ROI and Skip selection 236 
scan file 240 
skip function 237 

insert handle 137, 148 
installation 21 
instrument 79, 80 
instrument properties 80, 214 
interface 61 

layout 103 
interval 

apply color 146 
interval color 

set 149 
isotropic scaling 165 
keyboard 

shortcuts 34 
usage 33 

lasso tool 182 
launching the program 32 

command line option 32 
VGStudio icon 32 

layout 103 
Level-Window 144 
license 26 

update 26, 86 
light properties 57, 83, 160 

front light source 160 
overall intensity 160 

light source 
apply color 161 
disable 161 
enable 161 
front 58, 160 
shadow 58, 160 

look-at point 116, 117, 173 
marquee tool 182 
maximize 107 
maximum projection algorithm 156 
MDI 85, 103 
measure 

angle 80, 100 
distance 80, 99 
surface area 205 
volume 154 

menu bar 32, 65 
merge object 66 
minimize 106 

morphological operators 186 
motion smooting 159 
mouse 

Magellan Space Mouse 37 
usage 35 

move 76, 91, 114, 121 
MPR 62, 107 
Multi Planar Reconstruction 62, 107 
Multiple Document Interface 85, 103 
multiprocessor 23 
new scene 66, 87 
object 

center 54 
change name 151 
create reference 153 
delete 153, 155 
deselection 36, 90 
disable 152, 155 
duplicate 153 
enable 152 
group 152 
manipulation icons 87 
menu 76 
origin 168 
polygon 52 
reset 152 
selection 35, 90, 127 
voxel 52 

object group 150 
change name 151 
disable 152, 155 
enable 152 
ungroup 153 

object manipulation icons 89 
object overview 127, 129 

define Region of Interest (ROI) 129 
delete all segments 132 
reset Region of Interest (ROI) 131 

object properties 84, 162 
clipping 166, 169, 170 
position 163 
rotation 163 
scale 165 

Object relative mode 110 
Off file format 246 
opacity 125 
opacity curve 

copy 137 
paste 137 
reset 137 
reset to default 137 
reset to full opaque 137 
reset to full transparent 137 
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opacity function 132, 133 
opacity handles 132, 133 
opacity manipulation area 125, 132, 133, 134 

delete handle 137 
histogram 132 
insert handle 133, 137 
move handle 134 
opacity function 132 
opacity handles 132 
segment borders 132 
segment names 132 

open a scene 66, 88 
optimal settings 

image quality 59 
performance 59 

paste 70, 89 
paste opacity curve 137 
performance 

optimal settings 59 
pixel 55 
polygon lasso 182 
polygon object 52, 150 
polygon properties 84, 162 
polygonal representation 54 
position 163 
preferences 70 

Dicom imports path 72 
HDF imports path 71 
images path 72 
objects path 71 
polygons path 71 
raw imports path 71 
scenes path 71 

preferences dialog box 71 
directories index card 71 
options index card 72 

preset selection 127 
preview 230, 241 

auto scan checkbox 230, 241, 246 
region of interest 230, 241, 245 

print 68, 88 
print setup 68 
PROCESSORS 23 
properties 

axis 80 
grid 80 
instrument 80 

quit 58, 68 
Raw volume import wizard 232 
redo 69, 89 
reference 153 
region of interest 129 
registering Volume Graphics 28 

remove handle 134 
render properties 83, 156 

motion smooting 159 
rendering algorithms 156 
result image size 158 

rendering 
in monochrome 158 
in true color 158 

rendering algorithms 156 
maximum projection 156 
scatter 156, 187, 209 
scatter + gradients 156, 187, 209 

rendering quality 158 
rendering speed 59 
replace 189 
representation 

polygonal 54 
voxel 54 

resampling 228, 239, 244 
reset 77, 116 
reset opacity curve 137 
resolution area 166 
result image size 158 
ROI 129 
rotate 76, 92, 115, 121, 163 

advanced dialog 164 
standard dialog 164 

rotation 
absolute 164 

save 66, 88 
save as 66 
save image 67 
save object 67 
scale 77, 93, 115, 165 
scatter + gradient algorithm 156, 209 
scatter algorithm 156, 187, 209 
scene 52 

axes 101 
grid 102 
menu 79 
origin 53 
tree 83, 149 
utilities icons 87, 101 
view 113 
viewer 171, 172 

Scene relative mode 110 
segment 

apply color 146 
create new 137 
cut 138 
delete 138 
disable 138 
enable 138 
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extract 138, 155 
generate 135 

segment borders 132 
segment color 

copy 149 
export 149 
import 149 
paste 149 
set 149 

segment name 132 
change 136 

select all 70, 154 
select inverse 70, 154, 155 
selection of an object 35 
setting preferences 70 
shadow light source 160 

ambient 160 
diffuse 160 

slice selection box 108, 185, 191 
slice windows 32, 107 
SMP 23 
stack of image slices 216 

BMP 216 
DICOM 216 
HDF 216 
import 219 
JPEG 216 
PPM 216 
RAW 216 
TIFF 216 

standard icons 87 
starting VGStudio 31 
static 182 
status bar 32, 214 
stereo images 

save 162 
stereo mode 161 

auto checkbox 161, 162 
stereo parameters 161 

eye distance 161 
focal distance 161 
interlaced horizontal 161 
interlaced vertical 161 
red-blue 161 
red-green 161 

stereo properties 83, 161 
surface area 205 
system requirements 22 
technical support 17 
title bar 32, 64 
tolerance 182 
tool box 32, 123 
tool tips 63 

tools 61 
arrange 123 
close 125 
disable 123 
enable 123 
floating 123 
maximize 125 
minimize 125 

tools menu 83, 123 
trajectory 207 
transfer function 126 
undo 69, 89 
ungroup 78, 153 
up vector 116, 118, 173 
user interface 62 
vgi file 39, 216 
VGStudio 

interface 61 
tools 61 

view frustum 117, 174 
view selction icons 87 
view selection icons 103 
viewing angle 116, 172, 174 
volume graphics 12 
Volume Graphics Info file 39, 216 
volume rendering 12 
volumes 216 

Analyze™ 216 
DICOM 216 
HDF 216 

voxel 55 
voxel object 52, 150 

color 146 
reference 150 

voxel representation 54 
voxel resolution 166 
what's this icon 87, 105 
Width 144 
window 

arrange 104 
arrange modes 85 
cascade 85 
maximize 107 
minimize 106 
new 3D window 85 
new slice windows 84 

window buttons 64 
window layout icons 87, 103 
window menu 84 
workspace 106 
world view 83, 103, 113, 171 

default view buttons 172 
move mode 171 
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reset 172 
rotate mode 171 
scene viewer 171, 172 
viewing angle 172 
zoom 172 

world view mode 79, 116 

zoom 108, 109, 113, 114, 121, 172, 191 
actual pixels 109, 114, 191 
fit to object 109, 191 
fit to window 114 
in 108, 109, 114, 191 
out 108, 109, 114, 191 
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